Pioneer sound.vision.soul

DVD Recorder

DVR-633H-S
DVR-533H-S
DVR-532H-S
DVR-531H-S

Register Your Product on
www.pioneerelectronics.com (US)
www.pioneerelectronics.ca (Canada)

Operating Instructions
Thank you for buying this Pioneer product.
Please read through these operating instructions so you will know how to operate your model properly.
After you have finished reading the instructions, put them away in a safe place for future reference.

**CAUTION**

**RISK OF ELECTRIC SHOCK**
**DO NOT OPEN**

The lightning flash with arrowhead, within an equilateral triangle, is intended to alert the user to the presence of uninsulated "dangerous voltage" within the product's enclosure that may be of sufficient magnitude to constitute a risk of electric shock to persons.

**CAUTION:**

TO PREVENT THE RISK OF ELECTRIC SHOCK, DO NOT REMOVE COVER (OR BACK). NO USER-SERVICEABLE PARTS INSIDE. REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.

The exclamation point within an equilateral triangle is intended to alert the user to the presence of important operating and maintenance (servicing) instructions in the literature accompanying the appliance.

**IMPORTANT NOTICE**

THE SERIAL NUMBER FOR THIS EQUIPMENT IS LOCATED IN THE REAR.
PLEASE WRITE THIS SERIAL NUMBER ON YOUR ENCLOSED WARRANTY CARD AND KEEP IN A SECURE AREA. THIS IS FOR YOUR SECURITY.

**Information to User**

Alteration or modifications carried out without appropriate authorization may invalidate the user’s right to operate the equipment.

**NOTE:** This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

**CAUTION:** USE OF CONTROLS OR ADJUSTMENTS OR PERFORMANCE OF PROCEDURES OTHER THAN THOSE SPECIFIED HEREIN MAY RESULT IN HAZARDOUS RADIATION EXPOSURE.

**CAUTION:** THE USE OF OPTICAL INSTRUMENTS WITH THIS PRODUCT WILL INCREASE EYE HAZARD.

**WARNING**

TO PREVENT FIRE OR SHOCK HAZARD, DO NOT EXPOSE THIS APPLIANCE TO RAIN OR MOISTURE.

**CAUTION:** This product satisfies FCC regulations when shielded cables and connectors are used to connect the unit to other equipment. To prevent electromagnetic interference with electric appliances such as radios and televisions, use shielded cables and connectors for connections.

This Class B digital apparatus complies with Canadian ICES-003.
Cet appareil numérique de la Classe B est conforme à la norme NMB-003 du Canada.
IMPORTANT SAFETY INSTRUCTIONS

READ INSTRUCTIONS — All the safety and operating instructions should be read before the product is operated.

RETAIL INSTRUCTIONS — The safety and operating instructions should be retained for future reference.

HEED WARNINGS — All warnings on the product and in the operating instructions should be adhered to.

FOLLOW INSTRUCTIONS — All operating and use instructions should be followed.

CLEANING — The product should be cleaned only with a polishing cloth or a soft dry cloth. Never clean with furniture wax, benzene, insecticides or other volatile liquids since they may corrode the cabinet.

ATTACHMENTS — Do not use attachments not recommended by the product manufacturer as they may result in hazards.

WATER AND MOISTURE — Do not use this product near water — for example, near a bathtub, washbowl, kitchen sink, or laundry tub; in a wet basement; or near a swimming pool; and the like.

ACCESSORIES — Do not place this product on an unstable cart, stand, tripod, bracket, or table. The product may fall, causing serious injury to a child or adult, and serious damage to the product. Use only with a cart, stand, tripod, bracket, or table recommended by the manufacturer, or sold with the product. Any mounting of the product should follow the manufacturer’s instructions, and should use a mounting accessory recommended by the manufacturer.

CART — A product and cart combination should be moved with care. Quick stops, excessive force, and uneven surfaces may cause the product and cart combination to overturn.

VENTILATION — Slots and openings in the cabinet are provided for ventilation and to ensure reliable operation of the product and to protect it from overheating. These openings must not be blocked or covered. The openings should never be blocked by placing the product on a bed, sofa, rug, or other similar surface. This product should not be placed in a built-in installation such as a bookcase or rack unless proper ventilation is provided or the manufacturer’s instructions have been adhered to.

POWER SOURCES — This product should be operated only from the type of power source indicated on the marking label. If you are not sure of the type of power supply to your home, consult your product dealer or local power company.

LOCATION — The appliance should be installed in a stable location.

NONUSE PERIODS — The power cord of the appliance should be unplugged from the outlet when left un-used for a long period of time.

GROUNDING OR POLARIZATION — If this product is equipped with a polarized alternating current plug (a plug having one blade wider than the other), it will fit into the outlet only one way. This is a safety feature. If you are unable to insert the plug fully into the outlet, try reversing the plug. If the plug should still fail to fit, contact your electrician to replace your obsolete outlet. Do not defeat the safety purpose of the polarized plug.

If this product is equipped with a three-wire grounding type plug, a plug having a third (grounding) pin, it will only fit into a grounding type power outlet. This is a safety feature. If you are unable to insert the plug into the outlet, contact your electrician to replace your obsolete outlet. Do not defeat the safety purpose of the grounding type plug.

POWER CORD PROTECTION — Power supply cords should be routed so that they are not likely to be walked on or pinched by items placed upon or against them, paying particular attention to cords at plugs, convenience receptacles, and the point where they exit from the product.

OUTDOOR ANTENNA GROUNDING — If an outside antenna or cable system is connected to the product, be sure the antenna or cable system is grounded so as to provide some protection against voltage surges and built-up static charges. Article 810 of the National Electrical Code, ANSI/NFPA 70, provides information with regard to proper grounding of the mast and supporting structure, grounding of the lead-in wire to an antenna discharge unit, size of grounding conductors, location of antenna-discharge unit, connection to grounding electrodes, and requirements for the grounding electrode. See Figure A.

LIGHTNING — For added protection for this product during a lightning storm, or when it is left unattended and unused for long periods of time, unplug it from the wall outlet and disconnect the antenna or cable system. This will prevent damage to the product due to lightning and power-line surges.

POWER LINES — An outside antenna system should not be located in the vicinity of overhead power lines or other electric light or power circuits, where it can fall into such power lines or circuits. When installing an outside antenna system, extreme care should be taken to keep from touching such power lines or circuits as contact with them might be fatal.

OVERLOADING — Do not overload wall outlets, extension cords, or integral convenience receptacles as this can result in a risk of fire or electric shock.

OBJECT AND LIQUID ENTRY — Never push objects of any kind into this product through openings as they may touch dangerous voltage points or short out parts that could result in a fire or electric shock. Never spill liquid of any kind on the product.

SERVICING — Do not attempt to service this product yourself as opening or removing covers may expose you to dangerous voltage or other hazards. Refer all servicing to qualified service personnel.

DAMAGE REQUIRING SERVICE — Unplug this product from the wall outlet and refer servicing to qualified service personnel under the following conditions:

- When the power-supply cord or plug is damaged.
- If liquid has been spilled, or objects have fallen into the product.
- If the product has been exposed to rain or water.
- If the product does not operate normally by following the operating instructions. Adjust only those controls that are covered by the operating instructions as improper adjustment of other controls may result in damage and will often require extensive work by a qualified technician to restore the product to normal operation.
- If the product has been dropped or damaged in any way.
- When the product exhibits a distinct change in performance — this indicates a need for service.

REPLACEMENT PARTS — When replacement parts are required, be sure the service technician has used replacement parts specified by the manufacturer or have the same characteristics as the original part. Unauthorized substitutions may result in fire, electric shock, or other hazards.

SAFETY CHECK — Upon completion of any service or repair to this product, ask the service technician to perform safety checks to determine that the product is in proper operating condition.

WALL OR CEILING MOUNTING — The product should not be mounted to a wall or ceiling.

HEAT — The product should be situated away from heat sources such as radiators, heat registers, stoves, or other products (including amplifiers) that produce heat.
DANGER
VISIBLE AND INVISIBLE LASER RADIATION WHEN OPEN. AVOID DIRECT EXPOSURE TO BEAM.

CAUTION
PREVENT ELECTRIC SHOCK DO NOT USE THIS (POLARIZED) PLUG WITH AN EXTENSION CORD, RECEPTACLE OR OTHER OUTLET UNLESS THE BLADES CAN BE FULLY INSERTED TO PREVENT BLADE EXPOSURE.

ATTENTION
POUR PREVENIR LES CHOCS ELECTRIQUES NE PAS UTILISER CETTE FICHE POLARISEE AVEC UN PROLONGATEUR UNE PRISE DE COURANT OU UNE AUTRE SORTIE DE COURANT SAUF SI LES LAMES PEUVENT ETRE INSEREES A FOND SANS EN LAISSER AUCUNE PARTIE A DECOUVVERT.

NOTE TO CATV SYSTEM INSTALLER
This reminder is provided to call the CATV system installer’s attention to Article 820-40 of the NEC that provides guidelines for proper grounding and, in particular, specifies that the cable ground shall be connected to the grounding system of the building, as close to the point of cable entry as practical.

Recording equipment and copyright: You may use this product only to reproduce or copy materials for which you own the copyright or have obtained permission to copy from the copyright owner or for which you otherwise have a legal right to reproduce or copy. If you do not own the copyright or have not obtained permission, you may be violating the law, including copyright law, and may be subject to payment of damages and other remedies.

POWER-CORD CAUTION
Handle the power cord by the plug. Do not pull out the plug by tugging the cord and never touch the power cord when your hands are wet as this could cause a short circuit or electric shock. Do not place the unit, a piece of furniture, etc., on the power cord, or pinch the cord. Never make a knot in the cord or tie it with other cords. The power cords should be routed such that they are not likely to be stepped on. A damaged power cord can cause a fire or give you an electrical shock. Check the power cord once a while. When you find it damaged, ask your nearest PIONEER authorized service center or your dealer for a replacement.

This product is for general household purposes. Any failure due to use for other than household purposes (such as long-term use for business purposes in a restaurant or use in a car or ship) and which requires repair will be charged for even during the warranty period.

This product includes FontAvenue® fonts licenced by NEC corporation. FontAvenue is a registered trademark of NEC Corporation.

WARNING: Handling the cord on this product or cords associated with accessories sold with the product will expose you to lead, a chemical known to the State of California and other governmental entities to cause cancer and birth defects or other reproductive harm. Wash hands after handling.

This product contains mercury. Disposal of this material may be regulated due to environmental considerations. For disposal or recycling information, please contact your local authorities or the Electronics Industries Alliance: www.eiae.org.
Dear Customer:

Selecting fine audio equipment such as the unit you’ve just purchased is only the start of your musical enjoyment. Now it’s time to consider how you can maximize the fun and excitement your equipment offers. This manufacturer and the Electronic Industries Association’s Consumer Electronics Group want you to get the most out of your equipment by playing it at a safe level. One that lets the sound come through loud and clear without annoying blaring or distortion—and, most importantly, without affecting your sensitive hearing.

Sound can be deceiving. Over time your hearing “comfort level” adapts to higher volumes of sound. So what sounds “normal” can actually be loud and harmful to your hearing. Guard against this by setting your equipment at a safe level BEFORE your hearing adapts.

To establish a safe level:
• Start your volume control at a low setting.
• Slowly increase the sound until you can hear it comfortably and clearly, and without distortion.

Once you have established a comfortable sound level:
• Set the dial and leave it there.

Taking a minute to do this now will help to prevent hearing damage or loss in the future. After all, we want you listening for a lifetime.

We Want You Listening For A Lifetime

Used wisely, your new sound equipment will provide a lifetime of fun and enjoyment. Since hearing damage from loud noise is often undetectable until it is too late, this manufacturer and the Electronic Industries Association’s Consumer Electronics Group recommend you avoid prolonged exposure to excessive noise. This list of sound levels is included for your protection.

<table>
<thead>
<tr>
<th>Decibel Level</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>30</td>
<td>Quiet library, soft whispers</td>
</tr>
<tr>
<td>40</td>
<td>Living room, refrigerator, bedroom away from traffic</td>
</tr>
<tr>
<td>50</td>
<td>Light traffic, normal conversation, quiet office</td>
</tr>
<tr>
<td>60</td>
<td>Air conditioner at 20 feet, sewing machine</td>
</tr>
<tr>
<td>70</td>
<td>Vacuum cleaner, hair dryer, noisy restaurant</td>
</tr>
<tr>
<td>80</td>
<td>Average city traffic, garbage disposals, alarm clock at two feet.</td>
</tr>
</tbody>
</table>

THE FOLLOWING NOISES CAN BE DANGEROUS UNDER CONSTANT EXPOSURE

| 90            | Subway, motorcycle, truck traffic, lawn mower |
| 100           | Garbage truck, chain saw, pneumatic drill |
| 120           | Rock band concert in front of speakers, thunderclap |
| 140           | Gunshot blast, jet plane |
| 180           | Rocket launching pad |

Information courtesy of the Deafness Research Foundation.

We Want You Listening For A Lifetime

Used wisely, your new sound equipment will provide a lifetime of fun and enjoyment. Since hearing damage from loud noise is often undetectable until it is too late, this manufacturer and the Electronic Industries Association’s Consumer Electronics Group recommend you avoid prolonged exposure to excessive noise. This list of sound levels is included for your protection.

Decibel Level Example

<table>
<thead>
<tr>
<th>Decibel Level</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>30</td>
<td>Quiet library, soft whispers</td>
</tr>
<tr>
<td>40</td>
<td>Living room, refrigerator, bedroom away from traffic</td>
</tr>
<tr>
<td>50</td>
<td>Light traffic, normal conversation, quiet office</td>
</tr>
<tr>
<td>60</td>
<td>Air conditioner at 20 feet, sewing machine</td>
</tr>
<tr>
<td>70</td>
<td>Vacuum cleaner, hair dryer, noisy restaurant</td>
</tr>
<tr>
<td>80</td>
<td>Average city traffic, garbage disposals, alarm clock at two feet.</td>
</tr>
</tbody>
</table>

THE FOLLOWING NOISES CAN BE DANGEROUS UNDER CONSTANT EXPOSURE

| 90            | Subway, motorcycle, truck traffic, lawn mower |
| 100           | Garbage truck, chain saw, pneumatic drill |
| 120           | Rock band concert in front of speakers, thunderclap |
| 140           | Gunshot blast, jet plane |
| 180           | Rocket launching pad |

Information courtesy of the Deafness Research Foundation.

CAUTION

This product is a class 1 laser product, but this product contains a laser diode higher than Class 1. To ensure continued safety, do not remove any covers or attempt to gain access to the inside of the product. Refer all servicing to qualified personnel.

The following caution label appears on your unit.

Location: inside of the unit
Contents

01 Before you start
Features .................................................. 8
What's in the box ........................................... 9
Putting the batteries in the remote control ............... 10
Using the remote control ................................ 10
Disc / content format playback compatibility ............. 10
About the internal hard disk drive ......................... 13

02 Connecting up
Rear panel connections ..................................... 14
Front panel connections .................................... 14
Easy connections ........................................... 15
Using other types of video output ......................... 16
Connecting to a cable box or satellite receiver (1) ....... 17
Connecting to a cable box or satellite receiver (2) ....... 18
Connecting to an AV amplifier or receiver ............... 19
Connecting other AV sources ............................. 20
Plugging in ............................................... 20

03 Controls and displays
Front panel ................................................. 21
Remote control ............................................ 22
Display .................................................... 24

04 Getting started
Switching on and setting up ............................... 25
Setting up the TV Guide On Screen™ system ................ 27
Selecting the hard disk or DVD for playback and recording ......... 27
Making your first recording ................................ 27
Using the built-in TV tuner ................................ 28
Basic playback ........................................... 29
Using the Home Menu .................................... 32
Displaying disc information on-screen ..................... 32

05 Using the TV Guide On Screen™ interactive program guide
Introduction ............................................... 35
Using the TV Guide On Screen™ system ..................... 35
The Listings screen ........................................ 36
Recording programs ....................................... 37
Setting program reminders ................................ 39
Searching for programs ................................... 40
Scheduling recordings and reminders ....................... 44
Changing setup options ................................... 45
TV Guide On Screen™ FAQ and troubleshooting ............ 47

06 Recording
About DVD recording ....................................... 49
About HDD recording ...................................... 49
Recording time and picture quality ......................... 50
Recorded audio ............................................ 50
Restrictions on video recording ............................. 50
Setting the picture quality/record time ..................... 51
Basic recording from the TV ................................ 51
Simultaneous recording and playback ....................... 52
Recording from an external component .................... 53
Recording from a DV camcorder ......................... 53
Playing your recordings on other DVD players ............ 55
Initializing a recordable DVD disc ......................... 56

07 Playback
Introduction ............................................... 57
Navigating discs and the HDD .............................. 57
Using the Disc Navigator to browse the contents of a disc ..... 58
Scanning discs ............................................. 60
Playing in slow motion .................................... 60
Frame advance/frame reverse ................................ 61
The Play Mode menu ...................................... 61
Displaying and switching subtitles ......................... 64
Switching DVD soundtracks ................................ 64
Switching audio channels ................................ 65
Switching camera angles .................................. 65

08 Copying and back-up
Introduction ............................................... 66
One Touch Copy ............................................ 66
Using Copy Lists .......................................... 67
Using disc back-up ....................................... 74

09 Editing
The Disc Navigator screen .................................. 76
Command menu panel options .............................. 77
Editing accuracy .......................................... 77
HDD genres ............................................... 77

10 The PhotoViewer
Playing a slideshow ...................................... 85
### 11 The Disc Setup menu
- Introduction .................................................. 87
- Basic settings ................................................. 87
- Initialize settings .......................................... 88
- Finalize settings ........................................... 88
- Optimize HDD ............................................... 88
- Initialize HDD .............................................. 88

### 12 The Video/Audio Adjust menu
- Setting the picture quality for TV and external inputs .. 89
- Setting the picture quality for disc playback ............ 90
- Audio DRC .................................................... 91

### 13 The Initial Setup menu
- Using the Initial Setup menu ............................... 92

### 14 Additional information
- Resetting the recorder ..................................... 98
- Setting up the remote to control your TV ............... 98
- Screen sizes and disc formats ............................ 99
- Minimum copying times .................................. 100
- Troubleshooting ............................................. 101
- Frequently asked questions ............................... 103
- About DV ..................................................... 104
- Manual recording modes .................................. 105
- Additional information for cable/satellite/STB (set-top box) users .................................. 106
- Language code list ......................................... 107
- Country/Area code list ..................................... 107
- On-screen displays and recorder displays ............... 108
- Handling discs .............................................. 109
- Cleaning the pickup lens .................................. 109
- Condensation ................................................. 109
- Hints on installation ....................................... 110
- Glossary ...................................................... 110
- Specifications ............................................... 112

### Index

---

**DVR-530H_KU.book** 7 ページ 2005年6月8日 水曜日 午前11時16分
Chapter 1
Before you start

Features

• Built-in TV Guide On Screen™ interactive program guide
The TV Guide On Screen™ system is a free, interactive on-screen TV programming guide. You can see what’s on TV today and in the coming week, search TV listings by program categories or by using your own keywords, and even set the recorder to record programs with the press of a button.

Please note:
The TV Guide On Screen™ interactive program guide incorporated in this product supports and provides listings for cable-ready televisions, cable set-top-box supplied from most cable operators, and digital cable services as well as over-the-air broadcasts. TV Guide On Screen™ does not support or provide listings for any satellite services. Satellite subscribers should use the manual recording features built into this unit to record shows.

• HDD recording
Record video on the DVR-633H-S's internal 160 GB (gigabyte) hard disk (HDD), or the DVR-533H-S/DVR-532H-S/DVR-531H-S’s 80 GB HDD.

With both recordable DVD and a high-capacity HDD in the same recorder, you have the flexibility to keep recordings on the HDD or record to DVD.

• Copy between HDD and DVD
You can copy recordings between the HDD and DVD. When copying to DVD you can usually use the high-speed copy feature.

You can also choose to copy material at a different recording quality from the original. For example, you might want to copy an XP mode (highest quality) recording on the HDD to SP (standard play) quality on a DVD so that you can fit other recordings on the same disc.

• One Touch Copy
One Touch Copy makes copying the currently playing title from HDD to DVD, or DVD to HDD as simple as pressing a button.

• High quality, real-time copying
When recording to the HDD, picture quality data is also stored so that picture quality can be optimized when making real-time copies to DVD later.

(This is applicable only to MN16–32 HDD recordings (Video Mode Off), or MN12–32 / XP+ recordings (Video Mode On).

• Chase play
Using chase play you can start watching a recording from the beginning, while continuing to record. For example, you could set a timer recording for a program that you’re going to miss the first 15 minutes of, then start watching while the recorder is still recording the program 15 minutes ahead of you.

• Simultaneous recording and playback
HDD and DVD playback and recording are completely independent. For example, you can record a broadcast program to a recordable DVD, while watching another recording you already made on the same DVD.

• On-screen Help
Use the HELP button on the remote control to display a help screen for the current operation.

• Disc Navigator
The on-screen Disc Navigator makes finding your way around the contents of a disc or the HDD easy. For recordable DVD and HDD content, moving thumbnail images are displayed for ease of use. The Disc Navigator is also where you can edit HDD and recordable DVD content.

• Home Menu
The Home Menu gives you on-screen access to all the recorder’s features in one convenient place, from setting up the recorder, to programming a timer recording and editing a recording.

• Progressive scan-compatible
Compared to standard interlaced video, progressive scan effectively doubles the amount of video information fed to your TV or monitor. (Check your TV/monitor for compatibility with this feature.)

• Cinema-style surround sound in your home
Connect this recorder to a Dolby Digital and/or DTS-compatible AV amp/receiver to enjoy full surround sound effects from Dolby Digital and DTS DVD discs.

• One Touch Recording
Use One Touch Recording to start recording immediately in 30 minute blocks. Each time you press the REC button, the recording time is extended by another 30 minutes, up to six hours.
Before you start

- **Optimized recording**
  Optimized recording adjusts the recording quality automatically if a timer recording will not fit onto a disc with the settings that you made. Please note that the quality of recordings may be reduced if a longer recording time is used.

- **Super high quality HDD recording**
  Using the XP+ recording mode you can record super high quality video (around 15 Mbps data transfer rate) to the HDD.

- **High quality 16-bit Linear PCM audio**
  In the LPCM recording mode, audio is recorded in uncompressed 16-bit Linear PCM format. This delivers great sounding audio to accompany the high picture quality.

- **Picture quality adjustment features**
  During playback, you can adjust various picture quality settings to improve the picture. You can also adjust the recording picture quality. For example, if you want to make a DVD copy of an old video tape, you can optimize the picture quality before transferring it to disc.

- **Find what you want to watch quickly and easily**
  Unlike video tape that needs to be wound to the correct place, you can jump right to the part of a DVD disc or the HDD that you want to watch. Search for a point on a disc by title, chapter or time.

- **Manual recording**
  In addition to six preset recording quality modes, the manual recording mode allows you to access 34 different recording quality/time settings, giving you precise control over the recording.

- **Record from a DV camcorder**
  **DVR-633/533H-S only**
  This recorder has a built-in DV (Digital Video) input for connection to a DV camcorder. This makes it ideal for transferring camcorder footage to DVD or HDD for editing.

- **Safe, non-destructive editing**
  When editing Play List content, the actual content of the disc (the Original content) is not touched. The edited version (the Play List content) just points to various parts of the Original content.

- **Play Video mode recordings on a regular DVD player**
  Discs recorded using the Video mode can be played back on regular DVD players, including computer DVD drives compatible with DVD-Video playback.
  *DVD-Video format* recording: The use of the DVD-Video format for recording on DVD-R and DVD-RW discs is referred to as recording in 'Video mode' on Pioneer’s DVD recorders. Supporting playback of DVD-R / DVD-RW discs is optional for manufacturers of DVD playback equipment, and there is DVD playback equipment that does not play DVD-R or DVD-RW discs recorded in the DVD-Video format. Note: ‘Finalization’ is required.

- **WMA, MP3 and JPEG file playback**
  This recorder can play WMA and MP3 audio files and JPEG picture files on CD-R, CD-RW or CD-ROM discs.

- **Disc Back-up**
  The disc back-up feature gives you a convenient way to back-up important material on a finalized Video mode DVD to another recordable DVD disc. The material is first copied to the HDD, then on to a second DVD disc.

- **Recovery Recording**
  When a timer recording is set to use DVD but the disc loaded at the time of the recording is unrecordable, the program will automatically be recorded to the HDD.

What's in the box

Please confirm that the following accessories are in the box when you open it.

- Remote control
- AA/R6P dry cell batteries x2
- Audio/video cable (red/white/yellow)
- G-LINK™ cable
- RF antenna cable
- Power cable
- Blank DVD-RW disc
- Quick start guide
- These operating instructions
- Warranty card

Note on copying:
You may use this product only to reproduce or copy materials for which you own the copyright or have obtained permission to copy from the copyright owner or for which you otherwise have a legal right to reproduce or copy. Unless you own the copyright or have obtained permission from the copyright owner or otherwise have a legal right to reproduce or copy, you may be violating the law, including copyright law, and may be subject to payment of damages and other remedies.
Putting the batteries in the remote control

1 Open the battery compartment cover on the back of the remote control.

2 Insert two AA/R6P batteries into the battery compartment following the indications (⁺,⁻) inside the compartment.

3 Close the cover.

Important
Incorrect use of batteries can result in hazards such as leakage and bursting. Please observe the following:
- Don’t mix new and old batteries together.
- Don’t use different kinds of batteries together—although they may look similar, different batteries may have different voltages.
- Make sure that the plus and minus ends of each battery match the indications in the battery compartment.
- Remove batteries from equipment that isn’t going to be used for a month or more.
- When disposing of used batteries, please comply with governmental regulations or environmental public instruction’s rules that apply in your country or area.

Using the remote control
Please keep in mind the following when using the remote control:
- Make sure that there are no obstacles between the remote and the remote sensor on the unit.
- Remote operation may become unreliable if strong sunlight or fluorescent light is shining on the unit’s remote sensor.
- Remote controllers for different devices can interfere with each other. Avoid using remotes for other equipment located close to this unit.
- Replace the batteries when you notice a fall off in the operating range of the remote.
- When the batteries run down or you change the batteries, the remote control mode and TV preset codes are automatically reset. See Remote Control Mode on page 96 and Setting up the remote to control your TV on page 98 to reset them.
- Use within the operating range in front of the remote control sensor on the front panel, as shown.

You can control this recorder using the remote sensor of another Pioneer component using the CONTROL IN jack on the rear panel. See Rear panel connections on page 14 for more information.

Disc / content format playback compatibility

General disc compatibility
This recorder is compatible with a wide range of disc types (media) and formats. Playable discs will generally feature one of the following logos on the disc and/or disc packaging. Note however that some disc types, such as recordable CD and DVD, may be in an unplayable format—see below for further compatibility information.
Before you start

- Also compatible with KODAK Picture CD
- DVD is a trademark of DVD Format/Logo Licensing Corporation.

About DualDisc playback
- is a trademark of Fuji Photo Film Co. Ltd.

DVD-R/RW compatibility
This recorder will play and record DVD-R/RW discs.
Compatible media:
- DVD-RW Ver. 1.1, Ver. 1.1 / 2x, Ver. 1.2 / 2–4x and Ver. 1.2 / 2–6x
- DVD-R Ver. 2.0 and Ver. 2.0 / 4x / 8x / 16x, and Ver. 2.1 / 1–8x / 1–16x

Recording formats:
- DVD-R/RW: Video Recording (VR) format and DVD-Video format (Video mode)

Readable formats:
- DVD-R/RW: Video Recording (VR) format and DVD-Video format (Video mode)

Note that older models of DVD recorders and DVD writers may reject DVD-RW Ver. 1.2 discs and/or corrupt the data on the disc. If you want to share DVD-RW discs between this recorder and an older recorder/writer, we recommend using Ver. 1.1 discs.

The following table shows older Pioneer DVD recorders' limited compatibility with DVD-RW Ver. 1.2 discs.

<table>
<thead>
<tr>
<th>Model</th>
<th>Playable</th>
<th>Recordable</th>
</tr>
</thead>
<tbody>
<tr>
<td>DVR-7000</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>DVR-810H/DVR-87H / DVR-210/DVR-310/DVR-510H</td>
<td>Yes¹</td>
<td>No</td>
</tr>
</tbody>
</table>

¹ Discs should be finalized in this recorder before playing. Unfinalized VR mode and Video mode discs may not play.
² Cannot read the CPRM information will show in the display when you load a disc. However, this will not affect playback.
³ Copy-once protected disc titles will not play.

Compressed audio compatibility
- Compatible media: CD-ROM, CD-R, CD-RW
- Compatible formats: MPEG-1 Audio Layer 3 (MP3), Windows Media Audio (WMA)
- Sampling rates: 44.1 or 48kHz
- Bit-rates: Any (128Kbps or higher recommended)
- Variable bit-rate (VBR) MP3 playback: Yes
- VBR WMA playback: No
- WMA encoder compatibility: Windows Media Codec 8 (files encoded using Windows Media Codec 9 may be playable but some parts of the specification are not supported; specifically, Pro, Lossless, Voice and VBR)
- DRM (Digital Rights Management) file playback: No (see also DRM in the Glossary on page 110)
- File extensions: .mp3, .wma (these must be used for the recorder to recognize MP3 and WMA files – do not use for other file types)
- File structure: Up to 99 folders / 999 files (if these limits are exceeded, only files and folders up to these limits are playable)

About DualDisc playback
A DualDisc is a new two-sided disc, one side of which contains DVD content –video, audio, etc. – while the other side contains non-DVD content such as digital audio material.

The non-DVD, audio side of the disc is not compliant with the CD Audio specification and therefore may not play.

It is possible that when loading or ejecting a DualDisc, the opposite side to that being played will be scratched. Scratched discs may not be playable.

The DVD side of a DualDisc plays in this product. DVD-Audio content will not play.

For more detailed information on the DualDisc specification, please refer to the disc manufacturer or disc retailer.
Before you start

WMA (Windows Media Audio) compatibility

The Windows Media® logo printed on the box indicates that this recorder can playback Windows Media Audio content.

WMA is an acronym for Windows Media Audio and refers to an audio compression technology developed by Microsoft Corporation. WMA content can be encoded by using Windows Media® Player for Windows® XP, Windows Media® Player 9 or Windows Media® Player 10 series.

Microsoft, Windows Media, and the Windows logo are trademarks, or registered trademarks of Microsoft Corporation in the United States and/or other countries.

JPEG file compatibility

• Compatible formats: Baseline JPEG and EXIF 2.2* still image files
  *File format used by digital still cameras
• Sampling ratio: 4:4:4, 4:2:2, 4:2:0
• Horizontal resolution: 160 – 5120 pixels
• Vertical resolution: 120 – 3840 pixels
• Progressive JPEG compatible: No
• File extensions: .jpg, .jpeg, .jif, .jfif (must be used for the recorder to recognize JPEG files – do not use for other file types)
• File structure: The recorder can load up to 99 folders / 999 files at one time (if there are more files/folders that this on the disc then more can be reloaded)

PC-created disc compatibility

Discs recorded using a personal computer may not be playable in this unit due to the setting of the application software used to create the disc. In these particular instances, check with the software publisher for more detailed information.

Discs recorded in packet write mode (UDF format) are not compatible with this recorder.

Check the DVD-R/RW or CD-R/RW software disc boxes for additional compatibility information.

Frequently asked questions

• What's the difference between DVD-R and DVD-RW?
  The most important difference between DVD-R and DVD-RW is that DVD-R is a record-once medium, while DVD-RW is a re-recordable/erasable medium. You can re-record/erase a DVD-RW disc approximately 1,000 times.
  For more information, see About DVD recording on page 49.

• What's VR mode?
  VR (Video Recording) mode is a special mode designed for home DVD recording. It allows flexible editing of recorded material compared to 'Video mode'. On the other hand, Video mode discs are more compatible with other DVD players.

• How do I change the format of a disc?
  Both DVD-R and DVD-RW discs can be initialized for Video mode or VR mode recording. DVD-R discs are ready for Video mode recording when you first load them into the recorder. You can, however, initialize them for VR mode recording from the Disc Setup menu.
  DVD-RW discs can be initialized and re-initialized for either mode at any time (although initializing will erase all the data on the disc).

• Can I play my recordable discs in a regular DVD player?
  Generally, DVD-R discs and DVD-RW discs recorded in Video mode* are playable in a standard DVD player, but they must be 'finalized' first. This process fixes the contents of the disc to make them readable to other DVD players as DVD-Video discs.
  DVD-R discs recorded in VR mode are not playable in standard DVD players, but may be playable in other DVD recorders and DVD-ROM drives (in the case of DVD-ROM drives, the disc will need to be finalized first).
  DVD-RW discs recorded in VR mode are playable in some players and other recorders.

  Note that discs may not play due to recording or disc characteristics, scratches or dirt on the disc or pickup lens, etc.

  RW This label indicates playback compatibility with DVD-RW discs recorded in VR mode (Video Recording format). However, for discs recorded with a record-only-once encrypted program, playback can only be achieved using a CPRM compatible device.

  Note that Pioneer cannot guarantee that discs recorded using this recorder will play on other players.
"DVD-Video format" recording: The use of the DVD-Video format for recording on DVD-R and DVD-RW discs is referred to as recording in "Video mode" on Pioneer's DVD recorders. Supporting playback of DVD-R / DVD-RW discs is optional for manufacturers of DVD playback equipment, and there is DVD playback equipment that does not play DVD-R or DVD-RW discs recorded in the DVD-Video format.

Note: 'Finalization' is required.

This recorder supports the recording of 'copy-once' broadcast programs using the CPRM copy protection system (see CPRM on page 50) on CPRM-compliant discs in VR mode. CPRM recordings can only be played on players that are specifically compatible with CPRM.

Do I need two DVD recorders for editing? What kind of editing can I do?

Unlike editing video tape, you only need one DVD recorder to edit discs. With VR mode discs, you can edit by making a 'Play List' of what to play and when to play it. On playback, the recorder plays the disc according to the Play List.

Throughout this manual, you will often see the words Original and Play List to refer to the actual content and the edited version.

- Original content refers to what's actually recorded on the disc.
- Play List content refers to the edited version of the disc—how the Original content is to be played.

Please use the recorder following the guidelines below to protect against possible HDD failure.

The HDD should not be regarded as a place to store recordings permanently. We recommend that you back up your important recordings onto DVD-R/RW discs in order to protect against accidental loss.

Pioneer cannot under any circumstances accept responsibility for any direct or indirect loss arising from any inconvenience or loss of recorded material resulting from HDD failure.

- Do not move the recorder while it is on (this includes during EPG download when the display shows EPG).
- Install and use the recorder on a stable, level surface.
- Do not block the rear vent/cooling fan.
- Do not use the recorder in excessively hot or humid places, or in places that may be subject to sudden changes in temperature. Sudden changes in temperature can cause condensation to form inside the recorder. This can be a cause of HDD failure.
- While the recorder is switched on (including during EPG download when the display shows EPG), do not unplug from the wall socket or switch the electricity off from the breaker switch.
- Do not move the recorder immediately after switching it off. If you need to move the recorder, please follow the steps below:
  1. After the message POWER OFF is shown in the display, wait at least two minutes.
  2. Unplug from the wall socket.
  3. Move the recorder.
- If there's a power failure while the recorder is on, there is a chance that some data on the HDD will be lost.
- The HDD is very delicate. If used improperly or in an unsuitable environment, it is possible that the HDD will fail after a few years of use. Signs of problems include playback unexpectedly freezing and noticeable block noise (mosaic) in the picture. However, sometimes there will be no warning signs of HDD failure. If the HDD fails, no playback of recorded material will be possible. In this case it will be necessary to replace the HDD unit.

Optimizing HDD performance

As you record and edit material on the HDD, the data on the disk becomes fragmented, eventually affecting the recorder’s performance. Before this happens, the recorder will warn you that it is time to optimize the HDD (which you can do from the Disc Setup menu; see Optimize HDD on page 88).

About the internal hard disk drive

The internal hard disk drive (HDD) is a fragile piece of equipment. Depending on the conditions under which it is used, or through careless use, it is possible that the recorded contents will be damaged or lost completely, or that normal playback and recording will not be possible. Please understand that in the event of repair or replacement of the HDD or related components, all your HDD recordings will be lost.
Chapter 2
Connecting up

Rear panel connections

1 AC IN
After making all other connections, connect to a power outlet using the supplied power cable only.

2 Audio/video inputs 1 and 3
Two sets of audio/video inputs (stereo analog audio; composite and S-video video) that you can use to connect to satellite receivers, TVs, VCR or other source component for recording.

3 Audio/video outputs 1 and 2
Two sets of audio/video outputs (stereo analog audio; composite and S-video video) that you can use to connect TVs or monitors.

4 COMPONENT VIDEO OUT
A high-quality video output for connecting to a TV or monitor with a component video input.

5 VHF/UHF IN (RF IN)/OUT
Connect your TV antenna to the VHF/UHF IN (RF IN) jack. The signal is passed through to the VHF/UHF OUT jack for connection to your TV.

6 OPTICAL DIGITAL OUT
A digital audio output for connecting to an AV amp/receiver, Dolby Digital/DTS decoder or other equipment with optical digital input.

7 CONTROL IN
Use to control this recorder from the remote sensor of another Pioneer component with a CONTROL OUT terminal and bearing the Pioneer mark. Connect the CONTROL OUT of the other component to the CONTROL IN of this recorder using a mini-plug cord.

8 G-LINK™
Use to connect the supplied G-LINK™ cable for use with the TV Guide On Screen™ interactive program guide and a control-capable set-top box.

Front panel connections

On the right side of the front panel a flip-down cover hides more connections.

9 DV IN (DVR-633/533H-S only)
A DV input i.LINK connector, suitable for connecting a DV camcorder.

10 Audio/video input 2
Audio/video input (stereo analog audio; composite and S-video video), especially suitable for camcorders, game consoles, portable audio, etc.
Connecting up

Easy connections

The setup described here is a basic configuration that allows you to record TV programs on both this recorder and your VCR. When watching recordings from this recorder, set your TV to input 1; switch to input 2 to watch a video playing in the VCR.

Important

- This recorder is equipped with copy protection technology. Do not connect this recorder to your TV via a VCR (or your VCR via this recorder) using AV cables, as the picture from this recorder will not appear properly on your TV.
- Before making or changing any rear panel connections, make sure that all components are switched off and unplugged from the wall outlet.

1. Connect your TV antenna/cable TV outlet to the VHF/UHF IN (RF IN) jack on this recorder.

2. Use an RF antenna cable (one is supplied) to connect the VHF/UHF OUT jack on this recorder to the antenna input on your VCR.
   - If you are not connecting a VCR in the chain, connect this recorder directly to your TV and skip the next step.

3. Use an RF antenna cable to connect the antenna output on your VCR to the antenna input on your TV.

4. Connect the AUDIO and VIDEO OUTPUT jacks (1 or 2) to a set of audio/video inputs on your TV.
   Use the supplied three-pin audio/video cable. It is color-coded to help you match them up (red/white for the right/left audio connections and yellow for video in/outs). Make sure you match up the left and right outputs with their corresponding inputs for correct stereo sound.

5. Connect your VCR to your TV (A/V IN 2 above) using a set of audio and video cables.
   - See the following page if you want to use S-video or component video cables for the video connection.
Using other types of video output
This recorder has standard (composite), S-video and component video outputs. The main difference between them is the quality of the picture. S-video delivers a better picture than composite video, while component video gives better picture quality still. The variety of outputs also gives you the flexibility of connecting your particular equipment using the best connection type available.

1 Connecting using an S-video output
S-video carries the picture as separate color and luminance (brightness) signals.
There are two S-video outputs for connection to TVs, monitors, VCRs or other equipment.
- Use an S-video cable (not supplied) to connect an S-VIDEO OUTPUT (1 or 2) to an S-video input on your TV, monitor (or other equipment).

2 Connecting using the component video output
Component video carries the picture as two separate color signals, plus a luminance (brightness) signal.
See also Component Video Out on page 92 for how to set up the component video output for use with a progressive scan-compatible TV.
- Use a component video cable (not supplied) to connect the COMPONENT VIDEO OUT jacks to a component video input on your TV, monitor (or other equipment).
Connecting up

Connecting to a cable box or satellite receiver (1)

If you are using a cable box or satellite receiver with only a few scrambled channels, follow the setup on this page. If many or all the channels are scrambled, we recommend using the setup on the following page.

Using the setup on this page you can:
- Record unscrambled channels by selecting them on this recorder.
- Record scrambled channels by selecting them on the cable box/satellite receiver.
- Watch one channel while recording another.

Important
- Do not connect this recorder ‘through’ your VCR, satellite receiver or cable box. Always connect each component directly to your TV or AV amp/receiver.

1 Connect RF antenna cables as shown.
   This enables you to watch and record TV channels.

2 Connect the AUDIO and VIDEO OUTPUT jacks (1 or 2) on this recorder to a set of audio/video inputs on your TV using a set of A/V cables (as supplied).
   This enables you to watch the output from this recorder.

3 Connect the audio/video output of your cable box/satellite receiver to the INPUT 1 jacks on this recorder using a set of A/V cables.
   This enables you to record scrambled TV channels.

4 Plug the supplied G-LINK™ cable to the G-LINK™ jack.
   This enables you to control the tuner in the cable box through the TV Guide On Screen system.
   Position the IR transmitter end of the G-LINK™ cable so that the IR receiver on your cable box will pick up the control signals (see diagram).

See the manual that came with your cable box if you’re not sure where the IR receiver is on the front panel. Alternatively, experiment with the remote control, operating it from very close range until you find the place where the receiver responds.

Note
1. The diagram shows standard video connections, but you can alternatively use the S-video or component video connections if they’re available.
2. The TV Guide On Screen™ interactive program guide provides listings for cable-ready, cable box, and digital cable services as well as over-the-air broadcast. It does not provide listings for satellite services. Satellite subscribers can use the manual recording features built into this unit to record shows.
Connecting up

Connecting to a cable box or satellite receiver (2)
If many or all the channels you receive by cable or satellite are scrambled, we recommend using this setup. \(^1\)

Using the setup on this page you can:
- Record any channel by selecting it on the cable box/satellite receiver.

**Important**
- Do not connect this recorder ‘through’ your VCR, satellite receiver or cable box. Always connect each component directly to your TV or AV amp/receiver.

1. Connect RF antenna cables as shown.
   This enables you to watch and record TV channels.

2. Connect the AUDIO and VIDEO OUTPUT jacks (1 or 2) on this recorder to a set of audio/video inputs on your TV using a set of A/V cables (as supplied).
   This enables you to watch discs.

3. Connect the audio/video output of your cable box/satellite receiver to the INPUT 1 jacks on this recorder using a set of A/V cables.
   This enables you to record scrambled TV channels.

4. Plug the supplied G-LINK™ cable to the G-LINK™ jack.
   This enables you to control the tuner in the cable box through the TV Guide On Screen\(^2\) system.
   Position the IR transmitter end of the G-LINK™ cable so that the IR receiver on your cable box will pick up the control signals (see diagram).

   See the manual that came with your cable box if you’re not sure where the IR receiver is on the front panel. Alternatively, experiment with the remote control, operating it from very close range until you find the place where the receiver responds.

**Note**
1. The setup on this page does not allow you to watch one channel and record another.
   The diagram shows standard video connections, but you can alternatively use the S-video or component video connections if they’re available.

2. The TV Guide On Screen\(^{™}\) interactive program guide provides listings for cable-ready, cable box, and digital cable services as well as over-the-air broadcast. It does not provide listings for satellite services. Satellite subscribers can use the manual recording features built into this unit to record shows.
Connecting up

Connecting to an AV amplifier or receiver

To enjoy multichannel surround sound you need to connect this recorder to an AV amp/receiver using the digital optical output. In addition to the digital connection, we recommend also connecting using the stereo analog connection.

You’ll probably also want to connect a video output to your AV amp/receiver. Use the standard (composite) video output (as shown here), or the S-video or component video connections.

See also Audio Out Settings on page 93 for how to set up the digital audio output. (Noise may be output from your speakers if the recorder is not set up to work with your AV amp/receiver.)

Important

- Do not connect this recorder to your TV ‘through’ your VCR or other component using A/V cables. Always connect it directly to your TV.

1 Connect RF antenna cables as shown. This enables you to watch and record TV channels.

2 Connect the AUDIO and VIDEO OUTPUT jacks (1 or 2) on this recorder to a set of audio/video inputs on your AV amp/receiver.

3 Use an optical digital audio cable (not supplied) to connect the OPTICAL DIGITAL OUT jack on this recorder to an optical digital input on your AV amp/receiver. This enables you to listen to multichannel surround sound.

4 Connect the AV amp/receiver’s video output to a video input on your TV.

Note

1. If your AV amp/receiver doesn’t have an optical digital input, but has a coaxial type, converter boxes that convert from optical to coaxial are available at specialist audio dealers.
Connecting other AV sources

Connecting a VCR or analog camcorder

1. Connect a set of audio and video inputs of your VCR or camcorder to a set of outputs on this recorder. This enables you to record from this recorder to your VCR or camcorder.
   - You can use standard video or S-video cables for the video connection.

2. Connect a set of audio and video outputs of your VCR or camcorder to a set of inputs on this recorder. This enables you to record tapes from your VCR or camcorder.
   - You can use standard video or S-video cables for the video connection.
   - The front panel connections make convenient connections for a camcorder input.

Connecting a DV camcorder

DVR-633/533H-S only
Using the front panel DV IN jack, it is possible to connect a DV camcorder or video deck, or DVD-R/RW recorder and digitally transfer DV tapes or DVD-R/RW discs to DVD-R/RW.

Important
- This jack is for connection to DV equipment only. It is not compatible with digital satellite receivers or D-VHS video decks.

1. Use a DV cable (not supplied) to connect the DV jack of your DV camcorder/video deck to the front panel DV IN jack of this recorder.

Plugging in

After checking all the connections, plug in the recorder.

1. Use only the supplied power cable to connect this recorder to a power outlet.
Chapter 3
Controls and displays

Front panel

1 🍄 STANDBY/ON
Press to switch the recorder on/into standby.

2 Disc tray

3 DISC NAVIGATOR/TOP MENU
Press to display the Disc Navigator screen, or the top menu if a DVD-Video disc is loaded.

4 ▲ OPEN/CLOSE
Press to open/close the disc tray.

5 HDD/DVD indicator
Lights blue when the HDD is selected; orange when DVD is selected.

6 HDD/DVD
Press to switch between the hard disk drive (HDD) and DVD for recording and playback.

7 MENU
Press to display a DVD-Video disc menu.

8 Front panel display and IR remote sensor
See Display on page 24 for details.

9 Front panel inputs (page 14)
Pull the cover down where indicated to access the front panel input jacks (audio, video and DV¹). Especially convenient for connecting camcorders and other portable equipment.

10 ONE TOUCH COPY (page 66)
Press to start One Touch Copy of the currently playing title to DVD or the HDD. See also the Note on copying on page 9.

11 ▪ Press to stop recording.

12 ● REC
Press to start recording. Press repeatedly to set the recording time in 30 minute blocks.

13 RETURN
Press to go back one level in the on-screen menu or display.

14 🔽/▶/◅/▻ and ENTER
Used to navigate all on-screen displays. Press ENTER to select the currently highlighted option. When stopped, the 🔽/▶ buttons can also be used to change the TV channel.

15 HOME MENU (page 32)
Press to display the Home Menu, from which you can navigate all the functions of the recorder.

16 ►
Press to start or restart playback.

17 ■
Press to pause or resume playback.

18 ■
Press to stop playback.

Note
¹DV input on DVR-633/533H-S only
**Remote control**

1 **ONE TOUCH COPY** (page 66)
   Press to start One Touch Copy of the currently playing title to DVD or the HDD. See also the Note on copying on page 9.

2 **Remote control indicator**
   Lights when setting up the remote control for use with a TV (page 98) and when setting the remote control mode (page 96).

3 **STANDBY/ON**
   Press to switch the recorder on/into standby.

4 **OPEN/CLOSE**
   Press to open/close the disc tray.

5 **HDD** (page 27)
   Press to select the hard disk (HDD) for recording or playback.

6 **DVD** (page 27)
   Press to select the DVD for recording or playback.

7 **INPUT SELECT** (page 53)
   Press to change the input to use for recording.

8 **Alphanumeric buttons, + and CLEAR**
   Use the number buttons for track/chapter/title selection; channel selection, and so on. The same buttons can also be used to enter names for titles, discs and so on. Use the + button to enter non-alphanumeric characters and symbols. Use CLEAR to clear an entry and start again.

9 **CH +/-** (page 28)
   Press to change the channel of the built-in TV tuner.

10 **DVD playback functions**
    - **AUDIO** (page 29, 64, 65)
      Changes the audio language or channel. (When the recorder is stopped, press to change the tuner audio.)
    - **SUBTITLE** (page 64)
      Displays/changes the subtitles included in multilingual DVD-Video discs.
    - **ANGLE** (page 65)
      Switches camera angles on discs with multi-angle scenes.

11 **PLAY MODE** (page 61)
   Press to display the Play Mode menu (for features such as search, repeat and program play).

12 **DISC NAVIGATOR** (page 58, 76) / **TOP MENU** (page 30)
   Press to display the Disc Navigator screen, or the top menu if a DVD-Video disc is loaded.

13 **MENU** (page 30)
   Press to display the disc menu if a DVD-Video disc is loaded. While in the TV Guide On Screen™ system, press to display the panel menu.

14 **↑/↓/←/→ and ENTER**
   Used to navigate all on-screen displays. Press ENTER to select the currently highlighted option.

15 **HOME MENU** (page 32)
   Press to display the Home Menu, from which you can navigate all the functions of the recorder.

16 **RETURN**
   Press to go back one level in the on-screen menu or display. Also use to exit the TV Guide On Screen™ system.
## Controls and displays

### 17 TV Guide On Screen™ navigation

**TV GUIDE**
Press to access the TV Guide On Screen™ system; press again to exit.

**INFO**
Press to see additional information for the highlighted TV Guide On Screen™ item.

### 18 HELP
Press for help on how to use the current GUI screen.

### 19 DISPLAY (page 32)
Displays/changes the on-screen information displays.

### 20 Playback controls (page 29)

- **REV SCAN / FWD SCAN** (page 60)
  Press to start reverse or forward scanning. Press again to change the speed.

- **PLAY**
  Press to start playback.

- **PAUSE**
  Press to pause playback or recording.

- **STOP**
  Press to stop playback.

- **CM BACK (commercial back)**
  Press repeatedly to skip progressively backward through the audio or video playing.

- **CM SKIP (commercial skip)**
  Press repeatedly to skip progressively forward through the audio or video playing.

- **PREV / NEXT**
  Press to skip to the previous or next title/chapter/track/folder; or to display the previous or next menu page.
  Also use to display the previous/next page of a TV Guide On Screen™ listing.

- **STEP/SLOW** (page 60)
  During playback, press to start slow-motion playback; while paused, press to show the previous or next video frame.
  Also use to display the previous/next day of a TV Guide On Screen™ listing.

### 21 Recording controls (page 27)

- **REC**
  Press to start recording. Press repeatedly to set the recording time in blocks of 30 mins. With a program highlighted in the TV Guide On Screen™ system, press to set that program to record.

- **STOP REC**
  Press to stop recording.

- **REC MODE** (page 51)
  Press repeatedly to change the recording mode (picture quality).

- **TIMER REC** (page 44)
  Press to set a timer recording from the TV Guide On Screen™ system.

### 22 TV CONTROL (page 98)
After setting up, use these controls to control your TV.
Controls and displays

Display

1 ➤
Lights during playback; blinks when playback is paused.

2 ➔
Lights when copying.

3 ●
Lights during recording; blinks when recording is paused.

4 PM
Lights to indicate PM (after midday) for the clock display.

5 (page 37)
Lights when a timer recording has been set.
(Indicator blinks if the timer has been set to DVD but there isn’t a recordable disc loaded, or the timer has been set to HDD but the HDD is not recordable.)

SAP (page 29)
Lights when the currently selected TV channel has a Second Audio Program channel.

1L 1R (page 93)
Indicates which channels are recorded when Dual Mono is selected.

2P (page 92)
Lights when the component video output is set to progressive scan.

OVER (page 93)
Lights when the analog audio input level is too high.

6 Recording quality indicators (page 50)
XP
Lights when the recording mode is set to XP (best quality).

SP
Lights when the recording mode is set to SP (standard play).

LP / SLP
Lights when the recording mode is set to LP (long play) or SLP (super long play).

EP / SEP
Lights when the recording mode is set to EP (extended play) or SEP (super extended play).

MN
Lights when the recording mode is set to MN (manual recording level) mode.

7 CH (page 28)
Channel indicator for the built-in TV tuner.

8 Character display

9 R / RW
Indicates the type of recordable DVD loaded: DVD-R or DVD-RW.

10 PL (page 76)
Lights when a VR mode disc is loaded and the recorder is in Play List mode.

2 3 (page 96)
Shows the remote control mode (if nothing is displayed, the remote control mode is 1).

V
Lights when an unfinalized Video mode disc is loaded.
Getting started

Chapter 4
Getting started

Switching on and setting up
When you switch the recorder on for the first time, you can make several basic settings using the Setup Navigator feature. This takes you through setting the clock, the internal TV tuner and the video output settings.

If you’re using the recorder for the first time, we strongly recommend you use the Setup Navigator before starting to use the recorder.

1. Switch on your TV and set the video input to this recorder.
2. Press the STANDBY/ON button on the remote control or the front panel to switch on.
When you switch on for the first time, your TV should display the Setup Navigator screen. (If the Setup Navigator doesn’t appear, you can also access it from the Initial Setup menu; see page 92).
3. Use the / buttons to select an OSD language, then press ENTER.
This will also set the audio, subtitle and DVD menu language preferences.
4. With ‘Start’ highlighted press ENTER to start using the Setup Navigator.
• Highlight Cancel if you want to exit here.
5. Use the / buttons to select ‘Antenna’ or ‘Cable’ depending on how you receive your terrestrial TV channels, then press ENTER.
You can also select Do not set if you don’t need the recorder to retune all the channels (if you’re using the Setup Navigator for a second time, for example).

After selecting Antenna or Cable the recorder starts automatic tuning. This takes a couple of minutes to complete.

If EPG data is downloaded, the clock will automatically be set and you can skip to step 7 below.1
6. Select ‘Auto’ for automatic time setting, then press ENTER.

---

Note
1. If you want to adjust the clock after EPG data is downloaded, you must reset the unit to its default settings. You can then set the clock manually from the Initial Setup menu.
**Getting started**

- **Auto clock setting**
  Some TV channels broadcast time signals together with the program. This recorder can use these signals to set the clock automatically.

  Use the \(\uparrow/\downarrow\) buttons to set 'Clock Set CH' to the channel preset number that broadcasts a time signal, then move the cursor down to 'Start' and press ENTER.

  The recorder takes a short while to set the time. After you see that the time has been set, select **Next** to go back to the previous screen and select **Manual**.

- **Manual clock setting**
  If no stations in your area are broadcasting time signals, you can set the clock manually.

  Use the \(\uparrow/\downarrow\) buttons to set your time zone.

  Press \(\downarrow\) then use the \(\uparrow/\downarrow\) buttons to set Summer Time to On or Off, then press ENTER.

  Select **On** if you are currently using summer (daylight saving) time.

  **Set the current date and time.**

  Use the \(\uparrow/\downarrow\) buttons to change the value in the highlighted field.

  Use the \(\leftarrow/\rightarrow\) buttons to move from one field to another.

  Press ENTER to finish setting the time.

- **Select the kind of TV you have, ‘Wide (16:9)’ or ‘Standard (4:3)’.**

- **Is your TV compatible with progressive scan video?**

  Use the \(\uparrow/\downarrow\) buttons to select **Compatible**, **Not Compatible**, or **Don’t Know**.

- **Press ENTER to finish setting up, or select ‘Go Back’ if you want to start again.**

  That completes basic setup using the Setup Navigator.

**Other settings you can make**

After setting up using the Setup Navigator, you should be ready to start enjoying your DVD recorder. It’s possible, however, that you may want to make a couple of additional settings, depending on how the recorder is set up for TV broadcasts.

- **Manual channel setting** – This setting lets you skip channels where there is no station, as well as manually tune to stations. See Manual CH Setting on page 92.

- **Setting up the remote to control your TV** – You can set up the supplied remote control to control many brands of TV. See Setting up the remote to control your TV on page 98.
Setting up the TV Guide On Screen system

The TV Guide On Screen™ system1 is a free, interactive on-screen television program guide. The system offers program listings, searching by keyword, timer recording, reminders and more. The TV Guide On Screen system is a convenient way to find out what's on right now or during the coming week, by channel or by genre. It also allows you to automatically set your viewing and recording selections quickly and easily.

This setup provides you with TV listings in your area.

1 Press TV GUIDE to begin setup.
The TV Guide On Screen welcome screen is displayed.

2 Press ENTER to go to the first setup screen.

3 Select the country in which you are using your recorder.

4 Follow the on-screen instructions to set up the TV Guide On Screen system.
At the bottom of each screen you’ll see the buttons you need to navigate that screen.

- If for any reason you need to cancel the setup process before it’s completed, you will be asked the next time you switch on whether you want to start setting up again, or whether to leave it until later.

Tip

- If you need to change any of the settings you just made later on, select Setup from the Service bar in the main Guide screen.

Selecting the hard disk or DVD for playback and recording

The HDD and DVD buttons (remote control and front panel) are used to select the hard disk (HDD) or DVD for playback and recording. The indicator in the front panel display shows which is currently selected.

Making your first recording

This quick guide shows you how to make a basic recording of a TV program on either the HDD, or to a recordable DVD.

Recording is covered in much more detail in chapter 6 (Recording).

Note

1. The TV Guide On Screen™ interactive program guide provides listings for cable-ready, cable box, and digital cable services as well as over-the-air broadcast. It does not provide listings for satellite services. Satellite subscribers can use the manual recording features built into this unit to record shows.
Getting started

1. If they aren’t already on, switch on your TV and this recorder.
   Press STANDBY/ON to switch on.
   - Make sure that the video input on your TV is set to this recorder.

2. Press HDD to record to the HDD, or DVD to record to a recordable DVD.
   If you choose to record to the HDD, skip to step 5 now.

3. Press OPEN/CLOSE to open the disc tray.

4. Load a blank DVD-R or DVD-RW disc with the label side face-up, using the disc guide to align the disc.
   - When you load a new, blank DVD-RW disc, the recorder will take a moment to initialize it for recording.
   - Blank DVD-R discs are ready for Video mode recording out of the box.

5. Use the CH +/- buttons to select the TV channel you want to record from.
   - You can also use the ▲/▼ buttons on the front panel if the recorder is stopped.
   - Antenna channels are numbered 2 through 69. Cable channels are numbered 1 through 125.

6. Press REC to start recording.
   - By default, the recording will be in SP (standard play) mode, which will give you around two hours of recording from a blank DVD disc. The different recording modes and their recommended uses are covered in more detail in the chapter on Recording.
   - You can pause recording by pressing PAUSE.
   - Press REC or PAUSE again to restart recording.

7. When you want to stop recording, press STOP REC.

Playing back your recording
The TV program you just recorded should be on the HDD or DVD disc as a single title with one or more chapters.

- Press PLAY to start playback.
  If you want to stop playback before the end of the recording, press STOP.

Using the built-in TV tuner

Changing TV channels
There are three different ways to select TV channels. Note that you can’t change the TV channel during playback, recording or during recording standby.

- CH +/- buttons on the remote
- Number buttons on the remote – For example, to select channel 4, press 4 then ENTER; for channel 34, press 3, 4, ENTER; for channel 102, press 1, 0, 2, ENTER.
- ▲/▼ buttons on the front panel

Changing cable channels
When a cable box is connected, you can use the remote to change cable channels (up to 999).

If your cable box is connected to the RF antenna input on this recorder:

- Use the CH +/- or the number buttons to change the cable channel
  In this case, you can’t change the channel of the built-in tuner.

If your cable box is connected to a set of AV inputs:

1. Use the INPUT SELECT button to change to the cable box input.
2. Use the CH +/- or the number buttons to change the cable channel

Note
1. Antenna channels are numbered 2 through 69. Cable channels are numbered 1 through 125.
Getting started

Changing audio channels
Some TV programs are broadcast with both a main and a Second Audio Program (SAP). You can change the TV audio using the AUDIO button.

- Press AUDIO to change the TV audio.
The current audio channel is displayed on-screen.

- If SAP is selected, but there is no SAP channel being broadcast, you will still hear the main audio channel.

- If the sound is poor quality when set to Stereo, you can often improve it by changing to Mono.

Basic playback
This section shows you how to use your recorder for playback of discs (DVD, CD, etc.), and for playback of video from the HDD. More playback features, such as repeat and program play, are covered in Playback on page 57.

- Some DVD-Video discs don’t allow certain playback controls to operate at certain points in the disc. This is not a malfunction.

1 Press STANDBY/ON to switch on.
Also turn on your TV and make sure that it is set to the correct video input.

2 Press HDD to playback from the HDD, or DVD to play a DVD.
If playing video from the HDD, skip to step 5 below.

3 Press OPEN/CLOSE to open the disc tray.

4 Load a disc.
Load a disc with the label side facing up, using the disc tray guide to align the disc (if you’re loading a double-sided DVD-Video disc, load it with the side you want to play face down).

- If you want to play a DTS audio CD, please first read the note on page 31.

- Please see Disc / content format playback compatibility on page 10 if you want to play a Dual Disc (DVD/CD hybrid discs).

5 Press PLAY to start playback.
- If you’re playing a DVD-Video or Video CD, a disc menu may appear when you start playback. Use the 1/2/3/4 buttons and ENTER to navigate DVD disc menus, and the number buttons and ENTER for Video CD menus.

- When playing video from the HDD, playback will automatically stop after the end of a title is reached.

- See the following sections for more details on playing specific kinds of discs.

6 To stop playback, press STOP.

7 When you’ve finished using the recorder, eject the disc and switch the recorder back into standby.
- To open/close the disc tray, press OPEN/CLOSE.
- Remove the disc before putting the recorder into standby.
- Press STANDBY/ON to switch the recorder into standby.

Important
- Throughout this manual, the term ‘DVD’ means playback-only DVD-Video discs and DVD-R/RW. If a function is specific to a particular kind of DVD disc, it is specified.
### Playing DVD discs
The table below shows the basic playback controls for DVD-Video, and recordable DVD discs.

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>PLAY</strong></td>
<td>Press to start playback. If <strong>RESUME</strong> is displayed on-screen, playback starts from the place last stopped.</td>
</tr>
<tr>
<td><strong>STOP</strong></td>
<td>Press to stop playback. You can resume playback from the same point by pressing <strong>PLAY</strong>. (Press <strong>STOP</strong> again to cancel the resume function.)</td>
</tr>
<tr>
<td><strong>PAUSE</strong></td>
<td>Pauses playback, or restarts playback when paused.</td>
</tr>
<tr>
<td><strong>REV SCAN</strong></td>
<td>Press to start scanning. Press repeatedly to increase the scanning speed.</td>
</tr>
<tr>
<td><strong>FWD SCAN</strong></td>
<td>Press to skip to previous/next chapter/title.</td>
</tr>
<tr>
<td><strong>STEP</strong></td>
<td>Press to display the menu of a DVD-Video disc.</td>
</tr>
<tr>
<td><strong>CLEAR</strong></td>
<td>Press CLEAR to clear a number entry and start again.</td>
</tr>
<tr>
<td><strong>STEP BACK</strong></td>
<td>Each press skips backward/forward progressively up to a maximum of ten minutes forward or three minutes back.</td>
</tr>
<tr>
<td><strong>STEP FWD</strong></td>
<td>During playback, press to start slow-motion playback. Press repeatedly to change the playback speed. While paused, press to advance a single frame in either direction.</td>
</tr>
</tbody>
</table>

**Except VR mode:** During playback, enter a chapter number then press **ENTER** to skip directly to that chapter within the currently playing title. On some discs, you can also use the number buttons to select numbered items in the disc menu. **VR mode only:** During playback, enter a title number then press **ENTER**. All: Press CLEAR to clear a number entry and start again.

### Playing from the HDD
The table below shows the basic playback controls when playing video recorded on the hard disk (HDD).

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>PLAY</strong></td>
<td>Press to start playback. If <strong>RESUME</strong> is displayed on-screen, playback starts from the place last stopped. Playback automatically stops after the end of a title is reached.</td>
</tr>
<tr>
<td><strong>STOP</strong></td>
<td>Press to stop playback. You can resume playback from the same point by pressing <strong>PLAY</strong>. (Press <strong>STOP</strong> again to cancel the resume function.)</td>
</tr>
<tr>
<td><strong>PAUSE</strong></td>
<td>Pauses playback, or restarts playback when paused.</td>
</tr>
<tr>
<td><strong>REV SCAN</strong></td>
<td>Press to start scanning. Press repeatedly to increase the scanning speed.</td>
</tr>
<tr>
<td><strong>FWD SCAN</strong></td>
<td>Press to skip to previous/next chapter/title.</td>
</tr>
<tr>
<td><strong>STEP</strong></td>
<td>Press to display the menu of a DVD-Video disc.</td>
</tr>
<tr>
<td><strong>CLEAR</strong></td>
<td>Press CLEAR to clear a number entry and start again.</td>
</tr>
<tr>
<td><strong>STEP BACK</strong></td>
<td>Each press skips backward/forward progressively up to a maximum of ten minutes forward or three minutes back.</td>
</tr>
<tr>
<td><strong>STEP FWD</strong></td>
<td>During playback, press to start slow-motion playback. Press repeatedly to change the playback speed. While paused, press to advance a single frame in either direction.</td>
</tr>
</tbody>
</table>
Getting started

Playing CDs and WMA/MP3 discs
The table below shows the basic playback controls for audio CDs and WMA/MP3 files.

- **Press to start playback.**
- **Press to stop playback.**
- **Pauses playback, or restarts playback when paused.**
- **Press to start scanning. Press again to increase the scanning speed. (There are two scan speeds; the current scan speed is shown on-screen.)**
- **Press to skip to previous/next track (or folder for WMA/MP3 disc).**
- **During playback, enter a track number then press **ENTER** to skip directly to that track. Press **CLEAR** to clear a number entry and start again.**

Playing Video CDs
The table below shows the basic playback controls for Video CDs.

Some discs feature Playback Control (PBC for short) menus. These discs show PBC in the display when you load them and display a menu on-screen from where you can select what to watch.

- **Press to start playback.**
- **Press to stop playback.**
- **Pauses playback, or restarts playback when paused.**
- **Press to start scanning. Press repeatedly to increase the scanning speed.**
- **Press to skip to previous/next track.**
- **During playback, enter a track number then press **ENTER** to skip directly to that track. Press **CLEAR** to clear a number entry and start again.**
- **Each press skips backward/forward progressively up to a maximum of ten minutes forward or three minutes back. Note that this function doesn’t work when playing in PBC mode.**
- **During playback, press to start slow-motion playback. Press repeatedly to change the playback speed (forward only). While paused, press to advance a single frame (forward only).**
- **Press to display the disc menu of a Video CD playing in PBC mode.**

**Note**

1. If you want to play a DTS audio CD, make sure the recorder is connected to a DTS-compatible amp/receiver with a digital connection. Noise will be output through the analog outputs. Also make sure that **STEREO** is selected using the **AUDIO** button (see Switching audio channels on page 65).

2. When playing in PBC mode, some playback features, such as search, repeat and program play are not available. You can play a PBC Video CD in non-PBC mode by pressing **>** to start playback instead of **PLAY**.
Getting started

Using the Home Menu
From the Home Menu screen you can access all the features of the recorder.
Note that some options in the Home Menu may be grayed out sometimes, indicating that they are not available at the present time. For example, the Photoviewer option is grayed out unless there is a disc loaded that contains JPEG image files.
Press HOME MENU to display the Home Menu screen:

Use the ▲/▼/◄/► buttons followed by ENTER to select the option you want. To exit the Home Menu, press HOME MENU.

Displaying disc information on-screen
You can display various on-screen information about the disc loaded or the HDD.

1 Press DISPLAY repeatedly to display/change the on-screen information.
   - Press once to show the HDD and removable disc (DVD, etc.) activity together. Press again to show the status of just the currently selected playback/recording device (HDD or removable disc).
   - The on-screen display automatically disappears after 150 minutes.

2 To hide the information display, press DISPLAY repeatedly until it disappears.
The example displays below are a guide only; actual displays vary according to the disc loaded, etc.

HDD and removable disc activity display
Press DISPLAY once to see the HDD and removable disc (DVD, etc.) activity. Use the HDD and DVD buttons to switch between the two kinds of display.

<table>
<thead>
<tr>
<th>Home menu options</th>
<th>Disc Navigator (page 58, page 76)</th>
<th>Disc Setup (page 87)</th>
</tr>
</thead>
<tbody>
<tr>
<td>TV GUIDE (page 35)</td>
<td>Initial Setup (page 92)</td>
<td></td>
</tr>
<tr>
<td>Timer Recording (page 37)</td>
<td>Video/Audio Adjust (page 89)</td>
<td></td>
</tr>
<tr>
<td>Play Mode (page 61)</td>
<td>Copy (page 66)</td>
<td></td>
</tr>
<tr>
<td>Photo Viewer (page 85)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

Using the Home Menu
From the Home Menu screen you can access all the features of the recorder.
Note that some options in the Home Menu may be grayed out sometimes, indicating that they are not available at the present time. For example, the Photoviewer option is grayed out unless there is a disc loaded that contains JPEG image files.
Press HOME MENU to display the Home Menu screen:

Use the ▲/▼/◄/► buttons followed by ENTER to select the option you want. To exit the Home Menu, press HOME MENU.

Displaying disc information on-screen
You can display various on-screen information about the disc loaded or the HDD.

1 Press DISPLAY repeatedly to display/change the on-screen information.
   - Press once to show the HDD and removable disc (DVD, etc.) activity together. Press again to show the status of just the currently selected playback/recording device (HDD or removable disc).
   - The on-screen display automatically disappears after 150 minutes.

2 To hide the information display, press DISPLAY repeatedly until it disappears.
The example displays below are a guide only; actual displays vary according to the disc loaded, etc.

HDD and removable disc activity display
Press DISPLAY once to see the HDD and removable disc (DVD, etc.) activity. Use the HDD and DVD buttons to switch between the two kinds of display.

<table>
<thead>
<tr>
<th>Home menu options</th>
<th>Disc Navigator (page 58, page 76)</th>
<th>Disc Setup (page 87)</th>
</tr>
</thead>
<tbody>
<tr>
<td>TV GUIDE (page 35)</td>
<td>Initial Setup (page 92)</td>
<td></td>
</tr>
<tr>
<td>Timer Recording (page 37)</td>
<td>Video/Audio Adjust (page 89)</td>
<td></td>
</tr>
<tr>
<td>Play Mode (page 61)</td>
<td>Copy (page 66)</td>
<td></td>
</tr>
<tr>
<td>Photo Viewer (page 85)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Getting started

The example displays below show high-speed copying from HDD to DVD, and HDD chase playback.

Stop display 1

1 DVD-RW Original / Play List
If a VR mode disc is loaded, this shows whether playback is currently set to Original or Play List.
During preview playback of the Copy List, this shows Copy List.

2 Disc type and mode
Shows the disc type (HDD, DVD-R, DVD-RW, CD, etc.), and the disc mode for recordable DVD, if applicable (VR or Video).

3 Recording mode and time
Shows the current recording mode (XP, SP, LP, etc.), and the total recording time of the disc.

4 Resume
Shows Resume if playback can be resumed from the last place stopped.

5 Recording time remaining
Shows the approximate recording time left on the disc in the current recording mode.

6 Station call letters or TV channel
Shows the station call letters or TV channel preset for the built-in TV tuner.

7 Audio mode
Shows the broadcast audio mode for the current channel preset (Mono, Stereo, etc.).

8 Copy control information
Shows recording restrictions of the current channel program.

9 Disc name
Shows the disc name.
(For CDs, this area shows playable files other than CD audio tracks; for example, Multi-format: WMA/MP3.)

10 Finalized
Shows Finalized if a recordable DVD is finalized.

Stop display 2

1 Broadcast program name
2 Date and time
3 Number of titles/tracks on disc
For a VR mode DVD-RW, the number of Original and Play List titles are shown separately.

Play display 1

1 Number of chapters in title
2 Current title and chapter number
(For CD/Video CD, shows current track; for WMA/MP3, shows current folder and track; for JPEG disc, shows current folder and file.)

3 Elapsed title time
(For CD, WMA, MP3, shows elapsed track time; for Video CD, shows elapsed disc time.)

4 Total running time of title
5 Angle indicator
Lights during multi-angle scenes.
Getting started

Play display 2

1. Chase playback, simultaneous record/playback, copy, disc back-up
   Indicates that recording, copying or back-up is in progress.

2. Elapsed chapter time

3. Total running time of chapter

4. Data transfer rate
   Shows the current data rate being read from the disc.

5. Copy protected material (!) / PureCinema indicator (#)
   Shows ‘!’ if the playback material is copy-once protected.
   Shows ‘#’ if the current video is 24 fps, progressive scan.

Recording display

1. Current title number

2. Elapsed recording time

3. Timer recording start and stop times
   Shows the start and stop times if the current recording is a timer recording.

4. Remaining recording time available
   Shows the amount of space left on the disc in the current recording mode.

5. Recording mode
   Shows the current recording mode (XP, SP, LP, etc.), and the total recording time of the disc.

6. Broadcast program title

Tip

- When using the simultaneous play and record feature, the display shows information for playback only.
- During real-time copy, the copy source playback information is displayed.
- The Video mode disc displays become the same as a DVD-Video disc once the disc is finalized.
- The total recording time figure shown in parenthesis is calculated based on a 12cm/4.7GB disc at the displayed record setting.
- Recording and playback times for TV recordings are approximately 0.1% shorter than the actual time. This is because of the slightly different frame rates of TV broadcasts versus DVD.
- The frame number is shown next to the elapsed time display when the disc is paused.
- Copy Once or Can’t Record messages may appear in the stop or recording displays. These indicate that the broadcast TV program contains copy control information.

Note

1. Data transfer rate shows the amount of video and audio information recorded on the disc. It is not an indication of picture/audio quality.
Chapter 5
Using the TV Guide On Screen™ interactive program guide

Introduction
The TV Guide On Screen™ system is a free, interactive on-screen television program guide. The system offers program listings, searching by keyword, timer recording, reminders and more. The TV Guide On Screen system is a convenient way to find out what's on right now or during the coming week, by channel or by genre. It also allows you to automatically set your viewing and recording selections quickly and easily.

Before you can start using the TV Guide On Screen system, you'll need to set it up. If you haven't already done this, please turn to Setting up the TV Guide On Screen system on page 27 before proceeding.

Legal Notices
In the United States, TV GUIDE and other related marks are registered marks of Gemstar-TV Guide International, Inc. and/or one of its affiliates. In Canada, TV GUIDE is a registered mark of Transcontinental, Inc. and is used under license by Gemstar-TV Guide International, Inc.

The TV Guide On Screen system is manufactured under license from Gemstar-TV Guide International, Inc. and/or one of its affiliates.

The system TV Guide On Screen is fabriqués sous licence de Gemstar-TV Guide International, Inc. et/ou d'une de ses sociétés affiliées.

The TV Guide On Screen system is protected by one or more of the following issued United States patents 6,498,895; 6,418,556; 6,331,877; 6,239,794; 6,154,203; 5,940,073; 4,908,713; 4,751,578; 4,706,121.

Le système TV Guide On Screen est protégés par un ou plusieurs brevets émis aux Etats Unis, comme le 6,498,895; 6,418,556; 6,331,877; 6,239,794; 6,154,203; 5,940,073; 4,908,713; 4,751,578; 4,706,121.

Using the TV Guide On Screen system
Many of the screens have common elements to make using the system easier.

1 Video window – Allows you to continue watching the current program while using the guide.
2 Panel ads and panel menu entry – Space for show or product advertising (and the panel menu).
3 Service bar – Gives access to the various services of the guide.
4 Time slot – Half-hour time slots are displayed horizontally.
5 Information box – Shows information about the highlighted item.

TV Guide On Screen icons
Various icons are used to convey information or show the status of an item.

• ![Info button] – Additional information is available; press the INFO button to display.
• ![Progress Bar] – Shows the elapsed time of the current program.
• ![HDTV] – Indicates that a program is a high-definition broadcast.
• ![New] – The program is new (not a repeat).

Note
The TV Guide On Screen™ interactive program guide provides listings for cable-ready, cable box, and digital cable services as well as over-the-air broadcast. It does not provide listings for satellite services. Satellite subscribers can use the manual recording features built into this unit to record shows.
Using the TV Guide On Screen™ interactive program guide

- **Stereo** – The program is broadcast in stereo.
- **CC** – The program is broadcast with closed captioning.
- **TV Rating** – Indicates the age rating for the program.
- **Record Once** – One-time only recording.
- **Record Daily** – Record a program Monday through Friday at the same time each day.
- **Record Regularly** – Record the same program any day it airs on the same channel at the same time.
- **Record Weekly** – Record a program every week at the same time/day.
- **Record Suspend** – The program is set to record, but is suspended because of a conflict with another recording (it remains in the schedule). The recording resumes when the conflict is cleared.
- **Record Off** – The program remains in the list, but will not be recorded until the frequency is changed to one of the above.
- **Remind Once** – One-time only reminder.
- **Remind Daily** – Remind Monday through Friday at the same time each day.
- **Remind Regularly** – Remind the same program any day it airs on the same channel at the same time.
- **Remind Weekly** – Remind every week at the same time/day.
- **Remind Suspend** – A reminder is set of the program, but is suspended because of a conflict with another reminder (it remains in the schedule). The reminder resumes when the conflict is cleared.
- **Remind Off** – A reminder is set for the program, but it is currently off (it remains in the schedule).

**TV Guide On Screen navigation**

The table below shows a summary of the remote buttons you'll use to navigate the TV Guide On Screen system.

<table>
<thead>
<tr>
<th>Key</th>
<th>What it does</th>
</tr>
</thead>
<tbody>
<tr>
<td>TV GUIDE</td>
<td>Press to display the TV Guide On Screen system (also use to exit).</td>
</tr>
<tr>
<td>↑/↓/←/→</td>
<td>Use to navigate screens (highlight an item).</td>
</tr>
<tr>
<td>ENTER</td>
<td>Press to confirm a selection or execute an action. Can also be used to display the panel menu when a forthcoming program is highlighted.</td>
</tr>
<tr>
<td>MENU</td>
<td>Press to display the panel menu.</td>
</tr>
<tr>
<td>INFO</td>
<td>Press to cycle through the available information for the current program or screen.</td>
</tr>
<tr>
<td>REC</td>
<td>Press to set the highlighted program to record.</td>
</tr>
</tbody>
</table>

**Number buttons**

- Use for numeric entry.
- Press to select the previous/next page of information (where applicable).
- Press to select the previous/next day.

**The Listings screen**

You can consider the Listings screen as the ‘home’ screen of the TV Guide On Screen system. This is the screen you see when you press TV GUIDE.

From the Listings screen you can:
- View eight days of program listings.
- Display information about individual programs.
- Select a program to start watching.
- Set a program to remind.
- Set a program to record.
- See a thumbnail display of any channel in the video window.
- Access panel and channel ads.
Using the TV Guide On Screen™ interactive program guide

1 Press TV GUIDE to display Listings screen.

- With Listings highlighted in the Service bar at the top of the screen, press INFO to display help information.
- Press TV GUIDE anytime to exit.

2 Use the / arrow buttons to navigate the Listings screen.
- With a currently showing program highlighted, press ENTER to start watching.
- Move right for later time slots.
- Use the \ and \ buttons to display listings for the previous/next day.
- Press INFO to display information about the currently highlighted channel (if available).

3 To set the highlighted program to record, press REC.

Pressing REC just once will set the program to record. Press REC repeatedly to change the frequency of the recording:
- Once – Just record the highlighted program.
- Regularly – Record the same program at the same time every day.

- Weekly – Record the same program at the same time every week.
- Off – Keep the recording in the schedule, but don’t record it.
- No record icon – Don’t set a recording.
Note that setting a program to record in this way will result in a recording using all the default options (see also Changing the Default Options on page 46).
If you want to set a recording using settings other than the default, use the panel menu.

Recording programs
The simplest way to record a program is to highlight the program you want to record and press REC (as described above), but if you want to set the recording options to anything other than the default, the place to do it is the Recording Options menu panel. Here you can adjust the start and end time, the destination of the recording, the recording quality and so on.

1 From the program listings, highlight the program you want to record.

2 Press MENU to display the Episode Options panel menu.

Note
1 The program will still be recorded if it starts any time up to the midway point of the originally scheduled program. For example, up to 9:15 for a 9:00 to 9:30 program.
3 Highlight ‘set recording’ and press ENTER.

4 Set the recording options:

Use the ↑/↓ buttons to highlight a field; use the ←/→ buttons to change the setting.
- **frequency** – select whether the program will be recorded just **Once**, **Regularly** (at the same time on the same channel), or **Weekly** (every week at the same time/day). There’s also an **Off** option which puts the program in the recording schedule but doesn’t record it (you can set it to record later).
- **start** – set the start time of the recording to **On time**, or up to 120 mins. before or after the scheduled time.
- **end** – set the end time of the recording to **On time**, or up to 120 mins. before or after the scheduled time.
- **recorder** – select whether you want a DVD or HDD recording.
- **quality** – set the recording mode.

5 Once all the settings have been made, press ENTER to highlight ‘schedule recording’, then press ENTER again.

**When the recording is about to start**
The TV Guide On Screen™ system alerts you when a scheduled recording is about to start and gives you the chance to cancel the recording if you no longer need it.

When you see the on-screen alert, select either:
- change channel; start recording
- don’t change channel; cancel recording

If there’s a scheduled recording conflict when a recording is about to start, you’ll be alerted to this too. You can select to record the conflicting program, or cancel the recording.

**Canceling and stopping a timer recording in progress**
After a timer recording has started, you can cancel the program (but continue recording), or stop recording completely if you need to.

1 During timer recording, press and hold ● REC for three seconds.

Only the program is canceled (the timer indicator disappears); recording continues so that you can manually stop recording whenever you like.

2 When you want to stop recording completely, press □ STOP REC.

**Tip**
- You can also stop a timer recording immediately by pressing □ STOP REC, then selecting Yes to confirm.

**Preventing use of the recorder before a timer recording (child lock)**
You can make all the front panel and remote control buttons inoperative using the child lock feature. This is useful when you set a timer recording and want to make sure that the timer settings are not changed before recording has finished.

1 If the recorder is on, switch it into standby.

2 Press and hold □ STOP on the front panel for three seconds to lock the controls.

The front panel display briefly shows LOCK. If any buttons are pressed on the remote or front panel, LOCK is briefly displayed again.

- To unlock the recorder, press and hold □ STOP on the front panel for three seconds until the display shows UNLOCK.
To cancel a timer recording when the recorder is locked, first unlock the recorder (see above), then press and hold REC for three seconds.

Setting program reminders
By setting a program reminder you can have the recorder alert you when a program is about to start on another channel. You can set reminders for individual episodes of a program, or every time a program airs.

1. From the program listings, highlight the program you want to set a reminder for.

2. Press MENU to display the Episode Options panel menu.

3. Highlight ‘set reminder’ and press ENTER.

4. Set the reminder options:
   - **Frequency** – select whether to be reminded just Once, Regularly (at the same time on the same channel), or Weekly (every week at the same time/day). There’s also an Off option which puts the program in the reminder schedule but no reminder is given (you can set it to remind later).
   - **Auto tune** – set whether the recorder should automatically change channels when a reminder is due, or not.
   - **When** – set when the reminder is displayed (before, on time, or after a program has started).

5. Once all the settings have been made, press ENTER to highlight ‘schedule reminder’, then press ENTER again.

The reminder is now set (and will appear in the schedule) and you’ll be returned to the main listings area.

When a reminder appears on-screen
Depending on the settings you made, your program reminder will appear on your TV screen around the time the program is scheduled to start. You can then highlight the program and press ENTER to tune to the program, or highlight hide reminders to dismiss the reminder and leave the channel unchanged.

If more than one reminder is set for the same time, select the program you want using the ↑/↓ buttons.

The reminder will remain on-screen for three minutes before it automatically disappears.
Using the TV Guide On Screen™ interactive program guide

Searching for programs
The Search screen lets you search for programs alphabetically, by category or by keyword. You can also search for HDTV programs.

Searching by category
Here you can search for programs by category, and then by a further sub-category if you want.

1. Select ‘SEARCH’ from the Service bar at the top of the screen.

2. Press \( \downarrow \) to move to the search category bar, then use the \( \uparrow/\downarrow \) buttons to select a search category.

The available categories are:
- Movies
- Sports
- Children
- Educational
- News
- Variety
- Series
- HDTV

3. Press \( \downarrow \) to move to the search sub-categories and select the sub-category you want.

The sub-categories available depend on the category you chose in the last step.

4. Press ENTER to display a listing of upcoming programs that match the categories you chose.

5. Highlight a program listing and press MENU to display the Episode Options menu panel.

See The search Episode Options menu on page 43 for more on this.
- If the program listing is a program now being broadcast you can press ENTER to start watching it immediately.
Using the TV Guide On Screen™ interactive program guide

Searching by keyword
Using this type of search you can enter a keyword to base a search on. The keywords you create are stored so you can use them again in the future.

1 Select 'SEARCH' from the Service bar at the top of the screen.

2 Press \ to move to the search category bar, then use the \ buttons to select 'KEYWORD'.

3 Press ENTER to display the Keyword Search menu.

4 Select 'new search'.

5 If you want to change the category, move up and select the category you want.

6 Highlight 'enter keyword' and press ENTER.

7 Input a keyword to search for.

8 Select 'DONE' to start the search.
Using the TV Guide On Screen™ interactive program guide

9 Highlight a program listing, press ENTER, select an episode and press MENU to display the Episode Options menu panel.

See The search Episode Options menu on page 43 for more on this.

- If the program listing is a program now being broadcast you can press ENTER to start watching it immediately.

Alphabetical search
This search is designed to display all programs that start with a particular letter.

1 Select ‘SEARCH’ from the Service bar at the top of the screen.

2 Press ↓ to move to the search category bar, then use the ←/→ buttons to select ‘ALPHABETICAL’.

3 Press ENTER.

4 Select a letter and press ENTER to display all programs starting with that letter.

5 Highlight a program listing, press ENTER, select an episode and press MENU to display the Episode Options menu panel.

See The search Episode Options menu on page 43 for more on this.

- If the program listing is a program now being broadcast you can press ENTER to start watching it immediately.

HDTV search
Select this option to display a list of all the upcoming HDTV broadcasts.

1 Select ‘SEARCH’ from the Service bar at the top of the screen.
Using the TV Guide On Screen™ interactive program guide

2 Press ↓ to move to the search category bar, then use the ←/→ buttons to select ‘HDTV’.

3 Press ENTER to start the search.

4 Highlight a program listing and press MENU to display the Episode Options menu panel.

See The search Episode Options menu below for more on this.

Navigation and search tips

- The ↑/↓ buttons move the highlight between options in the panel menu. Use the number buttons to input information.
- If a highlighted field has arrows on either side, use the ←/→ buttons to cycle through the options.
- Press ENTER on any option to highlight the default command (eg., Done), then press ENTER again to execute and close the panel menu.
- Select Cancel and press ENTER to close the panel menu and return to the previous screen, or press MENU to cancel any changes and close the menu.

The search Episode Options menu

From the Episode Options menu you can select:

- go to Service bar – close the menu panel and return to the Service bar at the top of the screen.
- tune to channel / watch now – exit the TV Guide On Screen guide and tune to the channel.
- set recording – go to the Record Option menu (see Recording programs on page 37).
- set reminder – go to the Remind Option menu (see Setting program reminders on page 39).
- cancel – close the menu panel and return to the highlighted program listing.
Using the TV Guide On Screen™ interactive program guide

Scheduling recordings and reminders
From the Schedule area you can review, edit or delete recordings and reminders.

1 Select ‘SCHEDULE’ from the Service bar at the top of the screen.

A list of programs that have record or remind events scheduled appears. The icons on the right side indicate the status of the events.

- **Once only recording.**
- **Daily** recording (Monday through Friday at the same time each day).
- **Regularly** – Record the same program any day it airs on the same channel at the same time.
- **Weekly** recording (every week at the same time/day).
- **Off** – the program remains in the list, but will not be recorded until the frequency is changed to one of the above.
- **Once only reminder.**
- **Daily** reminder (Monday through Friday at the same time each day).
- **Regularly** – Remind the same program any day it airs on the same channel at the same time.
- **Weekly** reminder (every week at the same time/day).

When you highlight a program in the list you’ll see information related to that program appear in the information box.

The Schedule Options menu
The Schedule Options menu is accessible by pressing MENU when either SCHEDULE is highlighted in the Service bar, or a program is highlighted.

When SCHEDULE is highlighted:
- **go to Service Bar** – close the menu panel and return to the Service bar at the top of the screen.
- **sort by** – select a sort order for the program listings.
- **new manual recording** – select and then fill in all the necessary fields to set the recording. Select schedule recording when you're done to save and exit, or select cancel to exit without saving.
- **new manual reminder** – select and then fill in all the necessary fields to set the reminder. Select schedule reminder when you're done to save and exit, or select cancel to exit without saving.
- **done** – close the menu panel and return to the highlighted program listing.
- **cancel** – close the menu panel without saving any changes and return to the highlighted program listing.

When a program is highlighted:
- **go to Service Bar** – close the menu panel and return to the Service bar at the top of the screen.

Note
1 The program will still be recorded if it starts any time up to the midway point of the originally scheduled program. For example, up to 9:15 for a 9:00 to 9:30 program.
2 The reminder will still appear if the program starts any time up to the midway point of the original schedule. For example, up to 9:15 for a 9:00 to 9:30 program.
Using the TV Guide On Screen™ interactive program guide

- **watch now** — start watching the selected program (this option is **tune to channel** for a program that isn’t showing now).
- **set recording** — set the program to record (set the recording options from the following menu).
- **delete recording** — remove the recording from the schedule (requires confirmation).
- **edit recording** — edit the recording settings from the following menu.
- **set reminder** — set the program to remind (set the reminder options from the following menu).
- **delete reminder** — remove the reminder from the schedule (requires confirmation).
- **edit reminder** — edit the reminder settings from the following menu.
- **cancel** — close the menu panel and return to the highlighted program listing.

As you highlight an option you can see the settings you can adjust in that area:
- **System Settings** — Zip/postal code and cable setup
- **Channel Display** — Channel position, tuning channel, display on/off, etc.
- **Default Options** — General, recording and reminder defaults

**Changing the System Settings**
The System Settings include your zip/postal code and your cable TV setup.

1. Highlight the ‘Change System Settings’ item.

**Changing the Channel Display settings**
From the Channel Display settings you can set/change:
- the channel position in the channel listing.
- the tune channel number.
- the display setting to always display (On), never display (Off), or display only when channel information is available (Auto Hide).

**Changing setup options**
You can change TV Guide On Screen settings from the Setup menu. Setup options are divided into three categories: System Settings, Channel Display, and Default Options.

1. Select ‘SETUP’ from the Service bar at the top of the screen.

2. Use the ↓ button to select one of the setup areas.

3. Select one of the options, then follow the on-screen instructions.
Using the TV Guide On Screen™ interactive program guide

1. Highlight the ‘Change Channel Display’ item.

2. Press ENTER to display the channel editor.

3. Use the ↑/↓ buttons to highlight a channel then press ENTER to go to the Grid Options menu.

   From the Grid Options menu you can set:
   - **tune channel** – the channel number that the channel listing is tuned to
   - **service** – the type of service that the channel operates on (cable, cable box, etc.)
   - **channel** – On (display in channel list), Off (don’t display) or Auto Hide (hide when no program information available)
   - **position** – place that the channel appears in the channel list

4. When you’ve made all the settings you want for the channel, highlight ‘done’ then press ENTER.
   - To cancel without saving any of the changes you made, select **cancel**.

Changing the Default Options

This is the place to change the default settings for recordings, reminders and other general settings.

1. Select the ‘Change Default Options’ item.

2. Select one of the three default option categories. A different menu panel appears for each option:
   - **General default options**
     - **Info box size** – the initial size of the information box (no, small, large, last used)
     - **box cycle** – the cycle behavior of the information box (no only, small only, large only, no & small, no & large, small & large, all)
     - **auto guide** – Display TV Guide On Screen guide automatically when you switch on the recorder (On, Off)
   - **Record defaults**
     - **start** – when to start a recording (up to 120 mins earlier or later than set, or On time)
     - **end** – when to end a recording (up to 120 mins earlier or later than set, or On time)
     - **recorder** – by default, record to DVD or HDD
     - **quality** – recording quality
   - **Remind defaults**
     - **auto tune** – automatically tune to the correct channel when a reminder becomes due (On or Off)
     - **when** – when to display the reminder (15 mins early to 15 mins late, or On time)
Using the TV Guide On Screen™ interactive program guide

3. When you’ve made all the settings you want, highlight ‘done’ then press ENTER.
   • To cancel without saving any of the changes you made, select cancel.

TV Guide On Screen FAQ and troubleshooting

This FAQ covers only a few questions. For a complete list please consult the TV Guide On Screen website at: www.tvguideonscreen.com

FAQ

• If I add a recorder or change my cable service, how do I change my setup information?
  Highlight Setup service, select Change system settings, then follow the on-screen instructions.

• A show entry reads “No listing.” What does that mean?
  Show information for that entry was not available during the last information update (download). Show information is updated daily.

• When I entered the TV Guide On Screen guide, I was asked to choose from more than one channel line-up. What should I do?
  Select the line-up that most closely matches the one for your area. If after you choose the line-up you want to make changes to it:
  Highlight Setup service, select Change channel display, then follow the on-screen instructions.

• What do the colors for shows in the Listings and Search screens indicate?
  Green = sports; dark blue = children’s; purple = movies; teal = others.

• If there’s a power outage, do I have to complete the Setup again?
  No. All the setup information will still be stored in the TV Guide On Screen system.

• Is Help available within the TV Guide On Screen guide? If so, how do I find it?
  Yes. Highlight any of the five main Services (Listings, Schedule, Recordings, Setup, Search) and press the INFO button. An expanded info box displays additional help information. Press INFO again to close the box.

• I’ve noticed some stars displayed after show titles. What do they mean?
  These stars are a broadcast industry rating system used to inform you of a show’s quality. Four stars is the highest rating; one the lowest.

• I’ve seen the word “download” in reference to the TV Guide On Screen system. What does that mean?
  The recorder downloads channel and show information at least once a day. These downloads are completely automatic.

• Can I set a record or remind event without highlighting a show title in the program listing?
  Yes. The TV Guide On Screen system has a manual Record and Remind feature. Highlight SCHEDULE and then press menu. Choose Recording or Remind as the event type, press ENTER, then enter the necessary channel, date and time information.

• What do the frequencies for record and remind mean?
  Once – records/reminds once only.
  Daily (manual only) – records the time, channel, input, recorder combination Monday through Friday.
  Regularly – records/reminds the show every time the show airs on the same channel at the same time.
  Weekly – records/reminds the show every time the show airs on the same channel at the same time on the same day of the week.
  Off – keeps the show in the list of scheduled recordings/reminders, but will not record/remind the show until the frequency is changed to one of the above. Note that this is not the same as canceling or deleting the record/reminder.

• How can I look for a specific show in the TV Guide On Screen guide?
  The Search service lets you find shows by category (alphabetical, HDTV, movies, sports, children, educational, news, variety, series), or by keyword.
Using the TV Guide On Screen™ interactive program guide

Troubleshooting

- **My listings disappeared after a power failure.**
  You should start to receive listings again within 24 hours.

- **Some channel numbers that appear are incorrect.**
  You can correct them using the Change Channel Display option under Setup.

- **I haven’t received any program listings.**
  Listings usually appear within 24 hours after successfully setting up. It may take up to one week to receive all eight days of listings. Your recorder must be in standby mode to receive listing updates.
  - Check the connections between the recorder, cable, antenna and the IR cable if you’re using a cable box.
  - Verify the Setup information under Change system settings.
  - Make sure that your cable box is switched on (if applicable).

- **A show I set to record didn’t record.**
  - Make sure the recorder is in standby before the recording is due to start.
  - For DVD recording, make sure there is a recordable DVD loaded.
  - Check that the recording appears in the Schedule listing.

- **The TV Guide On Screen system didn’t automatically tune to a show that I set a reminder for.**
  - Check that the reminder appears in the Schedule listing.
  - If you have a cable box, check the placement of the IR cable.

- **I set a reminder with auto-tune, but the channel didn’t change.**
  - Check the Schedule and make sure that the show is listed as a reminder.
  - Highlight the show in the Listings screen, press MENU then highlight edit reminder, then press ENTER. Make sure that the Auto-tune option reads Yes.
  - The TV must be on when the reminder is due for automatic channel tuning to work.
Chapter 6

Recording

About DVD recording
This recorder can record on both DVD-R and DVD-RW media. The main difference between the two is that DVD-R discs can only be recorded once, while DVD-RW can be recorded, erased and re-recorded many times.

Both types of disc can be initialized for Video mode or VR mode recording. Each has its advantages, and it depends on what you want to do with the recording which mode you choose.

If you want to edit your recordings in any significant way, VR mode offers greater possibilities for cutting, copying, and changing the way the video is presented.

Video mode is less flexible when it comes to editing, but it has the advantage that it is compatible with standard DVD players (many of which won’t play VR mode discs).

Once a disc is initialized for a particular mode, all recording on that disc will be in that mode.

Important
- The maximum number of titles and chapters that can be recorded on a VR mode disc is 99 and 999 respectively; on a Video mode disc the maximum number of titles and chapters is 99 and 99. No more recording is possible on a disc that already contains the maximum number of chapters/titles.

- Unfinalized Video mode discs are not usable in other DVD recorders. Likewise, unfinalized video mode discs recorded using other recorders are not usable in this recorder.

- If power to the recorder is cut (due to a power outage, the plug being pulled from the power outlet, etc.) during recording, editing, initializing, finalizing or other operation, some recorded material on the disc, or the disc itself, may become unusable. In this case, try re-initializing the disc (DVD-RW only), or use a new disc. Pioneer is not responsible for lost recordings, damaged discs or other losses in these cases.

- Fingerprints and small scratches on a disc can affect playback and/or recording performance. Please take proper care of your discs.

- See also Disc / content format playback compatibility on page 10 for detailed disc compatibility information.

About HDD recording
Recording to the internal hard disk drive (HDD) is very flexible; you have the full choice of recording quality options, including manual mode, and of course you can record, erase and re-record as many times as you like.

Important
- The maximum number of titles/chapters per title that can be recorded on the HDD is 999 and 99 respectively. No more recording is possible on the HDD after the maximum number of titles has been reached.

- The maximum continuous recording time for one title is 12 hours.

HDD Video mode compatibility
When recording to the HDD you can choose to record in one of two formats. Set the format from the HDD Recording Format item in the Initial Setup menu (see page 95).

When set to Video Mode On, high-speed copying from HDD to Video mode DVD is possible. When recording a broadcast with a Secondary Audio Program (SAP) channel, set which channel you want to record from the Initial Setup menu (see Dual Mono Recording on page 93).

When HDD Recording Format is set to Video Mode Off, high-speed copying isn’t possible. However, when SAP is selected as the broadcast audio channel, both the main and SAP channels are recorded and you can switch the audio on playback.

Note
1. Some DVD players, such as some Pioneer models, are compatible with VR mode discs. Check the operating instructions for your player for VR mode compatibility information.
**Recording time and picture quality**

There are six preset recording quality modes:

- **XP** – High quality setting, gives about one hour of recording time on a DVD disc.
- **SP** (Standard Play) – Default quality, used for most applications, gives about two hours of recording time on a DVD.
- **LP** (Long Play) – Lower video quality than SP, but doubles the recording time on a DVD to about four hours.
- **EP** (Extended Play) – Lower quality than LP, but gives about six hours of recording time on a DVD disc.
- **SLP** (Super Long Play) – Lower quality than EP, but gives about eight hours of recording time on a DVD disc.
- **SEP** (Super Extended Play) – Lowest video quality but gives about ten hours of recording time on a DVD disc.

Please note that there is a trade-off between recording time and quality. The longer the possible recording time, the lower the recorded picture quality. You may wish to try recording different kinds of programs in different recording modes to determine the combination of picture quality and recording time that suits your needs. We recommend using the XP mode for recording fast-moving or action programs.

In addition to these settings, when Manual Recording is On (see Manual Recording on page 95) you can access 32 different recording quality/time settings (MN1–MN32), a high-quality audio mode (LPCM), and a super-high quality (data transfer rate of around 15 Mbps) HDD recording mode (XP+).

**Restrictions on video recording**

You cannot record copy-protected video using this recorder. Copy-protected video includes DVD-Video discs and some satellite broadcasts. If copy-protected material is encountered during a recording, recording will pause automatically and an error message will be displayed on-screen. Video that is ‘copy-once only’ can only be recorded on the HDD or in VR mode (see below).

When recording a TV broadcast or through an external input, you can display copy control information on screen. (see Displaying disc information on-screen on page 32).

**CPRM**

CPRM is a copy protection/scrambling system developed for the recording of ‘copy once’ broadcast programs. CPRM stands for Content Protection for Recordable Media.

This recorder is CPRM compatible, which means that you can record copy-once broadcast programs, but you cannot then make a copy of those recordings. CPRM recordings can only be made on CPRM-compatible DVD-R (ver. 2.0/8x or higher) or DVD-RW (ver. 1.1 or higher) discs formatted in VR mode or on the HDD. DVD CPRM recordings can only be played on players that are specifically compatible with CPRM.

**Recorded audio**

In all except the LPCM mode, sound is recorded in two channel Dolby Digital format. When set to LPCM, sound is recorded in high quality, uncompressed Linear PCM format.

If the broadcast audio has a SAP channel and you are recording in Video mode or to the HDD with the HDD Recording Format set to Video Mode On, or on the LPCM setting, use the AUDIO button to select the Mono, Stereo or SAP audio channel to record before recording starts. In other cases, if SAP is selected then both the main and SAP audio channels will be recorded and you can switch on playback.

The table below shows the different audio output possibilities:

<table>
<thead>
<tr>
<th>Audio setting</th>
<th>Audio output</th>
</tr>
</thead>
<tbody>
<tr>
<td>MONO</td>
<td>L + R</td>
</tr>
<tr>
<td>STEREO</td>
<td>L</td>
</tr>
<tr>
<td>SAP</td>
<td>L + R</td>
</tr>
</tbody>
</table>

**Audio setting**

<table>
<thead>
<tr>
<th>Audio output</th>
<th>Left (L)</th>
<th>Right (R)</th>
</tr>
</thead>
<tbody>
<tr>
<td>MONO</td>
<td>L + R</td>
<td>L + R</td>
</tr>
<tr>
<td>STEREO</td>
<td>L</td>
<td>R</td>
</tr>
<tr>
<td>SAP</td>
<td>L + R</td>
<td>SAP</td>
</tr>
</tbody>
</table>

**Note**

1. All recording times (both in this manual and those shown by the recorder) are approximate. This is because of the way that the video is recorded; you may get slightly more or slightly less, depending on what you’re recording.
Recording

• This product incorporates copyright protection technology that is protected by method claims of certain U.S. patents and other intellectual property rights owned by Macrovision Corporation and other rights owners. Use of this copyright protection technology must be authorized by Macrovision Corporation, and is intended for home and other limited viewing uses only unless otherwise authorized by Macrovision Corporation. Reverse engineering or disassembly is prohibited.

Setting the picture quality/recording time

Before starting a recording, you will usually want to set the picture quality/recording time. There are six standard settings available, which allow you to choose a balance between picture quality and recording time.

When Manual Recording is set to On (see Manual Recording on page 95), a further option will be available (MN1–32, LPCM or XP+, depending on what you set). See also Recording time and picture quality on page 50 for more information.

• Press REC MODE repeatedly to select a recording setting.
  • XP – High quality
  • SP – Standard play
  • LP – Long play
  • EP – Extended play
  • SLP – Super Long play
  • SEP – Super Extended play
  • MN / LPCM² / XP+ – Manual / Linear PCM / XP+ (available only when manual recording is on)

The setting is indicated in the front panel display, and shown on-screen together with the recording time for a blank recordable disc. If a recordable disc is loaded, the approximate remaining recording time for that disc is also shown. (Note that if the On Screen Display setting (see On-Screen Display on page 96) is Off then this information is not displayed.)

Basic recording from the TV

Follow the instructions below to record a TV program. Recording starts immediately and continues until the disc is full or you stop the recording.

1 Press HDD or DVD to record to the hard disk drive or a recordable DVD respectively.
  • If you’re recording to DVD, load a recordable disc (if you load a new blank DVD-RW disc, the recorder takes a short while to initialize the disc).

2 Use the CH +/- buttons to select the TV channel to record.

The front panel display shows the channel number:

Note

1. Audio is recorded in 16-bit Linear PCM format, video is recorded at XP quality. When recording a broadcast with a SAP channel, select which audio channel to record (see Dual Mono Recording on page 93).
2. Applicable only to HDD recording. (If this setting is used when recording to DVD, MN32 is used.) When copied to DVD, XP+ recordings are always copied in real time.
While the recorder is stopped, you can also use the number buttons on the remote to select the channel. (For channel 6, press 6 then ENTER; for channel 24, press 2, 4 then ENTER)

If the recorder is stopped, you can also use the ↑/↓ buttons on the front panel to select the channel number.

3 Use the REC MODE button to set the picture quality/recording time.
   • See Setting the picture quality/recording time above for detailed instructions.

4 If the broadcast audio has a SAP channel (Second Audio Program), press AUDIO to select the audio channel to record.
   Press repeatedly to switch between Mono, Stereo and SAP audio channels.
   • When recording in VR mode (DVD) or with HDD Recording Format set to Video Mode Off (HDD), both mono and SAP audio channels are recorded, allowing you to switch the audio channel on playback. The only exception to this is when the picture quality is set to LPCM, in which case you do need to select the audio channel before recording.

5 Press ● REC to start recording.
   If you want to set a recording end time, press the ● REC button repeatedly. The recording time increases in 30 minute increments, up to a maximum of six hours. The time the recording will end is shown on-screen and in the front panel display. When the recording ends, the recorder automatically switches into standby if no other operation is being performed.
   • To cancel the set recording time, press ● REC.
   • If you want to pause recording at any time, press II PAUSE. Press again to restart the recording. (If recording to the HDD or in VR mode, a new chapter is started after recording restarts)

6 To stop the recording, press □ STOP REC.
   • If you set the recording time in the previous step, you can still stop the recording anytime by pressing □ STOP REC.
   • Recording will stop automatically when there is no more space on the HDD/DVD, or after 12 hours of HDD recording (whichever is sooner).

---

**Simultaneous recording and playback**

**VR mode**

A feature called Chase Play makes it possible to watch a recording in progress (DVD or HDD) from the start of the recording (as in, playback is ‘chasing’ the recording). For example, perhaps you have to miss the first 30 minutes of a movie on TV; you can start recording, then start watching the movie, from the beginning, while the recorder is still recording 30 minutes ahead of you.

In fact, you’re not just limited to watching the recording in progress; you can watch anything else already on the DVD or HDD by selecting it from the Disc Navigator screen (see Using the Disc Navigator with recordable discs and the HDD on page 58).

**Important**

• Note that you must use a DVD-RW Ver. 1.1 / 2x or Ver. 1.2 disc to be able to use this feature.
• You may not be able to use this feature with a DVD-RW disc that was first initialized on another recorder.
• Chase playback is not possible using a VR mode DVD-R disc.
• During recording, press ● PLAY to start playback from the beginning of the current recording, or press DISC NAVIGATOR and select another title to play from there.

You can use all the usual playback controls, such as pause, slow-motion play, scan and skip.
• To stop playback, press ■ STOP (recording will continue).
• To stop recording, press □ STOP REC (playback will continue).

---

**Note**

1. You can’t start playback immediately after recording starts. Simultaneous playback and recording doesn’t work while copying or backing up.
2. When scanning a DVD, no sound is output if the recorder is also recording the DVD (see Scanning discs on page 60).
Recording from an external component

You can record from an external component, such as a camcorder or VCR, connected to one of the recorder’s external inputs.

1. Make sure that the component you want to record from is connected properly to the DVD recorder. See Chapter 2 (Connecting up) for connection options.

2. Press INPUT SELECT repeatedly to select one of the external inputs to record from. There are three analog inputs and a DV digital input. The current input is shown on-screen and in the front panel display:
   - L1 – Input 1
   - L2 – Input 2 (front panel)
   - L3 – Input 3
   - DV – DV input (front panel – DVR-633/533H-S only)
Check that the Audio In settings for External Audio, Dual Mono Recording and DV Input are as you want them (see Audio In Settings on page 93).
   - If the aspect ratio is distorted (squashed or stretched), adjust on the source component or your TV before recording.

3. Set up the recorder.
   - Use REC MODE to set the recording quality. See Setting the picture quality/recording time on page 51 for detailed information.
   - Press HDD to record to the hard disk drive, or DVD to record to a DVD.

4. Press ● REC when you’re ready to start recording.
   - The recorder will only start recording from the DV IN jack if there is a valid signal. Recording will also pause if the signal is interrupted during recording.
   - If your source is copy-protected using CopyGuard, you will not be able to record it. See Restrictions on video recording on page 50 for more details.

Recording from a DV camcorder

DVR-633/533H-S only

You can record from a DV camcorder connected to the DV IN jack on the front panel of this recorder. Using the recorder’s remote, you can control both the camcorder and this recorder.
Before recording, make sure that the audio input for the DV IN jack is setup (see DV Input on page 93).
Recording

Important
- The source signal must be DVC-SD format
- Some camcorders cannot be controlled using this recorder’s remote.
- If you connect a second recorder using a DV cable, you cannot control the second unit from this one.
- You can’t control this unit remotely from a component connected to the DV IN jack.
- You can’t record date and time information from DV cassette.
- During DV recording, if a part of the tape is blank, or has copy-protected material on it, this recorder will pause recording. Recording will restart automatically when there is a recordable signal. However, if there is more than 10 seconds of blank tape, this recorder will stop recording and the camcorder should stop (depending on the camcorder).
- For best results when recording from a DV camcorder to this recorder, we recommend cueing the camcorder to the place you want to start recording from and setting the camcorder to play-pause.

1 Make sure your digital camcorder is connected to the front panel DV IN jack.
Also, set the camcorder to VTR mode.

2 Set up the recorder.
   - Use REC MODE to set the recording quality. See Setting the picture quality/recording time on page 51 for detailed information.
   - Make sure a recordable disc is loaded if you want to record to DVD.

3 From the Initial Settings menu, check that the DV audio input is setup as you require.
See DV Input on page 93 for more on this.
   - Check also that the Audio In settings for External Audio and Dual Mono Recording are as you want them (see Audio In Settings on page 93).

4 Press HOME MENU, select ‘Copy’, then ‘DV Record’ from the menu.
   - DV recording only works when the digital camcorder is in VTR mode with a tape loaded.

5 Select ‘Record to Hard Disk Drive’ or ‘Record to DVD’ to record to the hard disk drive or a recordable DVD respectively.

6 Find the place on the camcorder tape that you want to start recording from.
For best results, pause playback at the point from which you want to record.

- Depending on your camcorder, you can use this recorder’s remote to control the camcorder using the ▶, ▼, ▪, □, ◀, ▶, ▼ and □ buttons.

7 Use the ↑/↓ buttons to select ‘Start Rec’ and press ENTER.

- Recording is automatically paused if the recorder detects no signal, or a copy-protected signal. Recording restarts when there is a non-copy-protected signal.
- You can pause or stop the recording by selecting Pause Rec or Stop Rec from the on-screen display.
- You cannot control the camcorder from this remote control during recording.
- If you restart recording after stopping the camcorder, the first few seconds of the camcorder tape will not be recorded. Use the pause button on your camcorder instead and recording will start immediately.
- HDD and DVD-RW (VR Mode) only: A chapter marker is inserted every time there is a break in the timecode on the DV tape. This happens when the recording is stopped or paused then restarted, for example.
- While recording, you cannot exit the DV recording screen using the HOME MENU or RETURN button.
- See also DV-related messages on page 104 if you encounter an error while using the DV IN jack.

Frequently Asked Questions
- I can’t get my DV camcorder to work with the recorder!
  Check that the DV cable is properly connected. Also make sure that what you’re trying to record is not copy-protected.
  If it still doesn’t work, try switching off the camcorder then switch back on.
- There’s a picture, but no sound!
  Try switching the DV Input setting (see DV Input on page 93) between Stereo 1 and Stereo 2. 1

1 If the audio subcode on the DV tape cannot be read correctly, the audio type will not switch automatically. You can switch the audio manually from the External Audio setting (page 93).
Playing your recordings on other DVD players

Most regular DVD players can play finalized discs recorded in Video mode. A number of players (including many Pioneer models) can also play DVD-RW discs recorded in VR mode, finalized or not. Most players will not play VR mode DVD-R discs, although some DVD-ROM drives and DVD recorders may be able to (finalization might be necessary). Check the manual that came with the player to check what kinds of discs it will play.

When you finalize a Video mode disc, a title menu is created from which you can select titles when you play the disc. There are a number of different styles of title menu to choose from to suit the content of the disc. All the title menus are navigated in the usual way, pressing MENU or TOP MENU to display the menu, then using the / arrow followed by ENTER to select titles and start playback.

Finalizing a disc

Finalizing ‘fixes’ the recordings in place so that the disc can be played on a regular DVD player or computer equipped with a suitable DVD-ROM drive.

Note that the disc name will appear in the title menu after you finalize a disc. Make sure the disc name is as you want it before you finalize the disc as it can’t be changed afterwards. If you want to rename the disc, see Input Disc Name on page 87 before starting the steps below.

Important

- Once you’ve finalized a disc recorded in Video mode, you can’t edit or record anything else on that disc. However, the finalization on a DVD-RW disc maybe ‘undone’, see Undo Finalize on page 88 for how to do this.
- A VR mode disc can still be recorded and edited on this recorder even after finalizing.

1 Load the disc you want to finalize.
   Make sure that the recorder is stopped before proceeding.

2 Press HOME MENU and select ‘Disc Setup’.

3 Select ‘Finalize’.

4 Select ‘Finalize’ from the finalize options, then ‘Next Screen’.

5 For Video mode discs only, select a title menu style, then select ‘Yes’ to start finalization or ‘No’ to cancel.
   The menu you select will be the one that appears when the ‘top menu’ is selected on any DVD player.

6 The recorder will now start finalizing the disc.
   During finalization:
   - If the finalization process of a DVD-RW disc is going to take more than around four minutes, you can press ENTER to cancel. Around four minutes before completion, the option to cancel disappears.
   - You can’t cancel the finalization of a VR mode DVD-R disc.
   - How long finalization takes depends on the type of disc, how much is recorded on the disc and the number of titles on the disc. A disc recorded in VR mode can take up to one hour to finalize. A disc recorded in Video mode can take up to 20 minutes.
Initializing a recordable DVD disc

When you first load a blank disc, the recorder will initialize it automatically for recording. You can also manually initialize discs for either Video mode recording or VR mode recording.\(^1\)

By default, the recorder initializes blank DVD-RW discs for VR mode recording. See DVD-RW Auto Init. on page 95 if you want to change the default to Video mode.

DVD-R discs are ready for Video mode recordings out of the box; if you want to use a DVD-R for VR mode recording, you must do it before recording anything else on the disc.

\(^1\) Press HOME MENU and select ‘Disc Setup’.
2 Select ‘Initialize’
3 Select ‘Video Mode’ or ‘VR Mode’ from the initialize options.
4 Select ‘Start’.
It takes about 30 seconds to initialize the disc.

Important
- Initializing a DVD-RW disc will erase everything recorded on it. Make sure there is nothing on the disc that you want to keep!
- You may not be able to re-initialize a DVD-RW disc in a different format if it was originally initialized on an older DVD recorder.
- Once initialized for VR mode recording, you can’t re-initialize a DVD-R back to Video mode.

Note
1. If a disc was previously finalized on an older DVD recorder, you may not be able to re-initialize and/or initialize it for Video mode recording.
Chapter 7
Playback

Introduction
Most of the features described in this chapter make use of on-screen displays. Navigate these using the \( \uparrow / \downarrow \) and ENTER. To go back one level from any screen, use the RETURN button. Remember also that the button guide at the bottom of every screen shows which buttons do what.

Many of the functions covered in this chapter apply to the HDD, DVD discs, Video CDs, WMA/MP3 discs and CDs, although the exact operation of some varies slightly with the kind of disc loaded. The following icons are provided to help you quickly identify which instructions you need for which kind of disc.

- DVD: Any kind of DVD, DVD-R or DVD-RW
- DVD-Video: Commercially produced DVD or finalized Video mode DVD-R/RW
- Video mode: Video mode DVD-R/RW (unfinalized)
- VR mode: VR mode DVD-R/RW
- HDD: HDD
- CD: Audio CD
- Video CD: Video CD
- WMA/MP3: WMA or MP3 files

- Some DVD-Video discs don’t allow certain playback controls to operate at certain points in the disc. This is not a malfunction.
- When playing Video CDs, some functions, such as making a program list, are not available in PBC mode. Stop the disc first, then start playback by pressing \( \uparrow / \downarrow \).
- For discs that contain JPEG picture files, see The PhotoViewer on page 85.

About DualDisc playback
A DualDisc is a new two-sided disc, one side of which contains DVD content—video, audio, etc.—while the other side contains non-DVD content such as digital audio material.

The non-DVD, audio side of the disc is not compliant with the CD Audio specification and therefore may not play.

It is possible that when loading or ejecting a DualDisc, the opposite side to that being played will be scratched. Scratched discs may not be playable.

The DVD side of a DualDisc plays in this product. DVD-Audio content will not play.

For more detailed information on the DualDisc specification, please refer to the disc manufacturer or disc retailer.

Navigating discs and the HDD

1. During playback use the number buttons to enter a chapter number within the current title. For example, for chapter 6, press 6; for chapter 24, press 2, then 4.
   - To clear and start again, press CLEAR.
2. Optionally: Press ENTER.
   - Alternatively, just wait a few seconds and playback will jump to the new chapter.

1. During playback, use the number buttons to input a title number.
   For example, for title 6, press 6; for title 24, press 2, then 4.
   - To clear and start again, press CLEAR.
2 Optionally: Press ENTER.
   • Alternatively, just wait a few seconds and playback will jump to the new title.

1 During playback, use the number buttons to input a track number.
   For example, for track 6, press 6; for track 24, press 2, then 4.
   • To clear and start again, press CLEAR.
2 Optionally: Press ENTER.
   • Alternatively, just wait a few seconds and playback will jump to the new track.

Using the Disc Navigator to browse the contents of a disc.
Use the Disc Navigator to browse the contents of a disc and start playback.

Using the Disc Navigator with recordable discs and the HDD
You can use the Disc Navigator to browse and edit video on recordable DVDs and the HDD, and to view information on titles.
See also Editing on page 76 for more on editing recordable discs.

1 Press HDD or DVD to select the hard disk drive or DVD.
2 Press HOME MENU and select ‘Disc Navigator’ from the on-screen display.
Alternatively, you can press DISC NAVIGATOR to go straight to the Disc Navigator screen.

3 Use the ↑/↓ buttons to browse up and down the list of titles.
   • Use the ◀/▶ buttons to display the previous/next page of titles, if there are more titles than can fit on to the screen.
   • You can change the style and order in which titles are displayed from the view options menu. See below for more on this.
   • You can change the thumbnail picture displayed for a title; see Set Thumbnail on page 79.

4 To play the highlighted title, press ENTER.
   • You can also select Play from the command menu options.

Tip
• Use the time search feature to find a particular point on a DVD or within a title on the HDD. See Search Mode on page 61 for more information.

Changing the display style of the Disc Navigator
You can choose to display titles in the Disc Navigator in various different ways, sorted alphabetically, by recording date, by genre, and so on. You can also choose whether to display four or eight titles on the screen at the same time.

1 From the Disc Navigator’s title list, press ← to display the view options panel.

The View Options panel
2 Use the ↑/↓ buttons to select ‘Style’, ‘Sort Order’ or ‘Genre’, then press ENTER to see the available view options.
   - **Style** – Select four or eight titles per screen view
   - **Sort Order** – Sort by date (most recent first), unwatched first, title name or recording date (oldest first)
   - **Genre** – Display all genres or just a selected genre

3 Use the ↑/↓ buttons to select an option, then press ENTER. The title list display is updated according to the new display preferences.

4 Press ➤ to return to the title list.

Using the Disc Navigator with playback-only discs

1 Press HOME MENU and select ‘Disc Navigator’ from the on-screen display. Alternatively, for a CD, Video CD or WMA/MP3 disc, you can press DISC NAVIGATOR, which takes you straight to the Disc Navigator screen.

2 Select what you want to play. Use the ↑/↓/←/→ to highlight items and ENTER to select. Depending on the type of disc you have loaded, the Disc Navigator looks slightly different.
   - When a DVD is loaded, titles are shown on the left, chapters on the right. Select a title, or a chapter within a title.
   - When a CD or Video CD is loaded, a list of the tracks is displayed.
   - When a WMA/MP3 disc is loaded, a list of folders and tracks is displayed (as shown below). Select a folder or a track within a folder.

Playback starts after you press ENTER.
   - For discs that contain both CD-Audio tracks and WMA/MP3 tracks, you can switch the playback area between CD and WMA/MP3. This can only be done while the disc is stopped.

### Note

1. It’s not possible to use the Disc Navigator when playing a Video CD in PBC mode.
### Scanning discs
You can fast scan discs at various speeds, forwards or backward.\(^1\)

1. During playback, press \(<<<\) or \(>>\) to start reverse or forward scanning.
   - The scanning speed is shown on-screen.
2. Press the same button repeatedly to increase the scanning speed.

   **Forward:**
   - SCAN 1 (1.5x Quick View) → SCAN 2 → SCAN 3 → SCAN 4
   **Reverse:**
   - Reverse play \(^2\) → SCAN 1 → SCAN 2 → SCAN 3 → SCAN 4
3. To resume normal playback, press \(\uparrow\) PLAY.

### Playing in slow motion
You can play video at various slow motion speeds. DVDs and video on the HDD can be played in slow motion in either direction, while Video CDs can only be played forwards in slow motion.\(^3\)

1. Press \(<<<\) or \(>>\) to start slow motion reverse or forward playback.
2. Press the same button repeatedly to change the slow motion speed.
3. To resume normal playback, press \(\uparrow\) PLAY.

---

**Note**
\(^1\) Only analog audio is output when scanning audio CDs.
\(^2\) No subtitles are displayed when scanning DVDs.
\(^3\) Analog and digital sound is output when scanning DVDs with Dolby Digital or Linear PCM sound on forward SCAN 1. (Linear PCM is output from the optical digital output, Except during chase playback and simultaneous recording/playback) No sound is output when using other scan speeds.
\(^4\) No sound is output when scanning from the HDD, except on forward SCAN 1. (Linear PCM is output from the optical digital output during forward SCAN 1).
\(^5\) Depending on the disc, normal playback may automatically resume when a new chapter is reached on a DVD disc.
\(^6\) Depending on the disc, reverse playback may not be smooth.
\(^7\) The picture quality during slow motion playback is not as good as during normal playback and depends on the disc being played.
\(^8\) Reverse slow-motion playback may not be as smooth as forward and may be better with some discs than others.
\(^9\) Depending on the disc, normal playback may automatically resume when a new chapter is reached on a DVD disc.
\(^10\) No sound is output during slow-motion playback.
Frame advance/frame reverse

You can advance or back up video on a DVD disc or the HDD frame-by-frame. With Video CDs, you can only use frame advance.\(^1\)

1. During playback, press PAUSE.
2. Press \(\ll\) or \(\gg\) to back up or advance one frame.
   • Hold down \(\ll\) or \(\gg\) for continuous frame reverse/frame advance.
3. To resume normal playback, press PLAY.

The Play Mode menu

The Play Mode menu gives you access to search functions, repeat and program play functions.

**Important**

• You can’t use the Play Mode features with Video CDs playing in PBC mode, or while a DVD disc menu is being displayed. For other restrictions, see the following sections.

1. Press PLAY MODE to display the Play Mode menu screen.
2. Use the \(\uparrow/\downarrow/\leftarrow/\rightarrow\) and ENTER to navigate.
   • You can also access the Play Mode menu from the Home Menu (press HOME MENU).
3. To exit the Play Mode menu, press HOME MENU or PLAY MODE.

**Search Mode**

The Search Mode feature lets you start playback from a specified point in a disc by time\(^2\) or by title/chapter/folder/track number.

1. Select ‘Search Mode’ from the Play Mode menu.
2. Select one of the search options.

**Note**

1. The picture quality when using frame reverse is not as good as frame advance.
   • Depending on the disc, normal playback may automatically resume when a new chapter is reached on a DVD disc.
2. When using time search, playback may occasionally start slightly before or after the time you input.
Use the number buttons to enter a title/chapter/folder/track number or the search time (in hours, minutes & seconds).

Time Search (HDD, DVD): For example, for 25 minutes into the current title, press 2, 5, 0, 0. For 1 hour and 15 minutes and 20 seconds into the current track, press 2, 5, 2, 0.

Time Search (Video CD): For example, for 2 minutes and 30 seconds into the current track, press 2, 3, 0.

Title/Chapter/Folder/Track Search: For example, for track 6, press 6. Alternatively, you can use the arrow buttons.

Press ENTER.

Tip
- You can often select what you want to watch on a DVD disc from the disc menu. Press MENU or TOP MENU to display the disc menu.

A-B Repeat

The A-B Repeat function allows you to specify two points (A and B) within a track or title that form a loop which is played over and over.1

1. During playback, select 'A-B Repeat' from the Play Mode menu.
2. With 'A (Loop Start)' highlighted, press ENTER at the point you want the loop to start.

After setting the loop start point, the highlight will automatically move down to B (Loop End).

3. With 'B (Loop End)' highlighted, press ENTER at the point you want the loop to end.
   Playback immediately jumps back to the start point and plays the loop round and round.

Note
- If you switch camera angles during A-B repeat play, A-B repeat is canceled.
- You can't use A-B Repeat with WMA/MP3 discs.
- If you switch the camera angle during repeat play of a DVD-Video disc, repeat play is canceled.
3 To resume normal playback, select ‘Repeat Off’ from the Repeat Play menu.

- You can also press CLEAR to cancel repeat play if no menu OSD (such as the Play Mode menu) is displayed.

Program play

This feature lets you program the play order of titles/chapters/folders/tracks on a disc or the HDD.

1 Select ‘Program’ from the Play Mode menu.

2 Select ‘Input/Edit Program’ from the list of program options.

- DVD or HDD:
  
  - You can add a whole title, or a chapter within a title to the program list.
  
  - To add a title, select the title.
  
  - To add a chapter, first highlight the title, then press ➔ and select a chapter from the list.

- CD or Video CD: Select a track to add to the program list.

- WMA/MP3: You can add a whole folder, or a track within a folder to the program list.
  
  - To add a folder, select the folder.
  
  - To add a track, first highlight the folder, then press ➔ and select a track from the list.

After pressing ENTER to add the title/chapter/folder/track, the step number automatically moves down one.

- To insert a step into the program list, highlight the step number where you want to insert another step, then select a chapter/title/folder/track as usual. After pressing ENTER, all the subsequent steps move down one.

- To delete a step from the program list, highlight the step you want to delete, then press CLEAR.

4 Repeat step 3 to build up a program list.

- A program list can contain up to 24 titles/chapters/folders/tracks.

5 To play the program list, press ➔ PLAY.

Program play remains active until you turn off program play (see below), erase the program list (see below), eject the disc or switch off the recorder.

- You can use repeat play with program play. Start playback of the program list then select Program Repeat from the Repeat Play Mode menu (see Repeat play on page 62).

Note

1. When playing a program list of DVD-Video chapters, chapters not included in the program list may be sometimes be played, depending on the disc.
Playback

Tip

- To save your program list and exit the program edit screen without starting playback, press HOME MENU or PLAY MODE.
- You can change the program list by selecting Input/Edit Program from the Play Mode Program menu.
- During program play, press ► to skip to the next program step.
- Press CLEAR during playback to switch off program play (if no menu OSD, such as the Disc Navigator, is displayed). Press while stopped to erase the program list.

Other Program play functions
As well as creating and editing a program list, you can start program play, cancel program play, and erase the program list from the Play Mode menu.

1 Press PLAY MODE and select ‘Program’ from the list of functions on the left.
2 Select a program play function.
   - Input/Edit Program – See above
   - Start Program Play – Starts playback of a saved program list
   - Cancel Program Play – Turns off program play, but does not erase the program list
   - Erase Program List – Erases the program list and turns off program play

Displaying and switching subtitles

Some DVD discs have subtitles in one or more languages; the disc box will usually tell you which subtitle languages are available. You can switch subtitle language during playback.¹

Check the disc packaging for details of the subtitle options.

1 Press SUBTITLE repeatedly to select a subtitle option.
The current subtitle language is shown on-screen and in the front panel display.

2 To switch off subtitles, press SUBTITLE then CLEAR.

Switching DVD soundtracks

When playing a DVD disc recorded with two or more soundtracks (often in different languages), you can switch the soundtrack during playback.²

Check the disc packaging for details of the soundtrack options.

- Press AUDIO repeatedly to select an audio soundtrack.

   • The sound may drop out for a few seconds when switching soundtracks.
   • Some discs feature both Dolby Digital and DTS soundtracks. There is no analog audio output when DTS is selected. To listen to the DTS soundtrack, connect this recorder to a DTS decoder or AV amp/receiver with built-in DTS decoder via the digital output. See Connecting to an AV amplifier or receiver on page 19 for connection details.

Note

1. Some discs only allow you to change subtitle language from the disc menu. Press TOP MENU or MENU to access.
2. Some discs only allow you to change audio language from the disc menu. Press TOP MENU or MENU to access.
Switching audio channels

For HDD or VR mode content that has both a main and a SAP (Secondary Audio Program) audio channel, you can switch between main (L), SAP (R), or both (L+R). When playing Video CDs and audio CDs you can switch between stereo, just the left channel or just the right channel.

1. To display/switch the audio channel, press AUDIO repeatedly. The audio channel(s) currently playing are indicated on-screen.

- **VR mode**
  - L+R – Both channels (default)
  - L – Left/main channel only
  - R – Right/SAP channel only

- **HDD**
  - Stereo – Stereo (default)
  - 1/L – Left channel only
  - 2/R – Right channel only

Switching camera angles

Some DVD-Video discs feature scenes shot from two or more angles—check the disc box for details: it should be marked with a icon if it contains multi-angle scenes. When a multi-angle scene is playing, the same icon appears on screen to let you know that other angles are available (this can be switched off if you prefer—see Angle Indicator on page 96).

- To switch the camera angle, press ANGLE.
  - The angle number is displayed on-screen.
  - If the disc was paused, playback starts again with the new angle.
  - Repeat play is canceled if you change the angle while repeat playback is active.
  - You can also change the angle from some DVD-Video disc menus. Press TOP MENU or MENU to access.

**Note**

1. Only when HDD Video Mode is set to Off. See also HDD Recording Format on page 95.
2. When playing a Dual Mono recording on a VR mode disc, if you are listening to the Dolby Digital soundtrack via the digital output, you cannot switch the audio channel. Set Dolby Digital Out to Dolby Digital – PCM (see Dolby Digital Out on page 93) or listen via the analog outputs if you need to switch the audio channel.
Chapter 8
Copying and back-up

Introduction
Use the copying features of this recorder to:
• Back up important recordings stored on the HDD to a DVD.
• Make a DVD copy of a recording on the HDD to play in another player.
• Transfer video from a DVD to the HDD for editing.
• Transfer edited video from the HDD to DVD.

The simplest way to copy a title is to use the One Touch Copy feature. This copies the currently playing HDD title to DVD, or DVD title to the HDD. See One Touch Copy on page 66 for detailed instructions.

For more sophisticated copying tasks you can build a Copy List of titles to copy, and edit titles so that you only copy the bits you want. See Using Copy Lists on page 67 for detailed instructions.

Where possible, the recorder will copy your recordings at high-speed. Depending on the recording mode, the kind of disc loaded and various other factors, copying can be as fast as one minute per hour of video. See Minimum copying times on page 100 for more on copying times. (Please note that additional time is required for initializing and finalizing a disc.)

If you want to save disc space you can copy video at a lower recording quality (for example, an XP recording on the HDD copied to SP on a DVD). Copying in this way is always done in real-time.

When real-time copying from the HDD to a Video mode DVD, the chapter markers in the original material are not copied. Chapter markers are put into the copy at intervals, according to the Auto Chapter (Video) setting (see also Auto Chapter (Video) on page 95).

Restrictions on copying
Some video material is copy-once protected. This means that it can be recorded to HDD, but it can’t then be freely copied again. If you want to transfer copy-once protected material from HDD to DVD, you’ll need to use a VR mode disc compatible with CPRM Ver. 1.1 or higher (see CPRM on page 50 for more on this). Only one instance of a copy-once protected title can be added to the Copy List, and after it’s been copied, the title is erased from the HDD (it is therefore not possible to copy a locked title that is copy-once protected).

You can identify copy-once protected material during playback by displaying disc information on-screen. If the current title is copy-once protected, an exclamation mark (!) is shown (see Play display 2 on page 34).

Copyright
You may use this product only to reproduce or copy materials for which you own the copyright or have obtained permission to copy from the copyright owner or for which you otherwise have a legal right to reproduce or copy. Unless you own the copyright or have obtained permission from the copyright owner or otherwise have a legal right to reproduce or copy, you may be violating the law, including copyright law, and may be subject to payment of damages and other remedies.

One Touch Copy

The One Touch Copy feature copies the currently playing or selected (in the Disc Navigator) HDD title to DVD, or DVD title to HDD. The whole title is copied, regardless of where in the title you start the copy. HDD to DVD copies are made in the same recording mode. When copying DVD to HDD, the copy is made in whatever recording mode is currently set.

Make sure that a recordable DVD-R/RW disc is loaded when trying to copy from the HDD.

1. If you’re copying from DVD to the HDD, use the REC MODE button to select a recording mode.

   Note that selecting a recording mode higher than the title playing will not result in a better quality recording.

2. During playback, press ONE TOUCH COPY to copy the current title.

   The front panel display indicates that the title is being copied.
   • High-speed copying is used when copying from the HDD to DVD. Playback continues while copying.
   • Real-time copying is used when copying from DVD to the HDD. Playback restarts from the beginning of the title.
Copying and back-up

Canceling One Touch Copy
You can cancel a One Touch Copy once it’s started.

• Press and hold ONE TOUCH COPY for more than a second.
  Copying is canceled and the video already copied is erased.
  • If you cancel a HDD to DVD-R copy, the space available for recording does not return to the pre-copy figure.

Notes on copying using One Touch Copy

Copying to DVD
• Title name, chapter markers, as well as thumbnail picture markers for the Disc Navigator, are also copied. However, if you copy to a Video mode DVD-R/ RW, only the first 40 characters of a name are copied.
• The chapter markers in the copy may not be in exactly the same positions as the original when recording on to a Video mode disc.
• You can’t use the One Touch Copy function to copy a title if any part of the title is copy-once protected.
• A title that contains mixed aspect ratios can’t be copied to a Video mode disc. Use a VR mode disc for this type of material.
• Low resolution (SEP through LP modes1) widescreen material can’t be copied to a Video mode disc. Use a VR mode disc for this type of material.
• When HDD Recording Format is set to Video Mode Off, titles recorded in LP/MN9–15 modes cannot be high-speed copied to a Video mode DVD. Please use a VR mode disc.
• Recordings of dual mono broadcasts cannot be high-speed copied to a Video mode DVD. Please use a VR mode disc.
• XP+ titles cannot be copied to DVD at high-speed.

Copying to the HDD
• The maximum title length for copying is 12 hours.
• Title name and chapter markers are also copied, except when copying from a finalized Video mode disc.
• Thumbnail picture markers and chapter markers for the Disc Navigator are copied, but their position in the copy may be slightly changed from the original.
• If some part of the title being copied is copy-protected, copying will start, but the copy-protected portions will not be copied.

Using Copy Lists
* See also Copyright on page 66.
At its simplest, a Copy List is just a list of HDD or DVD titles that you want to copy. When copying HDD titles to DVD, you can, however, edit the titles in your copy list, erasing chapters you don’t need, or re-naming titles, for example. Edits you make to titles in the Copy List do not affect the actual video content; only the ‘virtual’ content of the Copy List. So you can freely erase and modify anything in your Copy List safe in the knowledge that the actual content is not being altered.

Copying from HDD to DVD

1 Press HOME MENU and select ‘Copy’.

Using Copy Lists

• The recorder can only store one Copy List at a time.
• Resetting the recorder to its factory settings (see Resetting the recorder on page 98) will erase the Copy List.

Note
1. In manual recording mode these equate to MN1–15 (Video Mode Off) or MN1–11 (Video Mode On).
2 Select ‘HDD → DVD’.
If this is the first time to create a Copy List, skip to step 4 below.

3 If there is already a Copy List stored in the recorder, choose whether to ‘Create New Copy List’ or ‘Use Existing Copy List’.
If you select Use Existing Copy List, skip to step 8 below.

• Selecting Create New Copy List will erase any Copy List already stored in the recorder.

4 Select VR mode or Video mode for the copy.
For certain kinds of material you must use VR mode; for greater compatibility with other players, use Video mode.

5 Use the ↑/↓ buttons to highlight titles you want to copy, pressing ENTER after each one to add it to the Copy List.

Titles you’ve added to the Copy List are highlighted in pink.
There are some restrictions on titles that can be added to the Copy List if you are copying to a Video mode DVD:
• When adding titles that contain copy-once protected material, the copy-once parts will not be added.
• When adding titles that contain material of more than one aspect ratio (screen size), each part with a different aspect ratio will be added as a separate title if high-speed copying is possible.

Depending on the title¹, high-speed copying may not be possible to a Video mode disc.

6 Press ➤ to display the command menu panel.

Note
1. Widescreen titles recorded at low resolution (SEP through LP/MN1–15 (Video Mode Off) or MN1–11 (Video Mode On)).
• LP/MN9–15 recordings when HDD Recording Mode is set to Video Mode Off.
• Dual mono recordings.
• Combined titles that were originally recorded using different recording modes.
• XP+ titles.
7 Select ‘Next’ to move on to the Title Edit screen.

Repet this step for as many titles you have that need editing.

9 Press ➩ to display the command menu panel.

10 Select ‘Next’ to proceed to the Start Copy screen.

A menu of editing commands appears:

- **Erase** – Erase individual titles from the Copy List (see page 70).
- **Title Name** – Name or rename a title in the Copy List (see page 70).
- **Erase Section** – Erase part of a title (see page 71).
- **Move** – Change the order of titles in the Copy List (see page 71).
- **Preview** – Check the content of a title in the Copy List (see page 72).
- **Divide** – Divide a title in the Copy List into two (see page 72).
- **Combine** – Combine two titles in the Copy List into one (see page 72).
- **Chapter Edit** – Edit chapters within a Copy List title (see page 72):
  - **Divide** – Divide a chapter into two.
  - **Erase/Move** – Erase a chapter/Change the chapter order.
  - **Combine** – Combine two chapters into one.
- **Set Thumbnail** – Set the thumbnail frame for a title (see page 73).
- **Recording Mode** – Set the picture quality of the copy (see page 73).
- **Dual Mono Audio** – Set how dual mono audio should be copied when copying from HDD to Video mode DVD (see page 74).

**Note**

1. If a timer recording is scheduled to start during copying, the disc will not be finalized.
Copying and back-up

Copying from DVD to HDD

**Important**
- The DVD to HDD Copy screen isn’t accessible when a finalized Video mode disc is loaded. However, you can still use the One Touch Copy function (See One Touch Copy on page 66).
- The recorder can only store one Copy List at a time.
- The Copy List will be erased if:
  - any of the titles on the DVD disc are erased or edited.
  - the disc tray is opened.
  - playback is switched between Play List and Original.
  - the DVD disc is re-initialized or finalized.
  - the recorder is reset to its factory settings (see Resetting the recorder on page 98).
- It may not be possible to copy from a DVD disc that was recorded on a different DVD recorder or a PC.

1. Press HOME MENU and select ‘Copy’.
2. Select ‘DVD/CD → HDD’.
3. If there is already a Copy List stored in the recorder, choose whether to ‘Create New Copy List’ or ‘Use Existing Copy List’.
   - Selecting Create New Copy List will erase any Copy List already stored in the recorder.
4. Use the ↑/↓ buttons to highlight titles you want to copy, pressing ENTER after each one to add it to the Copy List.Titles you’ve added to the Copy List are highlighted in pink.
5. Press → to display the command menu panel.
6. Select ‘Next’ to move on to the Title Edit screen.
7. To edit a title, highlight it using the ↑/↓ buttons, then press ENTER. A menu appears of Copy List editing commands:
   - **Erase** – Erase individual titles from the Copy List (see page 70).
   - **Move** – Change the order of titles in the Copy List (see page 71).
   - **Preview** – Check the content of a title in the Copy List (see page 72).
   - **Cancel** – Exit the Copy List screen without saving any changes.
   Repeat this step for as many titles you have that need editing.
8. Press → to display the command menu panel.
9. Select ‘Next’ to proceed to the Start Copy screen.
   - Select Recording Mode if you want to change the recording quality (see Recording Mode on page 73).
10. Select ‘Start Copy’ to start copying.

Erase
Use this command to erase individual titles from the Copy List.
1. Highlight the title you want to erase.
2. Select ‘Erase’ from the command menu panel.
3. Select ‘Yes’ to confirm or ‘No’ to cancel, then press ENTER.

**Tip**
You can erase a title quickly by pressing CLEAR when the title is highlighted. Confirm the edit by pressing ENTER.

Title Name
Use this command to name or rename titles in the Copy List (the names of the original titles remain unchanged). When copying to a Video mode disc, the name length is limited to 40 characters; for a VR mode disc, the limit is 64 characters.
1. Highlight the title you want to name (or rename).
2. Select ‘Title Name’ from the command menu panel.
3. Input a name for the selected title.
   - Use the ↑/↓/←/→ and ENTER to select characters.
   - A name generated automatically by the recorder will already be in the name input section of the screen. Use the ←/→/↑/↓ buttons to change the cursor position.
Copyng and back-up

• Select CAPS or small to change to upper or lower-case, or use the CASE SELECTION buttons (mouseup/mousedown).
• You can also use the CLEAR button to delete characters directly (press and hold for two seconds to delete the whole name). For other remote control key shortcuts, see Using the remote key shortcuts to input a name on page 79.
• For discs formatted on a different DVD recorder, you will see only a limited character set.

4 Highlight ‘OK’ then press ENTER to enter the name and return to the Copy List.
• To return to the main Copy List screen without saving changes to the title name, press RETURN.

Erase Section
Using this command you can delete a part of a Copy List title, ideal for cutting out the commercial breaks in a recording made from the TV.

1 Highlight the title containing the section you want to erase.

2 Select ‘Erase Section’ from the command menu panel.
The Erase Section screen appears from which you can mark the start and end points of the section to erase.

3 Select the type of edit.

• Video Mode Compatible Editing – Edit points cannot be set with absolute precision, but high-speed copying to Video mode DVD will be possible.
• Frame Accurate Editing – Exact edit points are preserved, but high-speed copying to Video mode DVD will not be possible.
• For more information about these options, see Editing accuracy on page 77.

4 Highlight ‘From’ then use the playback controls (mouseup/mousedown, fastrev, fastfwd, etc.) to find the start of the section to erase, then press ENTER.
The bar at the bottom of the screen indicates the current play position in the title. After pressing ENTER, a marker shows the start of the section.

5 Highlight ‘To’ then, in the same way, find the end of the section to erase, then press ENTER.
After pressing ENTER, another marker indicates the end of the section, with the section itself marked in red.

6 Select ‘Yes’ to confirm, or ‘No’ to cancel, then press ENTER.

In the thumbnail viewer you can see a few seconds of video either side of the marked section to see how the edit will look.

Move
Use this command to change the order of titles in the Copy List.

1 Highlight the title you want to move and press ENTER.

2 Select ‘Move’ from the command menu panel.

3 Move the insert bar to the new position for the title and press ENTER.
Copying and back-up

Preview
Use this command to check what’s in a title.
1 Highlight the title you want to preview.
2 Select ‘Preview’ from the command menu panel. The selected title starts to play. Use any of the usual playback controls to scan, skip, play in slow-motion, etc.
3 To get back to the Copy List, press RETURN.

Divide
Use this command to make two titles from a title already in the Copy List.
1 Highlight the title you want to divide.
2 Select ‘Divide’ from the command menu panel.
3 Select the type of edit.
- Video Mode Compatible Editing – Edit points cannot be set with absolute precision, but high-speed copying to Video mode DVD will be possible.
- Frame Accurate Editing – Exact edit points are preserved, but high-speed copying to Video mode DVD will not be possible.
- For more information about these options, see Editing accuracy on page 77.
4 Use the playback controls (↑, ↓, →, ←, etc.) to find the place you want to divide the title.
5 Press ENTER to divide the title at the current playback position.

Combine
Use this command to make a single title from two titles in the Copy List. The second title selected will be appended to the first.
1 Highlight the title you want to combine with another, then press ENTER. This title will not move. The next title you select will be appended to this one.
2 Select ‘Combine’ from the command menu panel.
3 Select the title you want to append to the first, then press ENTER. This title will effectively move to be added to the end of the first title. In the example below, title 3 will be appended to title 1.
4 Select ‘Yes’ to confirm or ‘No’ to cancel, then press ENTER.

Chapter Edit
The Chapter Edit option gives you access to several commands that you can use to edit chapters within a Copy List title.
1 Highlight the title that contains the chapters you want to edit.
2 Select ‘Chapter Edit’ from the command menu panel.
3 Select the type of editing.

Copyng and back-up

- Video Mode Compatible Editing – Edit points cannot be set with absolute precision, but high-speed copying to Video mode DVD will be possible.
- Frame Accurate Editing – Exact edit points are preserved, but high-speed copying to Video mode DVD will not be possible.
- For more information about these options, see Editing accuracy on page 77

4 Select the command you want:
- Divide – Divide a chapter into two or more parts: Use the playback controls (→, II, ◀, ▶, etc.) to find the point at which you want to divide the chapter, then press ENTER.

You can keep dividing the chapter as many times as you wish (up to 99 per title).
- Erase/Move – Erase or move chapters: Select the chapter you want to erase/move and press ENTER. Select whether you want to erase or move the chapter.
- Move command only: Select the destination for the chapter, and press ENTER.

- Combine – Combine two adjacent chapters into one: Highlight the bar divider between two adjacent chapters and press ENTER.

5 Select ‘Exit’ to get back to the main Copy List screen.

Set Thumbnail
You can change the thumbnail picture that appears in the four-title display of the Disc Navigator for a title to any frame that appears in that title.

1 Highlight the title you want to change the thumbnail picture for.
2 Select ‘Set Thumbnail’ from the command menu panel.
3 The thumbnail setting screen appears from which you can find the frame you want.
4 Use the playback controls (→, II, ◀, ▶, etc.) to find a suitable frame, then press ENTER to set.
You can also use the chapter and time search features (press PLAY MODE), and the CM SKIP buttons.

4 Select ‘Exit’ to return to the Copy List screen.

Recording Mode

1 Select ‘Recording Mode’ from the command menu panel.
2 Use the ▲/▼ buttons to select a recording mode for the copy.
- High-Speed Copy1 – The Copy List is copied at the same recording quality as the original.
- XP, SP, LP, EP, SLP, SEP, MN2 – The Copy List is copied at the specified recording quality in real-time. (Note that if you copy at a higher quality setting than the original, the copy will not be better quality than the original.)

If you select MN above, you can also change the level setting (MN1–MN32, LPCM or XP+) from the Recording Quality box that appears.
- Optimized3,4 – The recording quality is automatically adjusted so that the Copy List fits on to the space available on the disc. Copying is carried out in real-time.

Note
1When copying to a Video mode DVD, the chapter markers in the copy may not be in exactly the same position as the original.
2When the copy mode is set to something other than High-Speed Copy for copying to a Video mode DVD, the chapter markers of the original are not copied. Chapter markers are put into the copy at regular intervals, according to the Auto Chapter setting (see also Auto Chapter (Video) on page 95).
3XP+ mode available only when copying to HDD.
4Optimized mode only available when copying to DVD.
When you change the recording mode setting, you can see how much disc space it will require. If this is more than is available, it shows up in red and you won’t be able to start copying. In this case, either change the recording quality, or press RETURN to go back to the Copy List screen and erase one or more titles from the Copy List.

3 Press ENTER.

Dual Mono Audio

1 Select the title containing the audio you want to change.
2 Select ‘Dual Mono Audio’ from the command menu panel.
3 Use the ↑/↓ buttons to select a dual mono audio option.
4 Press ENTER.

Using disc back-up

* See also Copyright on page 66.
This feature offers a simple way to make a back-up copy of a finalized Video mode disc. The data is copied first to the hard disk drive\(^1\), then on to another recordable DVD disc.

1 Press HOME MENU, select ‘Copy’, then ‘Disc Back-up’.
2 Select a back-up option.

There are three back-up options:

- **Start new disc back-up** – Start making a back-up of a disc.
- **Resume writing data** – Record the back-up data already on the HDD to a recordable DVD.
- **Erase back-up data** – Erase the back-up data on the HDD.

3 Press ▲ OPEN/CLOSE to open the disc tray and load the disc you want to make a back-up of, then close the disc tray.
You can only make back-up copies of finalized Video mode discs.

4 Select ‘Start’.

- To see the progress of the back-up, press DISPLAY.
- You can cancel the back-up process by pressing ONE TOUCH COPY for more than one second.

5 When the data has been copied, press ▲ OPEN/CLOSE to open the disc tray. Take out the disc and load a blank* recordable DVD.
* If you’re using a DVD-RW, the disc doesn’t have to be blank, although the previous contents of the disc will be erased in the back-up process.

You can use a DVD-R Ver. 2.0 disc, or DVD-RW Ver. 1.1 or Ver. 1.2 for the back-up.

- If you back-up a DVD-R disc to DVD-RW, you cannot undo the finalization later.
- Actual recordable capacity of discs vary so there may be cases where the contents of the disc you’re backing-up will not fit on to a particular blank disc. If this happens, please try another brand of disc.

**Note**

\(^1\) It is not possible to play this material directly from the HDD.
6 Select ‘Start’ to start writing the backed-up data to the blank disc.

To see the progress of the back-up, press DISPLAY.

You can cancel the back-up process by pressing ONE TOUCH COPY for more than one second. However, this will make the disc unusable (although if you are using a DVD-RW disc you can re-initialize it in order to make it usable again—see Initializing a recordable DVD disc on page 56.)

7 After the recorder has finished recording the back-up disc, you can select whether to make another back-up of the same data or exit.

Select Start to make another back-up copy or Cancel to finish. If you want to make another back-up copy, return to step 6 above.

8 If you don’t need to keep the back-up data on the HDD, you can delete it now.

Select Yes to delete the data from the HDD; select No to keep it (you can delete it later if you want to).

If you decide to leave the back-up data on the HDD, you can make back-up copies to recordable DVD discs anytime from the Disc Back-up menu.
Chapter 9  
Editing

The Disc Navigator screen
The Disc Navigator screen is where you can edit video content on unfinalized Video mode and VR mode DVD discs, as well as video content on the internal hard disk drive.

1 Press HDD or DVD to select the hard disk drive or the DVD.
2 Press DISC NAVIGATOR to display the Disc Navigator screen.
   Playback will automatically stop when you do this.

   • You can also access the Disc Navigator from the Home Menu (press HOME MENU, select Disc Navigator then press ENTER).
   • From the title list, press → to display the command menu panel. Use the ↑/↓ and ENTER buttons to navigate the menus.
   • When in the title list, use the PREV (←) and NEXT (→) buttons to display the previous/next page if there are more titles than can be displayed.
   • Press DISPLAY to change the title information displayed in the title list.
   • If you are editing a VR mode disc you can display the Play List by selecting Play List from the view options panel (press ←, then select Play List from the view options, then Play List).

   • You can switch between the HDD and the DVD Disc Navigator screens using the HDD and DVD buttons (front panel or remote).

   Titles on the HDD marked with a icon are recently recorded titles that haven’t yet been played.

3 To exit the Disc Navigator, press HOME MENU.

Note
1. It isn’t possible to edit video on DVD-RAM discs using this recorder.
Editing menu panel options

The table below shows which commands you can use with which video type.

<table>
<thead>
<tr>
<th>Command</th>
<th>HDD</th>
<th>Video mode</th>
<th>VR mode (Original)</th>
<th>VR mode (Play List)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Play</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Erase</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Edit &gt; Title Name</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Edit &gt; Set Thumbnail</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Edit &gt; Erase Section</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Edit &gt; Divide</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Edit &gt; Chapter Edit</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Edit &gt; Set Genre</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Edit &gt; Lock</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Edit &gt; Combine</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Genre Name</td>
<td>●</td>
<td>●</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Multi-Mode</td>
<td>●</td>
<td>●</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Undo</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
</tbody>
</table>

Editing accuracy

Some editing (and Copy List) commands ask you whether you want to keep Video mode compatibility or frame accuracy (Video mode compatible editing, or Frame accurate editing).

Frame accurate editing is very precise. The edit point is accurate to the exact frame you choose. However, this accuracy is not preserved in any copy you make if you use the high-speed copy function to make a Video mode DVD.

Video mode compatible editing is less precise. The edit point you choose will only be accurate to within 0.5–1 second. On the other hand, these edit points will be preserved if you use high-speed copy to make a Video mode DVD.

HDD genres

The large capacity of the HDD means that there may be many hours of video in the recorder. To help you organize your HDD video content you can assign different genres to titles. There are five genres (set initially to FREE1–5) that can be named and renamed as you like.
Create

Use this function to create a Play List and add titles to it. Before you can use this command, make sure that the Play List is switched on in the view options panel on the left.

1. Select ‘Create’ from the command menu panel.

2. Select a title to add to the Play List. Use the ↑/↓ buttons to highlight an Original title then press ENTER to add it and display the Play List.

3. Repeat steps 1 and 2 to add as many titles as necessary to the Play List.

Erase

Use this function to erase unwanted titles. When you erase titles from the HDD or Original titles from a VR mode DVD-RW, the available recording space increases accordingly. Erasing a title from a Video mode DVD-RW disc increases the available recording time only if it is the last title on the disc.

1. Highlight the title you want to erase.

2. Select ‘Erase’ from the command menu panel.

3. Select ‘Yes’ to confirm or ‘No’ to cancel, then press ENTER.

Tip

You can erase a title quickly by pressing CLEAR when the title is highlighted. Confirm the edit by pressing ENTER.

Title Name

You can give titles new names of up to 64 characters long for VR mode and HDD recordings, and up to 40 characters for Video mode recordings.

1. Highlight the title you want to name (or rename).

2. Select ‘Edit’ > ‘Title Name’ from the command menu panel.
3 Input a name for the selected title.

- Use the ↑/↓/←/→ and ENTER to select characters.
- A name generated automatically by the recorder will already be in the name input section of the screen. Use the ←/→ buttons to change the cursor position.
- Select CAPS or small to change to upper or lower-case, or use the CASE SELECTION buttons (↑/↓/→). You can also use the CLEAR button to delete characters directly (press and hold for two seconds to delete the whole name). For other remote control key shortcuts, see Using the remote key shortcuts to input a name below.
- For discs formatted on a different DVD recorder, you will see only a limited character set.

4 Highlight 'OK' then press ENTER to enter the name and return to the main Disc Navigator screen.
- To return to the main Disc Navigator screen without saving changes to the title name, press RETURN.

Using the remote key shortcuts to input a name

The table below shows the remote control key shortcuts that you can use to input characters in the name input screen. Pressing a button repeatedly cycles through the characters shown.

If you want to enter two characters in succession that are both on the same button (for example a P and an R), press ↑/↓/→ to advance the cursor one space manually between inputting the two characters.

<table>
<thead>
<tr>
<th>Key</th>
<th>Characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>1↑</td>
<td>. ‘ ’ ! &amp; 1</td>
</tr>
<tr>
<td>2↑</td>
<td>a b c å á ã Æ ç</td>
</tr>
<tr>
<td>3↑</td>
<td>d e f ì í î Î ï ¡</td>
</tr>
<tr>
<td>4↑</td>
<td>g h i ë ê Ù Ú Û Ú Ú</td>
</tr>
<tr>
<td>5↑</td>
<td>j k l £</td>
</tr>
<tr>
<td>6↑</td>
<td>m n o ö ô ò ó ø ñ</td>
</tr>
<tr>
<td>7↑</td>
<td>p q r s $ ý/ß</td>
</tr>
<tr>
<td>8↑</td>
<td>t u v ü ù û ú</td>
</tr>
<tr>
<td>9↑</td>
<td>w x y z</td>
</tr>
<tr>
<td>0↑</td>
<td>0</td>
</tr>
<tr>
<td>[cursor back]</td>
<td>[cursor forward]</td>
</tr>
<tr>
<td>[change case]</td>
<td>CLEAR [clear character]</td>
</tr>
<tr>
<td>&lt;space&gt;</td>
<td>[finish name input]</td>
</tr>
<tr>
<td>+</td>
<td>( ) _ / : ; &quot; ` ^ @ # ¥</td>
</tr>
</tbody>
</table>

*1 lower-case: ÿ; upper-case: ß

Set Thumbnail

You can change the thumbnail picture that appears in the Disc Navigator for a title to any frame that appears in that title.

1 Highlight the title you want to change the thumbnail picture for.

2 Select 'Edit' > 'Set Thumbnail' from the command menu panel.

The thumbnail setting screen appears from which you can find the frame you want.
3 Use the playback controls (►, ▼, ◀, ▶, etc.) to find a suitable frame, then press ENTER to set.

You can also use the chapter and time search features (press PLAY MODE), and the CM SKIP buttons.

4 Select ‘Exit’ to return to the Edit screen.

Erase Section

Using this command you can delete a part of a title, ideal for cutting out the commercial breaks in a recording made from the TV.

1 Highlight the title containing the section you want to erase.

2 Select ‘Edit’ > ‘Erase Section’ from the command menu panel.

3 HDD only: Select the type of edit.

- Video Mode Compatible Editing – Edit points cannot be set with absolute precision, but high-speed copying to Video mode DVD will be possible.
- Frame Accurate Editing – Exact edit points are preserved, but high-speed copying to Video mode DVD will not be possible.
- For more information about these options, see Editing accuracy on page 77.

4 Highlight ‘From’ then use the playback controls (►, ▼, ◀, ▶, etc.) to find the start of the section to erase, then press ENTER.

The bar at the bottom of the screen indicates the current play position in the title. After pressing ENTER, a marker shows the start of the section.

5 Highlight ‘To’ then, in the same way, find the end of the section to erase, then press ENTER.

After pressing ENTER, another marker indicates the end of the section, with the section itself marked in red.

6 Select ‘Yes’ to confirm, or ‘No’ to cancel, then press ENTER.

In the thumbnail viewer you can see a few seconds of video either side of the marked section to see how the edit will look.

- When editing VR mode Original content, you may not be able to erase very short sections (less than five seconds).

Divide

Use this command to divide a title into two. Note that once divided, the two new HDD titles cannot be recombined into one again.

1 Highlight the title you want to divide.

2 Select ‘Edit’ > ‘Divide’ from the command menu panel.

3 HDD only: Select the type of edit.

- Video Mode Compatible Editing – Edit points cannot be set with absolute precision, but high-speed copying to Video mode DVD will be possible.
Editing

- **Frame Accurate Editing** – Exact edit points are preserved, but high-speed copying to Video mode DVD will not be possible.
- For more information about these options, see Editing accuracy on page 77

4 Use the playback controls (►, ▼, ◀, ►, etc.) to find the place you want to divide the title.

5 Press ENTER to divide the title at the current playback position.

6 Select ‘Yes’ to confirm you want to divide the title, or ‘No’ to cancel.

**Chapter Edit**

When editing a VR mode DVD or video on the HDD you can edit individual chapters within a title, with commands for erasing, combining and dividing.

1 Highlight the title that contains the chapters you want to edit.

2 Select ‘Edit’ > ‘Chapter Edit’ from the command menu panel.

3 **HDD only:** Select the type of edit.

   ![Select the type of edit](image)
   - **Video Mode Compatible Editing** – Edit points cannot be set with absolute precision, but high-speed copying to Video mode DVD will be possible.
   - **Frame Accurate Editing** – Exact edit points are preserved, but high-speed copying to Video mode DVD will not be possible.
   - For more information about these options, see Editing accuracy on page 77

4 Select the command you want:
   - **Divide** – Divide a chapter into two or more parts: Use the playback controls (►, ▼, ◀, ►, etc.) to find the point at which you want to divide the chapter, then press ENTER.

   You can keep dividing the chapter as many times as you wish (up to 999 chapters per DVD disc or 99 chapters per HDD title).
   - **Erase /Move** – Erase or move chapters: Select the chapter you want to erase/move and press ENTER. Select whether you want to erase or move the chapter.

   ![Move command only](image)
   - **Combine** – Combine two adjacent chapters into one: Highlight the bar divider between two adjacent chapters and press ENTER.

5 Select ‘Exit’ to get back to the main Disc Navigator screen.

**Note**

1. When editing VR mode Original content, it may not be possible to erase chapters less than five seconds long.
2. VR mode Play List only.
3. It may not always be possible to combine two chapters, even though they are adjacent. If a chapter has been divided into three, then the middle chapter erased, it is not possible to combine the two remaining chapters into one.
### Editing

#### Set Genre

Use this command to assign a genre to a title.

1. Highlight the title you want to assign a genre to.
2. Select ‘Edit’ > ‘Set Genre’ from the command menu panel.

3. Use the ↑/↓ buttons to select a genre for the title, then press ENTER.

#### Lock

Original only

You can lock a title so that it can’t be edited or erased accidentally. If you do need to edit it, you can always unlock it later.

**Important**

- You can’t undo any edits made before changing the lock status. You also can’t undo a lock/unlock command using the Undop option from the Disc Navigator menu.

1. Highlight the title you want to lock (or unlock).

2. Select ‘Edit’ > ‘Lock’ from the command menu panel.

An unlocked title will become locked; a locked title will be unlocked. Locked titles are shown in the Disc Navigator with a padlock icon.

#### Move

VR mode: Play List only

Use this function to re-arrange the playing order of Play List titles.

1. Highlight the title you want to move.

2. Select ‘Edit’ > ‘Move’ from the command menu panel.

3. Select a new position in the Play List for the title, then press ENTER.

After pressing ENTER, the new, updated Play List is displayed.
Editing

Combine

VR mode Play List only

Use this function to combine two Play List titles into one.

1 Highlight the title you want to combine.

This title will remain in the same place after combining with another title.

2 Select 'Edit' > 'Combine' from the command menu panel.

3 Select another title to combine with the first.

This title will be appended to the first title selected.

After pressing ENTER, the new, updated Play List is displayed.

Genre Name

HDD

Use this command to rename one of the five user-definable genres (Free 1-5).

1 Select 'Genre Name' from the command menu panel.

2 Use the ↑/↓ buttons to select one of the user-definable genre names, then press ENTER.

3 Input a name for the genre.

The name can be up to 12 characters long.

4 To finish entering the name, highlight 'OK' and press ENTER.

Multi-Mode

HDD

Multi-Mode allows you to select several titles, then select a command that will be applied to all of them. In this way you can select multiple titles and then erase them all at once, for example.

1 Select 'Multi-Mode' from the command menu panel.

2 Select titles from the title list.

Use the ↑/↓ and ENTER buttons to select. Selected titles are marked with a ✖.
3 Select ‘Next’ from the command menu panel.

4 Select the command that you want applied to all the marked titles.
   For example, select Erase to erase all the marked titles.

Once the command is completed, Multi-Mode is automatically exited.

**Undo**

If you make a mistake while editing, you can generally undo it. There are three levels of undo (in other words, you can undo the last three edits you made).

1 Select ‘Undo’ from the command menu panel.
   - You can’t undo anything after exiting the Disc Navigator screen.

**Frequently asked questions**

- **Why doesn’t the available recording time increase when I erase titles from a VR mode DVD-R?**
  When you erase titles from a DVD-R, the titles are no longer displayed, but the content remains on the disc. DVD-R is a write-once medium; it can’t be erased or rewritten.

- **I can’t edit my disc!**
  You may find that as the available recording time is reduced on a VR mode DVD-R disc, editing is no longer possible. This is because information about your edits requires a certain amount of disc space. As you edit, this information builds up, eventually preventing you from editing further.
Chapter 10
The PhotoViewer

From the PhotoViewer you can view JPEG photos and picture files stored on a CD-ROM/R/RW\(^1\) on your TV.

### Playing a slideshow

1. Press HOME MENU and select ‘PhotoViewer’ to display the PhotoViewer screen.
   - The PhotoViewer is only accessible when a disc containing JPEG files is loaded.
   - If you encounter a disc that will not play, check that the disc and file formats are compatible with this recorder (see JPEG file compatibility and PC-created disc compatibility on page 12).

2. Use the \(\uparrow/\downarrow\) buttons to select a folder from the folder list.
   - The first five images from the selected folder are displayed as thumbnails in the main part of the screen.
   - The larger the file size, the longer it takes the recorder to load the file.

3. Press ENTER or \(\rightarrow\) to move to the thumbnail view area.
   - The first thumbnail image is highlighted.

4. Use the \(\uparrow/\downarrow/\leftarrow/\rightarrow\) to select a thumbnail.
   - Use the \(\ll/\gg\) buttons to display the previous/next page of thumbnails.

5. Press ENTER or \(\gg\) to start playing a slideshow from the selected thumbnail.
   - Use the \(\ll/\gg/\gg\gg\) buttons to display the previous/next picture, or the \(\mathbf{II}\) PAUSE button to pause the slideshow.
   - Depending on the aspect ratio, some pictures may be displayed with black bars top and bottom, or left and right.
   - Large picture files may take a few seconds to display. This is normal.

6. Press \(\mathbf{STOP}\) or RETURN to return to the thumbnail view area.

7. To return to the folder view area, press RETURN (or \(\ll\) when the leftmost thumbnail is highlighted).
   - To exit the PhotoViewer, press HOME MENU.

---

**Note**

1. Up to 999 files or 99 folders are viewable, but if there are more files/folders than this on the disc it is still possible to view them all using the Reload function (see the following page).
Reloading files from a disc
If you have a disc with a large number of files and/or folders, you can still view all the images using the reload function.

1. Use the $ button to navigate to the last entry in the folder list (‘Read next: ...’).
2. Press ENTER to load the next batch of up to 999 files/99 folders from the disc.
   It will take a moment (at most a minute) to load in the images.\(^1\)

Zooming the image
During a slideshow you can zoom in to enlarge a portion of the picture by a factor of two or four. You can also move the area of the picture displayed.

1. During a slideshow, use the CHANNEL + button to zoom the picture.

2. Use the ↑/↓/←/→ to move the zoomed area within the picture.

Rotating an image
You can rotate the displayed picture during a slideshow so you can always view pictures the right way up, whichever way they were taken.

• During a slideshow, press ANGLE to rotate the displayed picture clockwise by 90º.
  Press ANGLE repeatedly to continue rotating the picture in increments of 90º.

\(^1\) You can press HOME MENU to exit the PhotoViewer screen while the recorder is reloading images. (If you enter the PhotoViewer again, it will resume reloading.)
Chapter 11
The Disc Setup menu

Introduction
From the Disc Setup menu you can name discs, lock the contents to prevent accidental recording and erasure, initialize and finalize discs. The Disc Setup menu is accessed from the Home menu:

• Press HOME MENU and select 'Disc Setup'.

Basic settings

Input Disc Name
When you initialize a disc for recording, the recorder automatically assigns a name for the disc ranging from DISC 1 to DISC 99. You can use the Input Disc Name function to change the default disc name to something more descriptive. This name appears when you load the disc and when you display disc information on-screen.

1 Select 'Input Disc Name' from the Basic options, then 'Next Screen'.

2 Input a name for the disc up to 64 characters long for a VR mode disc, or 40 for a Video mode disc.

• Select CAPS or small to change to upper or lower-case, or use the CASE SELECTION buttons (↑/↓). You can also use the CLEAR button to delete characters directly (press and hold for two seconds to delete the whole name). For other remote control key shortcuts, see Using the remote key shortcuts to input a name on page 79.

• You will see only a limited character set for discs formatted on a different DVD recorder.

Lock Disc
Default setting: Off

Set to On to prevent accidental recording, editing or erasing of the disc loaded. If you need to unlock the disc to make edits, select Off.

Important
• A locked disc can still be initialized (which will completely erase the disc).
The Disc Setup menu

Initialize settings

**DVD-R**  **DVD-RW**

You can initialize a recordable DVD disc for either VR mode or Video mode recording.

The first time you load a new DVD-RW disc, it will be automatically initialized for recording according to the DVD-RW Auto Init. setting in the Initial Setup menu (see page 95).

New DVD-R discs are ready for Video mode recording when you load them, but it is also possible to initialize them for VR mode recording.

The initialize menu here lets you reinitialize a disc, for example if you want to change the recording format of the disc. See Initializing a recordable DVD disc on page 56 for detailed instructions.

Finalize settings

**Finalize**

**DVD-R**  **DVD-RW**

Finalizing 'fixes' the recordings in place so that the disc can be played on a regular DVD player or computer equipped with a suitable DVD-ROM drive.

See Playing your recordings on other DVD players on page 55 for detailed instructions.

**Undo Finalize**

**DVD-RW**

You can undo the finalization on DVD-RW discs recorded on this recorder in Video mode. You need to do this if you want to record more material or edit material already on the disc.

You can also undo the finalization of VR mode discs which have been finalized on other DVD recorders. If when you load a disc the message This disc cannot be recorded. Undo the finalization is displayed, use this command to be able to record on the disc using this recorder.

1. From the Disc setup menu, select ‘Finalize’, then ‘Undo Finalize’ from the finalize options.
2. Select ‘Start’.

Optimize HDD

**HDD**

You’ll see a message appear on-screen recommending you optimize the HDD.

As you record, erase and edit recordings, the HDD file system gradually becomes fragmented. Periodically, the HDD will need optimizing to ‘clean up’ all the fragmented files.

**Important**

- Optimizing the HDD can take as long as eight hours. During optimization, playback and recording are not possible.
- Canceling optimization mid-way does not undo the optimization already done, so the HDD will be partly optimized.

- Select ‘Optimize HDD’ from the disc Setup menu.

- Select ‘Start’ to optimize.

A progress bar indicates how long there is left to go.

Initialize HDD

**HDD**

When your DVD recorder is working without a problem this option is not visible in the Disc Setup menu. However, if the HDD file system becomes corrupted for some reason, you initialize the HDD to fix the problem. Note that initializing the HDD will erase all the data on it.

- Select ‘Initialize HDD’ from the disc Setup menu.

- Select ‘Start’ to initialize.
Chapter 12
The Video/Audio Adjust menu

Using the Video/Audio Adjust menu you can set up the picture quality for the built-in tuner and external inputs, for disc playback, and for recording.

Setting the picture quality for TV and external inputs
Picture Creation lets you choose a set of picture quality settings for the built-in TV tuner and for each external input. There are several preset settings that suit various sources, or you can create up to three of your own sets.

Choosing a preset
1 With the recorder stopped, press HOME MENU and select ‘Video/Audio Adjust’.
2 Select ‘Video Adjust’.
3 Use the / buttons to change the preset.

• Use the INPUT SELECT button to switch between the built-in TV tuner and the external inputs.
• Use the CH +/– buttons to change the channel of the built-in TV tuner.

There are six presets available:
• Tuner – suitable for general TV broadcasts
• VCR – suitable for video cassettes
• LDP – suitable for Laserdiscs
• Memory1 – user preset 1
• Memory2 – user preset 2
• Memory3 – user preset 3

You can press DISPLAY to see the individual settings for the current preset (Tuner, VCR or LDP).

4 Press ENTER to select the preset.

Creating your own set
There are three user presets in which you can save your own set of picture quality settings.

1 Follow Choosing a preset above and select one of the user presets (Memory 1, 2 or 3).
2 Select ‘Detailed Settings’.
3 Use the / buttons to select the picture quality setting you want to adjust.

You can adjust the following settings:¹
• Prog. Motion – Adjusts the motion and still picture quality when video output is set to progressive.
• PureCinema – This setting optimizes the picture for film material when the video output is set to progressive. Usually this is best left set to Auto; try switching to Off if the picture appears unnatural.
• 3-D Y/C – Adjusts the brightness/color separation.
• YNR – Adjusts the amount of noise reduction (NR) applied to the Y (brightness) component.
• CNR – Adjusts the amount of noise reduction (NR) applied to the C (color) component.
• Detail – Adjusts how sharp edges appear.

⁻Note⁻
¹ When the DV input is selected, only Prog. Motion and PureCinema settings can be adjusted.
The Video/Audio Adjust menu

- White AGC – Turn on for automatic white level adjustment. ¹
- White Level – Adjusts the intensity of white.
- Black Level – Adjusts the intensity of black.
- Black Setup – Corrects the standard reference black level.
- Gamma Correction – Adjusts the brightness of darker images.
- Hue – Adjusts overall balance between red and green.
- Chroma Level – Adjusts how rich the colors appear.

¹ Use the ↔ button to adjust the currently selected picture quality setting.

5 When you have all the settings as you want them, press HOME MENU to exit.
You can now use the preset for any other input or the built-in TV tuner.

Tip
- To see more of the picture as you adjust different settings, press ENTER after selecting the setting you want to adjust.

Setting the picture quality for disc playback
This setting determines how the picture will look when playing discs.

Choosing a preset
1 With a disc playing (or paused), press HOME MENU and select ‘Video/Audio Adjust’.
2 Select ‘Video Adjust’
3 Use the ↓↑ buttons to change the setting.

There are six presets available:
- TV(CRT) – suitable for standard cathode-ray tube TVs
- PDP – suitable for plasma display screens
- Professional – suitable for professional monitors

Creating your own set
There are three user presets in which you can save your own set of picture quality settings for disc playback.

1 Follow Choosing a preset above and select one of the user presets (Memory 1, 2 or 3).
2 Move the cursor down and select ‘Detailed Settings’.

3 Select the picture quality setting you want to adjust.

You can adjust the following settings:
- Prog. Motion – Adjusts the motion and still picture quality when video output is set to progressive.
- PureCinema – This setting optimizes the picture for film material when the video output is set to progressive. Usually this is best left set to Auto 1; try switching to Auto 2, On or Off if the picture appears unnatural.
- YNR – Adjusts the amount of noise reduction (NR) applied to the Y (brightness) component.
- BNR – Adjusts the amount of noise reduction (NR) applied to the block noise (artefacts visible in areas of flat color, caused by MPEG compression).
- Detail – Adjusts how sharp edges appear.
- White Level – Adjusts the intensity of white.

Note
1. When White AGC is On, the White Level setting can’t be adjusted.
The Video/Audio Adjust menu

- **Black Level** – Adjusts the intensity of black.
- **Black Setup** – Corrects the standard reference black level.
- **Gamma Correction** – Adjusts the brightness of darker images.
- **Hue** – Adjusts overall balance between red and green.
- **Chroma Level** – Adjusts how rich the colors appear.

4 Use the ←/→ buttons to adjust the currently selected picture quality setting.
5 When you have all the settings as you want them, press HOME MENU to exit.

**Tip**
- To see more of the picture as you adjust different settings, press ENTER after selecting the setting you want to adjust.

**Audio DRC**

- Default setting: Off
When watching Dolby Digital material at low volume, it’s easy to lose low level sounds completely—including some of the dialog. Switching on Audio DRC (Dynamic Range Control) can help by bringing up the low level sounds, while controlling high level peaks.

1 During playback or when paused, press HOME MENU and select ‘Video/Audio Adjust’.
2 Select ‘Audio Adjust’.
3 Use the ←/→ buttons to adjust DRC from ‘Off’ to ‘Max’.

Exactly how much difference you can hear between the settings will depend on the material.

**Tip**
- Audio DRC is not effective when listening to a disc via the digital output when Dolby Digital Out is set to Dolby Digital. In this case adjust the dynamic range from your AV amplifier/receiver.
Chapter 13
The Initial Setup menu

Using the Initial Setup menu
The Initial Setup menu is where you can set various recorder options for sound, picture, language and so on. Some settings can only be changed when the recorder is stopped. During playback or recording these settings are grayed out in the Initial Setup menu.

Except for the Setup Navigator, menu screens are exited automatically after 20 minutes of inactivity.

• Press HOME MENU and select 'Initial Setup'.

In the table below, the default option is marked with a •.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Basic Settings</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Clock Setting</td>
<td>Auto</td>
<td>Set the channel that broadcasts a clock signal and the clock will be set automatically.</td>
</tr>
<tr>
<td></td>
<td>Manual •</td>
<td>If there is no channel that broadcasts a clock signal in your area, you can set the time and date manually.</td>
</tr>
<tr>
<td>Help Setting</td>
<td>On •</td>
<td>Switches on the automatic Help screens for GUI displays.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>Switches off the automatic Help screens for GUI displays. (Press HELP on the remote to manually display the Help screen.)</td>
</tr>
<tr>
<td>Setup Navigator</td>
<td>Start</td>
<td>Select to start the Setup Navigator. See also Switching on and setting up on page 25.</td>
</tr>
<tr>
<td><strong>Tuner Settings</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Auto Channel Setting</td>
<td>Antenna •</td>
<td>Select if you receive channels from an antenna. It takes a few moments for the auto tuning to complete.</td>
</tr>
<tr>
<td></td>
<td>Cable</td>
<td>Select if you receive channels via cable. It takes a few moments for the auto tuning to complete.</td>
</tr>
<tr>
<td>Manual CH Setting</td>
<td>Next Screen</td>
<td>Proceed to the next screen if you need to adjust any of the settings made by auto tuning.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Change channels using the CH +/- buttons.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• To skip the displayed channel (because there is no station assigned to that channel), change the Skip setting to On.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• To manually fine tune the channel, change the AFT setting to Off then adjust the Level setting.</td>
</tr>
</tbody>
</table>

• Note that you can’t use the Auto Channel Setting or the skip feature (in the Manual Channel Setting) after completing the TV Guide setting.

**Video Out Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Component Video Out</td>
<td>Interface •</td>
<td>Select if your monitor/TV is not compatible with progressive-scan video.</td>
</tr>
<tr>
<td></td>
<td>Progressive</td>
<td>Select if your monitor/TV is progressive-scan compatible. Check the operating instructions that came with your monitor/TV if you’re not sure.</td>
</tr>
</tbody>
</table>
## The Initial Setup menu

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Audio In Settings</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>External Audio</strong></td>
<td><strong>Stereo •</strong></td>
<td>Select if the audio from the currently selected external input is standard stereo.</td>
</tr>
<tr>
<td><strong>Dual Mono</strong></td>
<td></td>
<td>Select if each channel carries a separate soundtrack.</td>
</tr>
<tr>
<td></td>
<td><strong>L •</strong></td>
<td>Select to record the left channel of an external dual mono source when recording to DVD in Video mode, to HDD with HDD Recording Format set to Video Mode On, or in LPCM mode.</td>
</tr>
<tr>
<td></td>
<td><strong>R</strong></td>
<td>As above, but for right channel recording.</td>
</tr>
<tr>
<td></td>
<td><strong>Dual Mono Recording L •</strong></td>
<td>Select to record the left channel of an external dual mono source when recording to DVD in Video mode, to HDD with HDD Recording Format set to Video Mode On, or in LPCM mode.</td>
</tr>
<tr>
<td></td>
<td><strong>R</strong></td>
<td>As above, but for right channel recording.</td>
</tr>
<tr>
<td></td>
<td><strong>DV Input</strong></td>
<td>Select one of the three settings to use a mix of the two stereo audio tracks.</td>
</tr>
<tr>
<td><strong>Input Level (L1–L3)</strong></td>
<td><strong>-6dB – +6dB</strong> (default: 0 dB)</td>
<td>Adjust the input level separately for each of the external inputs from -6dB to +6dB in steps of 3dB.</td>
</tr>
<tr>
<td><strong>Audio Out Settings</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Digital Out</strong></td>
<td><strong>On •</strong></td>
<td>Activates the digital audio output.</td>
</tr>
<tr>
<td></td>
<td><strong>Off</strong></td>
<td>Deactivates the digital audio output.</td>
</tr>
<tr>
<td></td>
<td><strong>Dolby Digital Out</strong></td>
<td>Output a Dolby Digital signal when a Dolby Digital source is being played.</td>
</tr>
<tr>
<td></td>
<td><strong>Dolby Digital → PCM</strong></td>
<td>Convert Dolby Digital sources to Linear PCM output. If your connected equipment doesn’t have a Dolby Digital decoder.</td>
</tr>
<tr>
<td></td>
<td><strong>DTS Out</strong></td>
<td>Output a DTS signal when a DTS source is being played.</td>
</tr>
<tr>
<td></td>
<td><strong>Off</strong></td>
<td>Switch off the digital output when a DTS source is being played. Use when your connected equipment doesn’t have a DTS decoder. In this case, use the analog audio outputs.</td>
</tr>
<tr>
<td></td>
<td><strong>96 kHz PCM Out</strong></td>
<td>Convert 96 kHz digital audio sources to 48 kHz output. Use if your connected equipment doesn’t support 96 kHz sampling rate.</td>
</tr>
<tr>
<td></td>
<td><strong>MPEG Out</strong></td>
<td>Output an MPEG audio signal when a source using MPEG audio is being played.</td>
</tr>
<tr>
<td></td>
<td><strong>MPEG → PCM •</strong></td>
<td>Convert sources with MPEG audio to Linear PCM output. If your connected equipment doesn’t have an MPEG audio decoder.</td>
</tr>
</tbody>
</table>
# The Initial Setup menu

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Explanation</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Language Settings</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OSD Language</td>
<td>English •</td>
<td>Sets the language of the on-screen displays to English.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>français</td>
<td>Sets the language of the on-screen displays to French.</td>
<td></td>
</tr>
<tr>
<td>Audio Language</td>
<td>English •</td>
<td>Sets the default audio language for DVD-Video playback to English.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>French</td>
<td>Sets the default audio language for DVD-Video playback to French.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Other</td>
<td>Select to set the default audio language to something other than the others listed. See Selecting other languages for language options on page 97.</td>
<td></td>
</tr>
<tr>
<td>Discs do not necessarily have audio in your selected language. Also, some discs override the Audio Language preference.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Subtitle Language</td>
<td>English •</td>
<td>Sets the default subtitle language for DVD-Video playback to English.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>French</td>
<td>Sets the default subtitle language for DVD-Video playback to French.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Other</td>
<td>Select to set the default subtitle language to something other than the ones listed. See Selecting other languages for language options on page 97.</td>
<td></td>
</tr>
<tr>
<td>Discs do not necessarily have subtitles in your selected menu language. Also, some discs override the Subtitle Language preference.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Auto Language</td>
<td>On •</td>
<td>On this setting: &lt;br&gt;• DVD-Video discs whose main audio track is in your default language will play using that language, without subtitles. &lt;br&gt;• Discs whose main audio track is not in your default language but that have a subtitle track in your default language will play the original audio track with subtitles.</td>
<td>Select to play DVD-Video discs according to your audio and subtitle language preferences.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td></td>
<td></td>
</tr>
<tr>
<td>For Auto Language to be effective, the Audio Language and Subtitle Language options must be set to the same language.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DVD Menu Language w/Subtitle Language</td>
<td>English •</td>
<td>Sets the language of DVD-Video menus to the same as that set for the subtitle language.</td>
<td>Select to set the DVD menu language to something other than the ones listed. See Selecting other languages for language options on page 97.</td>
</tr>
<tr>
<td></td>
<td>French</td>
<td>Sets the language of DVD-Video menus to French.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Other</td>
<td>Select to set the DVD menu language to something other than the ones listed. See Selecting other languages for language options on page 97.</td>
<td></td>
</tr>
<tr>
<td>Discs do not necessarily have menus in your selected menu language.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Subtitle Display</td>
<td>On •</td>
<td>Select to have discs display subtitles according to your Subtitle Language and Auto Language preferences.</td>
<td>Select to switch off subtitle display.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Assist Subtitle</td>
<td>Select to display special additional assistive subtitles, where available.</td>
<td></td>
</tr>
<tr>
<td>Some discs may override these settings.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### The Initial Setup menu

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Recording Settings</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Manual Recording</td>
<td>On (go to setup)</td>
<td>All the standard recording modes, plus MN1–32, LPCM and XP+ modes can be set.</td>
</tr>
<tr>
<td></td>
<td>Off •</td>
<td>Just the standard recording modes (XP, SP, LP, EP, SLP and SEP) can be set.</td>
</tr>
<tr>
<td>See also Manual recording modes on page 105 for detailed information on manual recording levels.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Optimized Rec</td>
<td>On</td>
<td>The recording quality of timer recordings is automatically adjusted to fit on to the selected media if it will not fit at the selected quality setting. If the recording will not fit even at MN1, then the recording will start at MN1 and stop when all the available space is used up.</td>
</tr>
<tr>
<td></td>
<td>Off •</td>
<td>When a timer recording is set that won't fit on to the selected media, the recording starts but is cut off when no more recording is possible.</td>
</tr>
<tr>
<td>Optimized Rec will only compensate for the next scheduled timer recording if more than one is set.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Set Thumbnail</td>
<td>0 seconds •</td>
<td>Sets the default thumbnail picture in the Disc Navigator to the first frame of the title.</td>
</tr>
<tr>
<td></td>
<td>30 seconds</td>
<td>Sets the default thumbnail picture to 30 seconds into the title.</td>
</tr>
<tr>
<td></td>
<td>3 minutes</td>
<td>Sets the default thumbnail picture to 3 minutes into the title.</td>
</tr>
<tr>
<td>Auto Chapter (Video)</td>
<td>No Separation</td>
<td>Automatic chapter marking is switched off.</td>
</tr>
<tr>
<td></td>
<td>10 minutes •</td>
<td>When recording in Video mode, chapter markers are inserted every 10 minutes.</td>
</tr>
<tr>
<td></td>
<td>15 minutes</td>
<td>Chapter markers are inserted every 15 minutes.</td>
</tr>
<tr>
<td>DVD-RW Auto Init.</td>
<td>VR Mode •</td>
<td>Blank DVD-RW discs are initialized for VR mode recording when loaded into the recorder for the first time.</td>
</tr>
<tr>
<td></td>
<td>Video Mode</td>
<td>Blank DVD-RW discs are initialized for Video mode recording.</td>
</tr>
<tr>
<td>HDD Recording Format</td>
<td>Video Mode Off</td>
<td>Recordings made to the HDD are made in VR mode. Use this setting if you don't need to transfer the recording later to a Video mode DVD.</td>
</tr>
<tr>
<td></td>
<td>Video Mode On •</td>
<td>Recordings made to the HDD are compatible with Video mode recordings. This setting is convenient if you want to transfer the recording to a Video mode DVD as high-speed copy can be used.</td>
</tr>
<tr>
<td>When Video Mode On is used, you must select the audio channel you want to record when recording a broadcast with a SAP channel. On the Video Mode Off setting, both channels will be recorded and you can switch between them on playback. See also Dual Mono Recording on page 93.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Playback Settings</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TV Screen Size</td>
<td>4:3 (Letter Box) •</td>
<td>Select if you have a standard 4:3 TV and prefer the letter box format presentation for widescreen material.</td>
</tr>
<tr>
<td></td>
<td>4:3 (Pan &amp; Scan)</td>
<td>Select if you have a standard 4:3 TV and prefer the pan and scan presentation for widescreen material.</td>
</tr>
<tr>
<td></td>
<td>16:9</td>
<td>Select if you have a widescreen 16:9 TV. Your TV settings determine how 4:3 material will look.</td>
</tr>
<tr>
<td>Selecting 4:3 (Letter Box) or 4:3 (Pan &amp; Scan) does not guarantee that all video material will be presented in that format as some discs override this setting.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## The Initial Setup menu

### Setting Options Explanation

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Still Picture</td>
<td>Field</td>
<td>Produces a stable, generally shake-free image.</td>
</tr>
<tr>
<td></td>
<td>Frame</td>
<td>Produces a sharper image, but more prone to shake than Field stills.</td>
</tr>
<tr>
<td></td>
<td>Auto</td>
<td>The recorder automatically selects Field or Frame type still, according to the material playing.</td>
</tr>
<tr>
<td>Seamless Playback</td>
<td>On</td>
<td>Playback is smooth, but with a trade-off against the accuracy of the edit points.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>You may notice momentary interruption at edited points during playback of a VR mode Play List.</td>
</tr>
<tr>
<td>Parental Lock</td>
<td>Set Password</td>
<td>In order to change the parental lock level or change the country/area code, set the password using this option. From the following screen, enter a four-digit number that will be your password.</td>
</tr>
<tr>
<td></td>
<td>Change Password</td>
<td>In order to change the password, first enter your existing password and then a new one from the following screen.</td>
</tr>
<tr>
<td></td>
<td>Change Level</td>
<td>From the following screen, first enter your password and then set a parental lock level.</td>
</tr>
<tr>
<td></td>
<td>Country/Area Code</td>
<td>From the following screen, first enter your password and then set a country/area code.</td>
</tr>
</tbody>
</table>

Only certain discs have parental lock and country code features. Check the disc packaging to see what features the disc has. If you forget your password you can reset it by resetting the recorder to its factory settings. See Resetting the recorder on page 98.

### Options

<table>
<thead>
<tr>
<th>Options</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>On-Screen Display</td>
<td>The recorder displays operation displays (Stop, Play, etc.) on-screen.</td>
</tr>
<tr>
<td></td>
<td>Switches off the on-screen operation displays.</td>
</tr>
<tr>
<td>Front Panel Display</td>
<td>The time is shown in the front panel display when the recorder is in standby.</td>
</tr>
<tr>
<td></td>
<td>The front panel display is switched off in standby (although it still lights dimly when setting a timer recording).</td>
</tr>
<tr>
<td>Remote Control Mode</td>
<td>If you are using more than one recorder in the same room, set them to different IDs. This setting sets the recorder ID; to change the remote controller ID, press and hold RETURN then press 1, 2 or 3 to set. The remote will only control a recorder with the same ID.</td>
</tr>
</tbody>
</table>

### Angle Indicator

On • A camera icon appears on-screen during multi-angle scenes on a DVD-Video disc.

Off Nothing is indicated on-screen when a multi-angle scene is showing.
Additional information about component video output
If you switch the Component Video Out setting to Progressive when using a TV that is not compatible with progressive-scan video, you will not be able to see anything displayed on your TV. If this happens, press and hold the STOP button on the front panel, then press PLAY. This will set the recorder’s video output back to Interlace.

Selecting other languages for language options
1. Select 'Other' from the language list. This option appears in the settings for DVD Menu Language, Audio Language, and Subtitle Language.
2. Select the language you want.
   - Select by language name: Use the ←/→ buttons to change the language.
   - Select by code number: Press ↓ then use the number buttons to enter the four-digit language code.

Compatibility of this unit with progressive-scan TVs
Consumers should note that not all high-definition television sets are fully compatible with this product and may cause artifacts to be displayed in the picture. In case of 525 progressive-scan picture problems, it is recommended that the user switch the connection to the ‘standard definition’ output (Interlace). If there are questions regarding our TV set compatibility with this model, please contact our customer service center.

This recorder is compatible with the following Pioneer displays and monitors:

Plasma display

Projection monitor receiver
- Pro-700HD, Pro-710HD, Pro-610HD, Pro-510HD, Pro-720HD, Pro-620HD, Pro-520HD, SD-641HD5, SD-582HD5, SD-532HD5, SD-553HD5, SD-643HD5, Pro-730HD, Pro-630HD, Pro-530HD, Pro-730HDi, Pro-530HDi, Pro-730HD, Pro-630HD, Pro-530HD
Chapter 14
Additional information

Resetting the recorder
If you need to, you can reset the recorder to all its factory settings.

1. Make sure that the recorder is on.
2. Press and hold STOP and press STANDBY/ON. The recorder turns off with all settings reset.

Setting up the remote to control your TV
You can use the supplied remote to control your TV. To be able to use this feature you first have to program the remote with a maker code from the table below.

1. Press and hold down the CLEAR button, then enter the maker code for your TV. The LED indicator on the remote controls lights. See the list below for the list of maker codes. If there is more than one code given for your make, input the first one in the list.
   - If the maker’s name of your TV doesn’t appear in the table below, you will not be able to use this remote to control your TV.

2. Press TV to check that the remote works with your TV. If the remote is set up correctly, the TV should switch on/off. If it doesn’t and there is another code given for your maker, repeat step 1 with a new code.

Using the TV remote control buttons
The table below shows how to use this remote control with your TV.

<table>
<thead>
<tr>
<th>Button</th>
<th>What it does</th>
</tr>
</thead>
<tbody>
<tr>
<td>○ TV</td>
<td>Press to switch the TV on/off (standby)</td>
</tr>
<tr>
<td>INPUT SELECT</td>
<td>Press to change the TV’s video input</td>
</tr>
<tr>
<td>TV VOLUME</td>
<td>Use to adjust the TV volume</td>
</tr>
<tr>
<td>TV CHANNEL</td>
<td>Use to change TV channels</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Maker</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aiwa</td>
<td>38</td>
</tr>
<tr>
<td>Funai</td>
<td>36</td>
</tr>
<tr>
<td>GE</td>
<td>11, 28</td>
</tr>
<tr>
<td>General</td>
<td>34</td>
</tr>
<tr>
<td>Goldstar</td>
<td>10, 23</td>
</tr>
<tr>
<td>Grandiente</td>
<td>30</td>
</tr>
<tr>
<td>Hitachi</td>
<td>06, 24, 25, 32</td>
</tr>
<tr>
<td>Magnavox</td>
<td>12, 29</td>
</tr>
<tr>
<td>Mitsubishi</td>
<td>09</td>
</tr>
<tr>
<td>NEC</td>
<td>37</td>
</tr>
<tr>
<td>Panasonic</td>
<td>08, 22, 41</td>
</tr>
<tr>
<td>Philips</td>
<td>07</td>
</tr>
<tr>
<td>Pioneer</td>
<td>00, 35, 40, 44</td>
</tr>
<tr>
<td>RCA</td>
<td>01, 15, 16, 17, 18</td>
</tr>
<tr>
<td>Sanyo</td>
<td>14, 21</td>
</tr>
<tr>
<td>Sharp</td>
<td>02, 19, 27</td>
</tr>
<tr>
<td>Sony</td>
<td>04</td>
</tr>
<tr>
<td>Toshiba</td>
<td>05, 26, 31, 43</td>
</tr>
<tr>
<td>JVC</td>
<td>13, 33, 42</td>
</tr>
<tr>
<td>Zenith</td>
<td>03, 20</td>
</tr>
</tbody>
</table>
## Screen sizes and disc formats

### When viewing on a standard TV or monitor

<table>
<thead>
<tr>
<th>Screen format of disc</th>
<th>Setting</th>
<th>Appearance</th>
</tr>
</thead>
<tbody>
<tr>
<td>16:9</td>
<td>4:3 (Letter Box)</td>
<td>The program is shown in widescreen with black bars at the top and bottom of the screen.</td>
</tr>
<tr>
<td></td>
<td>4:3 (Pan &amp; Scan )</td>
<td>The sides of the program are cropped so that the picture fills the whole screen.</td>
</tr>
<tr>
<td>4:3</td>
<td>16:9</td>
<td>The program appears squashed. Set to either 4:3 (Letter Box) or 4:3 (Pan &amp; Scan).</td>
</tr>
<tr>
<td></td>
<td>4:3 (Letter Box)</td>
<td>The program is presented correctly on either setting.</td>
</tr>
<tr>
<td></td>
<td>4:3 (Pan &amp; Scan )</td>
<td></td>
</tr>
</tbody>
</table>

### When viewing on a widescreen TV or monitor

<table>
<thead>
<tr>
<th>Screen format of disc</th>
<th>Setting</th>
<th>Appearance</th>
</tr>
</thead>
<tbody>
<tr>
<td>16:9</td>
<td>16:9</td>
<td>The program is presented in widescreen.</td>
</tr>
<tr>
<td>4:3</td>
<td>16:9</td>
<td>Your TV will determine how the picture is presented—check the manual that came with the TV for details.</td>
</tr>
</tbody>
</table>

---
**Minimum copying times**

The table below shows the minimum HDD to DVD copying time for one hour of video (extra time will be required for initializing and finalizing a disc).

Please note that not all discs are compatible with high-speed copying. Check with the disc manufacturer for compatibility.

Note that all times in the above table are approximate.

*1 Compatible with single speed recording only
*2 Compatible with 2x speed recording
*3 Compatible with 4x speed recording
*4 Compatible with 8x speed recording.
*5 Compatible with 12x speed recording.

Note that actual copy speed varies with the part of the disc being recorded.

The table below shows 16x DVD-R and 6x DVD-RW disc brands that have been tested for high-speed writing compatibility with this recorder.

### DVD disc type

<table>
<thead>
<tr>
<th>Rec mode</th>
<th>SEP</th>
<th>SLP</th>
<th>EP</th>
<th>LP</th>
<th>SP</th>
<th>XP</th>
</tr>
</thead>
<tbody>
<tr>
<td>DVD-RW Ver. 1.0, 1.1</td>
<td>6 mins.</td>
<td>7.5 mins.</td>
<td>10 mins.</td>
<td>15 mins.</td>
<td>30 mins.</td>
<td>60 mins.</td>
</tr>
<tr>
<td>DVD-R Ver. 2.0</td>
<td>3 mins.</td>
<td>4 mins.</td>
<td>5 mins.</td>
<td>7.5 mins.</td>
<td>15 mins.</td>
<td>30 mins.</td>
</tr>
<tr>
<td>DVD-RW Ver. 1.1/2x</td>
<td>1.5 mins.</td>
<td>2 mins.</td>
<td>2.5 mins.</td>
<td>4 mins.</td>
<td>15 mins.</td>
<td>15 mins.</td>
</tr>
<tr>
<td>DVD-R Ver. 2.0/4x*2</td>
<td>1.25 mins.</td>
<td>1.5 mins.</td>
<td>2 mins.</td>
<td>2.5 mins.</td>
<td>10 mins.</td>
<td>8 mins.</td>
</tr>
<tr>
<td>DVD-RW Ver. 1.2/4x*3</td>
<td>1.1 mins.</td>
<td>1.25 mins.</td>
<td>1.5 mins.</td>
<td>2 mins.</td>
<td>8 mins.</td>
<td>6 mins.</td>
</tr>
<tr>
<td>DVD-R Ver. 2.0/8x*4</td>
<td>1 min.</td>
<td>1.1 mins.</td>
<td>1.25 mins.</td>
<td>1.5 mins.</td>
<td>3 mins.</td>
<td></td>
</tr>
<tr>
<td>DVD-RW Ver. 1.2/6x*3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DVD-R Ver. 2.1/8x*5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DVD-R Ver. 2.0/16x*5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Note

1. There may be cases where even 2x/4x/6x/8x/16x compatible discs do not copy at full speed. High speed copying is not possible when using discs initialized on another recorder.
Additional information

Troubleshooting
Incorrect operation is often mistaken for trouble and malfunction. If you think there is something wrong with this component, please check the points below. Sometimes the trouble may lie in another component. Investigate the other components and electrical appliances being used. If the trouble cannot be rectified even after checking the points below, ask your nearest Pioneer authorized service center or your dealer to carry out repair work.

General

<table>
<thead>
<tr>
<th>Problem</th>
<th>Remedy</th>
</tr>
</thead>
</table>
| The disc is automatically ejected after closing the disc tray | • Check that the disc is not a DVD+R/RW, DVD-RAM, dual disc (DVD/CD hybrid disc) or other incompatible format disc (page 10).  
  • Check that the disc is loaded properly (aligned in disc tray and label-side up).  
  • Take out the disc and clean it (page 109).  
  • Check that the disc has a region code compatible with the recorder (page 112). |
| No picture                    | • Check that everything is connected properly (page 14).  
  • Check that the connected TV and/or the AV amp/receiver is set to the correct input.  
  • Make sure that the disc is NTSC format.  
  • The recorder may be set to progressive-scan with an incompatible TV. Reset to interlace by pressing and holding the [STOP] button (front panel) then pressing [PLAY].  
  • The recorder may be set to progressive scan with an incompatible TV. Reset to interlace by pressing and holding the front panel [STOP] button then pressing [PLAY]. |
| Can’t play a disc             | • Check that the disc is not a DVD+R/RW, DVD-RAM, dual disc (DVD/CD hybrid disc) or other incompatible format disc (page 10).  
  • Take out the disc and clean it (page 109).  
  • Check that the disc is loaded properly (aligned in disc tray and label-side up).  
  • There may be condensation in the recorder. Leave the recorder for an hour or so for the condensation to evaporate. |
| Can’t record a disc           | • Check that the disc is not a DVD+R/RW, DVD-RAM or other incompatible format disc (page 10). |
| All settings are reset        | • If the recorder is unplugged (or there is a power failure) while the recorder is on, all the settings will be lost.  
  • Make sure that you switch the recorder into standby before unplugging the power cord. |
| Remote control does not work | • If you connected this recorder to another Pioneer product using the CONTROL IN jack, point the remote control at the other component to use (page 14).  
  • Set the remote control to the same ID number as the recorder (page 96). (When the batteries run down, the remote mode is automatically reset to Recorder1.)  
  • Use the remote within its operating range (page 10).  
  • Replace the batteries (page 10). |
### Additional information

<table>
<thead>
<tr>
<th>Problem</th>
<th>Remedy</th>
</tr>
</thead>
</table>
| No sound or sound is distorted                                         | • Make sure that the amp/receiver or TV is set to the correct input and the volume turned up.  
• There is no sound when the picture is paused, or during scanning or slow motion play. Press ➤ PLAY to resume regular playback.  
• DTS discs can only be played if this recorder is connected to a DTS decoder or DTS compatible amp/receiver. If you have connected a suitable decoder, also make sure that the Initial Setup > Audio Out > DTS Out setting is On.  
• Some 96kHz discs do not output audio through the digital jack. In this case, switch the input of your amp/receiver to analog.  
• Check the audio cable connections (page 14).  
• If the sound is distorted, try cleaning the cable plugs. |
| The picture from the external input is distorted                      | • If the video signal from the external component is copy-protected, you cannot connect via this recorder. Connect the component directly to your TV.                                                                 |
| Screen is stretched vertically or horizontally                        | • Make sure that the TV Screen Size setting (page 95) is correct for the kind of TV you have (see also page 99).  
• If you have a widescreen TV, check its aspect ratio settings.  
• This recorder’s input switches into wide mode automatically according to the input signal. When the unit connected is not compatible with VIDEO ID-1 (widescreen signalling), set the connected component to output 4:3 aspect ratio (standard) video. |
| Can’t play a disc recorded using this recorder on another player        | • If the disc was recorded in Video mode, make sure that it’s finalized (page 55).  
• Some players will not play recordable DVD discs, even when recorded in Video mode and finalized.  
• If the disc was recorded in VR mode, the other player must be specifically RW compatible in order to play it (page 10).  
• Discs recorded with copy-once material cannot be played on non-CPRM compatible players (page 50). |
| During playback the picture is dark or distorted                      | • When a copy-protected disc is played via a VCR, the picture will not display correctly. Connect the recorder directly to your TV.                                                                          |
| Can’t control your TV using this remote control                       | • If there is more than one code listed for your make of TV, try each one in turn (page 98).  
• It is possible that none of the codes listed will work with your particular model of TV, even if the maker appears in the remote control code list. |
| Can’t record or does not record successfully                          | • Check that there is some remaining blank space on the DVD/HDD.  
• For a Video mode disc, check that the disc isn’t already finalized.  
• The HDD may contain up to 999 titles: one DVD disc 99 (Original) titles and 999 chapters (VR mode), or 99 Chapters (Video mode). Check that these limits have not been reached.  
• Check that the source you are trying to record is not copy protected.  
• For a VR formatted disc, check that the disc isn’t locked (page 87).  
• The power may have failed during recording. |
| Timer program doesn’t record successfully                             | • When setting the recording channel, make sure you set the recorder’s built-in TV tuner, not the TV’s built-in tuner.  
• When recording to a Video mode disc, programs that are copy-once protected cannot be recorded. Use a VR mode formatted disc for copy-once material (page 50).  
• Two timer programs may have overlapped, in which case only the earlier one will record completely.  
• The power may have failed during recording. |
If the unit does not operate normally due to external effects such as static electricity, disconnect the power plug from the outlet and insert again to return to normal operating conditions.

Frequently asked questions
In this section you can find answers to frequently asked questions on how to use your DVD recorder and what it can do.

- **How do I make a high-quality copy?**
  We recommend that you use the high-speed copy mode. Although the copy is faster than real time, there is no loss of picture or sound quality compared to the original.
  If there is not enough space on the disc to make a copy at the same picture quality as the original, we recommend that you change the recording mode to ‘Optimized’. This will fit the recording on to the available space on the disc.
  See also Copying and back-up on page 66.

- **Can I make a DVD copy of, say, a movie that has had the commercials edited out?**
  Yes. There are two ways to do this. You can either edit the video on the HDD then copy the edited version to DVD, or you can assemble a Copy List that cuts out the commercials, then record that to DVD.
  See also Copying and back-up on page 66.

- I have a two-hour recording on the HDD made in XP mode. Can I copy this to DVD in high-speed mode? A standard DVD disc can hold only an hour of XP mode material, so you wouldn’t be able to make a high-speed copy of this on to one disc. You could divide up the recording on the HDD into two of an hour each and copy these to two DVDs (using high-speed copy). Alternatively, you could copy the material in SP (or Optimized) mode so as to fit it all on to one disc (note that there will be a loss in picture quality if you do this).
  See also Copying and back-up on page 66.

- Can I record a broadcast containing a main and SAP channel to the HDD, keeping both audio channels and switch them on playback?
  Yes. When HDD Recording Format is set to Video Mode Off (see HDD Recording Format on page 96) and SAP is selected as the broadcast audio channel, both channels of the broadcast are recorded (unless you set the recording mode to LPCM, in which case only the channel set using the Dual Mono Recording setting will be recorded; see Using the built-in TV tuner on page 28).

---

### Additional information

<table>
<thead>
<tr>
<th>Problem</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>After briefly unplugging or after a power failure the front panel display shows ‘--:--’</td>
<td>• A backup battery inside the recorder keeps the clock and other settings from being reset when there is no power to the recorder. This battery should last approximately five years from factory shipping. Reset the clock and other recorder settings to use the recorder again. To have the battery replaced, contact your dealer or a Pioneer Service Center.</td>
</tr>
<tr>
<td>Front panel display shows ‘LOCK’ when a button is pressed</td>
<td>• The Child Lock is on; turn off in order to use the recorder (page 38).</td>
</tr>
<tr>
<td>Can’t use One Touch Copy (HDD to DVD)</td>
<td>• Make sure that there is a recordable DVD loaded with some free space for recording and fewer than 99 titles already on the disc. Also make sure that for a Video mode disc, the disc isn’t finalized.  • If the title currently playing contains material that is copy-once protected, One Touch Copy will not work.  • If the currently playing HDD content was recorded in XP+ mode, the One Touch Copy feature can’t be used.  • One Touch Copy doesn’t work if the recorder is already recording to DVD.</td>
</tr>
<tr>
<td>Can’t use One Touch Copy (DVD to HDD)</td>
<td>• Make sure that there is space available on the HDD and that there are fewer than 999 titles on the HDD.  • One Touch Copy doesn’t work if the recorder is already recording to the HDD.</td>
</tr>
<tr>
<td>The picture freezes and the front panel and remote control buttons stop working</td>
<td>• Press ◄ STOP then try restarting playback.  • Press the front panel ○ STANDBY/ON button to switch the power off, then switch back on and restart playback. If the power fails to switch off, press and hold ○ STANDBY/ON for 10 seconds until the power switches off.</td>
</tr>
</tbody>
</table>

If the unit does not operate normally due to external effects such as static electricity, disconnect the power plug from the outlet and insert again to return to normal operating conditions.
Additional information

- Can I copy a finalized Video mode disc (DVD-R or DVD-RW) to the HDD?
  Yes. Start playing the Video mode disc and use the One Touch Copy button to copy the currently playing title to the HDD. Repeat for as many titles on the disc as you want to copy.
  See also Copying from DVD to HDD on page 70.

- Can I use high-speed copy to copy from DVD to HDD?
  You can only use high-speed copy from DVD to HDD when copying Original titles from a VR mode DVD-R or DVD-RW disc.
  See also Copying from DVD to HDD on page 70.

- Can I copy a copy-once protected program from a subscription satellite or cable channel to a DVD from the HDD?
  Yes, you can use high-speed copy to copy to a VR mode disc. You can also divide the recording on the HDD into a number of smaller titles if the whole recording won’t fit on to one disc.
  See also Copying from HDD to DVD on page 67.

- Can I play a DVD I recorded on this recorder on another DVD player?
  Yes, you can generally play finalized Video mode discs recorded on this recorder on any standard DVD player. You may find, however, that some players will not play some recordable media.
  For VR mode DVD-RW discs, look for the ‘RW Compatible’ mark to see if it will play the disc.

About DV
DVR-633/533H-S only

Using DV, also known as i.LINK, you can connect a DV-equipped camcorder to this recorder using a single DV cable for input of audio, video, data and control signals.

The i.LINK interface is also known as IEEE 1394-1995. “i.LINK” and the “i.LINK” logo are trademarks.

- This recorder is only compatible with DV-format (DVC-SD) camcorders. Digital satellite receivers and Digital VHS video recorders are not compatible.
- You cannot connect more than one DV camcorder at a time to this recorder.
- You cannot control this recorder from external equipment connected via the DV IN jack.
- It may not always be possible to control the connected camcorder via the DV IN jack.

- Digital camcorders can usually record audio as stereo 16-bit/48kHz, or twin stereo tracks of 12-bit/32kHz. This recorder can only record one stereo audio track. Set the DV Input setting as required (see DV Input on page 93).
- Audio input to the DV IN jack should be 32 or 48kHz (not 44.1kHz).
- Picture disturbance in the recording may occur if the source component pauses playback or plays an unrecorded section of tape, or if the power fails in the source component, or the DV cable becomes disconnected.
- The DV IN jack is an input only. There is no output functionality.

DV-related messages
You may see the following messages appear on your TV screen when using the DV IN jack.

- No DV camcorder connected. – The camcorder is not connected properly, or the camcorder is switched off.
- The DV camcorder is recording. – The camcorder is recording, so you cannot start recording from the camcorder to this recorder.
- You cannot connect more than one DV camcorder at the same time. – The DV jack on this recorder supports connection to just one camcorder.
- No tape in the DV camcorder. – There is no cassette loaded into the connected equipment.
- The DV camcorder is in record-pause mode. – The camcorder is in record-pause mode.
- DV camcorder playback canceled. Recording has been paused. – Recording was paused because the camcorder is not in playback mode.
- Cannot operate the DV camcorder. – This recorder cannot control the camcorder. Try switching off the camcorder then switching it back on.
- Could not operate the DV camcorder. – This recorder was not able to control the camcorder.
- Recording has stopped because the recorded material on the tape finished. – When the recorded part of the DV tape comes to an end, this recorder automatically stops recording.
- Recording has stopped because DV camcorder playback stopped. – Recording stopped because DV camcorder playback was stopped or the camcorder was disconnected.
- The DV camcorder is not set for playback. Please select playback mode on the DV camcorder. – The camcorder is in camera mode.
### Manual recording modes

The table below shows the approximate recording times for a VR mode and Video mode DVD in each manual recording mode, as well as the standard recording mode equivalents. Levels separated by a bold line show where there is a noticeable change in picture quality.

Audio recording in all manual recording modes is in Dolby Digital 2ch format, except for LPCM mode, which is in Linear PCM format.

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Video mode Off (HDD)</th>
<th>Video mode On (HDD)</th>
<th>Video mode (DVD)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>VR mode (DVD)</td>
<td>VR mode (HDD)</td>
<td>Video mode (DVD)</td>
</tr>
<tr>
<td>352 x 240</td>
<td>MN 1 802 mins.</td>
<td>MN 1 802 mins.</td>
<td>MN 1 802 mins.</td>
</tr>
<tr>
<td></td>
<td>MN 2 720 mins.</td>
<td>MN 2 720 mins.</td>
<td>MN 2 720 mins.</td>
</tr>
<tr>
<td></td>
<td>MN 3 600 mins.</td>
<td>MN 3 600 mins.</td>
<td>MN 3 600 mins.</td>
</tr>
<tr>
<td></td>
<td>MN 4 480 mins.</td>
<td>MN 4 480 mins.</td>
<td>MN 4 480 mins.</td>
</tr>
<tr>
<td></td>
<td>MN 5 420 mins.</td>
<td>MN 5 420 mins.</td>
<td>MN 5 420 mins.</td>
</tr>
<tr>
<td></td>
<td>MN 6 360 mins.</td>
<td>MN 6 360 mins.</td>
<td>MN 6 360 mins.</td>
</tr>
<tr>
<td>352 x 480</td>
<td>MN 7 300 mins.</td>
<td>MN 7 300 mins.</td>
<td>MN 7 300 mins.</td>
</tr>
<tr>
<td></td>
<td>MN 8 270 mins.</td>
<td>MN 8 270 mins.</td>
<td>MN 8 270 mins.</td>
</tr>
<tr>
<td>480 x 480</td>
<td>MN 9 240 mins.</td>
<td>MN 9 240 mins.</td>
<td>MN 9 240 mins.</td>
</tr>
<tr>
<td></td>
<td>MN 10 230 mins.</td>
<td>MN 10 230 mins.</td>
<td>MN 10 230 mins.</td>
</tr>
<tr>
<td></td>
<td>MN 11 220 mins.</td>
<td>MN 11 220 mins.</td>
<td>MN 11 220 mins.</td>
</tr>
<tr>
<td>544 x 480</td>
<td>MN 12 210 mins.</td>
<td>MN 12 210 mins.</td>
<td>MN 12 210 mins.</td>
</tr>
<tr>
<td></td>
<td>MN 13 200 mins.</td>
<td>MN 13 200 mins.</td>
<td>MN 13 200 mins.</td>
</tr>
<tr>
<td></td>
<td>MN 14 190 mins.</td>
<td>MN 14 190 mins.</td>
<td>MN 14 190 mins.</td>
</tr>
<tr>
<td></td>
<td>MN 15 180 mins.</td>
<td>MN 15 180 mins.</td>
<td>MN 15 180 mins.</td>
</tr>
<tr>
<td></td>
<td>MN 16 170 mins.</td>
<td>MN 16 170 mins.</td>
<td>MN 16 170 mins.</td>
</tr>
<tr>
<td></td>
<td>MN 17 160 mins.</td>
<td>MN 17 160 mins.</td>
<td>MN 17 160 mins.</td>
</tr>
<tr>
<td></td>
<td>MN 18 150 mins.</td>
<td>MN 18 150 mins.</td>
<td>MN 18 150 mins.</td>
</tr>
<tr>
<td></td>
<td>MN 19 140 mins.</td>
<td>MN 19 140 mins.</td>
<td>MN 19 140 mins.</td>
</tr>
<tr>
<td></td>
<td>MN 20 130 mins.</td>
<td>MN 20 130 mins.</td>
<td>MN 20 130 mins.</td>
</tr>
<tr>
<td></td>
<td>MN 21 120 mins.</td>
<td>MN 21 120 mins.</td>
<td>MN 21 120 mins.</td>
</tr>
<tr>
<td></td>
<td>MN 22 110 mins.</td>
<td>MN 22 110 mins.</td>
<td>MN 22 110 mins.</td>
</tr>
<tr>
<td></td>
<td>MN 23 105 mins.</td>
<td>MN 23 105 mins.</td>
<td>MN 23 105 mins.</td>
</tr>
<tr>
<td></td>
<td>MN 24 100 mins.</td>
<td>MN 24 100 mins.</td>
<td>MN 24 100 mins.</td>
</tr>
<tr>
<td></td>
<td>MN 25 95 mins.</td>
<td>MN 25 95 mins.</td>
<td>MN 25 95 mins.</td>
</tr>
<tr>
<td></td>
<td>MN 26 90 mins.</td>
<td>MN 26 90 mins.</td>
<td>MN 26 90 mins.</td>
</tr>
<tr>
<td></td>
<td>MN 27 85 mins.</td>
<td>MN 27 85 mins.</td>
<td>MN 27 85 mins.</td>
</tr>
<tr>
<td></td>
<td>MN 28 80 mins.</td>
<td>MN 28 80 mins.</td>
<td>MN 28 80 mins.</td>
</tr>
<tr>
<td></td>
<td>MN 29 75 mins.</td>
<td>MN 29 75 mins.</td>
<td>MN 29 75 mins.</td>
</tr>
<tr>
<td></td>
<td>MN 30 70 mins.</td>
<td>MN 30 70 mins.</td>
<td>MN 30 70 mins.</td>
</tr>
<tr>
<td></td>
<td>MN 31 65 mins.</td>
<td>MN 31 65 mins.</td>
<td>MN 31 65 mins.</td>
</tr>
<tr>
<td></td>
<td>MN 32 61 mins.</td>
<td>MN 32 61 mins.</td>
<td>MN 32 61 mins.</td>
</tr>
<tr>
<td></td>
<td>LPCM 61 mins.</td>
<td>LPCM 61 mins.</td>
<td>LPCM 61 mins.</td>
</tr>
<tr>
<td></td>
<td>XP+ 41 mins.</td>
<td>XP+ 41 mins.</td>
<td>XP+ 41 mins.</td>
</tr>
</tbody>
</table>

* XP+ mode is available for HDD recording only. If set for a DVD recording, the DVD will be recorded in MN32 mode.

When recording to the HDD, recording for the times given will use approximately 4.7 GB of HDD space (equivalent to one recordable DVD).

See also Recording on page 49.
**Additional information**

**Additional information for cable/satellite/STB (set-top box) users**

The following instructions show how to use the timer features of your STB with this recorder.

**Setting up**

1. Connect the STB’s audio/video outputs to a set of audio/video inputs on this recorder.

2. Switch on both the STB and this recorder and switch the recorder’s input function to the STB (L1, L2 or L3).

   To check that everything is connected properly, switch on your TV and select this recorder as the video input. You should see whatever the STB is tuned to.

3. Program the IR controller supplied with your STB to send start/stop recording codes for a Pioneer VCR.

   See the manual that came with the STB for how to do this.

   Only the **REC** and **STOP** codes have any effect when used with this recorder:
   - **REC** – Start recording
   - **STOP** – Stop recording

4. Position the IR controller so that it will control this recorder.

   The IR sensor on the recorder is located just above the mark on the front panel.

**Making a timer recording**

1. Set the timer on the STB.

   See the manual that came with your STB for how to do this.

2. Switch on this recorder.

   You must leave the recorder on until the recording finishes.
   - At the programmed times, the STB will start and stop recording on this recorder.
Language code list

Language code (Language code letter)

Japanese (ja), 1001
English (en), 0514
French (fr), 0618
German (de), 0405
Italian (it), 0920
Spanish (es), 0519
Chinese (zh), 2608
Dutch (nl), 1412
Portuguese (pt), 1620
Swedish (sv), 2008
Bihari (bh), 0426
Byelorussian (be), 0515
Bulgarian (bg), 0520
Bislama (bi), 0521
Bengali (bn), 0609
Catalan (ca), 0610
Tibetan (bo), 0615
Irish (ga), 0625
Scots-Gealic (gd), 0704
Galician (gl), 0712
Guarani (gn), 0714
Javanese (ja), 0801
Arabic (ar), 0809
Kurdish (ku), 0811
Welsh (cy), 0904
Burmese (my), 0911
Indonesian (id), 0914
Icelandic (is), 0919
Kazakh (kk), 0923
Javanese (jv), 0924
Kazakh (kk), 1001
Georgian (ka), 1112
Czech (cs), 1113
Kashmiri (sa), 1119
Kurdish (ku), 1121
Kirghiz (ky), 1125
Latin (la), 1201
Lingala (lo), 1214
Laotian (lo), 1215
Lithuanian (lt), 1220
Latvian (lv), 1222
Malagasy (mg), 1307
Mongolian (mn), 1310
Macedonian (mk), 1311
Malayalam (ml), 1312
Mongolian (mn), 1314
Moldavian (mo), 1315
Marathi (mr), 1318
Malay (ms), 1319
Malay (ms), 1320
Macedonian (mk), 1325
Malagasy (mg), 1401
Nepali (ne), 1405
Norwegian (no), 1415
Occitan (oc), 1503
Oromo (or), 1513
Oriya (or), 1518
Punjabi (pa), 1601
Polish (pl), 1612
Pashto, Pushto (ps), 1619
Quechua (qu), 1721
Riveto-Romance (rm), 1813
Kirundi (rn), 1814
Romanian (ro), 1815
Krinyavanda (rw), 1823
Sanskrit (sa), 1901
Sindhi (sd), 1904
Sinhala (si), 1907
Serbo-Croatian (sh), 1908
Singapore (si), 1909
Slovak (sk), 1911
Slovenian (sl), 1912
Somali (so), 1913
Shona (sn), 1914
Somali (so), 1915
Albanian (sq), 1917
Serbian (sr), 1918
Siswati (st), 1919
Sesotho (st), 1920
Bhutani (dz), 1921
Bhutanese (dz), 1922
Bhutanese (dz), 1923
Tamil (ta), 2001
Telugu (te), 2005
Tajik (tg), 2007
Thai (th), 2008
Tigrinya (ti), 2009
Turkmen (tk), 2011
Tajik (tg), 2012
Setswana (st), 2014
Tonga (to), 2015
Turkish (tr), 2016
Tsonga (ts), 2019
Turkmen (tk), 2020
Twi (tw), 2023
Ukrainian (uk), 2024
Urdu (ur), 2118
Uzbek (uz), 2126
Vietnamese (vi), 2209
Volapük (vo), 2315
Wolof (wo), 2408
Xhosa (xh), 2515
Yoruba (yo), 2621
Zulu (zu), 2621

Country/Area code list

Country/Area, Country/Area code letter

Argentina, 0118, ar
Australia, 0121 au
Austria, 0120, at
Belgium, 0205 be
Brazil, 0218 br
Canada, 0301 ca
Chile, 0312 cl
China, 0314 cn
Denmark, 0411 dk
Finland, 0609 fi
France, 0618 fr
Germany, 0405 de
Hong Kong, 0811 hk
India, 0914 in
Indonesia, 0904 id
Italy, 0920 it
Japan, 1016 jp
Korea, Republic of, 1118 kr
Malaysia, 1325 my
Mexico, 1324 mx
Netherlands, 1412 nl
New Zealand, 1426 nz
Norway, 1415 no
Pakistan, 1611 pk
Philippines, 1608 ph
Portugal, 1620 pt
Russian Federation, 1821 ru
Singapore, 1907 sg
Spain, 0519 es
Sweden, 1905 se
Switzerland, 0308 ch
Taiwan, 2023 tw
Thailand, 2008 th
United Kingdom, 0702 gb
USA, 2119 us
On-screen displays and recorder displays

The table below shows a list of error messages that you may encounter when using the recorder and an explanation of their meaning.

<table>
<thead>
<tr>
<th>Message</th>
<th>Explanation/Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Initializing disc. Please wait a moment.</td>
<td>When you load a blank DVD-RW disc, the recorder automatically initializes it.</td>
</tr>
<tr>
<td>• Incompatible region number.</td>
<td>The disc loaded has an incompatible region number for the recorder and so will not play.</td>
</tr>
<tr>
<td>• Cannot record any more titles.</td>
<td>The disc control data limit has been reached, or the maximum number of chapters and/or titles has been reached. Erase titles/chapters or combine chapters.</td>
</tr>
<tr>
<td>• Cannot record any more titles.</td>
<td>No more space for file management data.</td>
</tr>
<tr>
<td>• Cannot add any more chapter marks.</td>
<td></td>
</tr>
<tr>
<td>• This disc cannot be recorded. Undo the final-</td>
<td>The disc was finalized on a non-Pioneer DVD recorder. Undo the finalization in order to recording/editing.</td>
</tr>
<tr>
<td>ization.</td>
<td></td>
</tr>
<tr>
<td>• Cannot play this disc.</td>
<td>The disc may be dirty or damaged. Take out the disc, clean it and retry. If the error persists, use a new disc. If the error appears even with a new disc, please consult a Pioneer Service Center.</td>
</tr>
<tr>
<td>• Cannot record this content using Video mode</td>
<td>The video source is copy-once protected. Use a VR mode DVD-R/RW disc with CPRM for recording.</td>
</tr>
<tr>
<td>recording.</td>
<td></td>
</tr>
<tr>
<td>• Cannot add the CPRM information.</td>
<td>The recorder could not read the CPRM information. The recorder may be damaged—please consult a Pioneer Service Center.</td>
</tr>
<tr>
<td>• This content is copy protected.</td>
<td>The video source is copy-protected and cannot be recorded.</td>
</tr>
<tr>
<td>• Incorrect CPRM information.</td>
<td>The video source is copy-protected and cannot be recorded.</td>
</tr>
<tr>
<td>• The audio will conform to the [Dual Mono</td>
<td>When recording from an external input in Video mode (DVD), Video Mode On (HDD), or in LPCM mode, you can only record the left or right channel; not both.</td>
</tr>
<tr>
<td>Recording] setting.</td>
<td></td>
</tr>
<tr>
<td>• Repairing disc.</td>
<td>During recording, the power was cut. This display appears when the power is restored.</td>
</tr>
<tr>
<td>• Could not repair the disc.</td>
<td>The recorder was unable to repair the disc after a power cut. The contents of the recording will be lost.</td>
</tr>
<tr>
<td>• Overheating has stopped operation. Press</td>
<td>The internal temperature of the recorder has exceeded the operating limit. If this message reappears, please contact a Pioneer authorized service center.</td>
</tr>
<tr>
<td>DISPLAY to clear this message.</td>
<td></td>
</tr>
<tr>
<td>• There is no DV input or the input signal is</td>
<td>No signal was detected at the DV IN jack. This may appear if a blank section of DV tape is playing in the connected camcorder.</td>
</tr>
<tr>
<td>unrecordable.</td>
<td></td>
</tr>
<tr>
<td>• Cannot preview because there is no DV input</td>
<td></td>
</tr>
<tr>
<td>or the input signal is unrecordable.</td>
<td></td>
</tr>
</tbody>
</table>
Handling discs
When holding discs of any type, take care not to leave fingerprints, dirt or scratches on the disc surface. Hold the disc by its edge or by the center hole and edge. Damaged or dirty discs can affect playback and recording performance. Take care also not to scratch the label side of the disc. Although not as fragile as the recorded side, scratches can still result in a disc becoming unusable.

Should a disc become marked with fingerprints, dust, etc., clean using a soft, dry cloth, wiping the disc lightly from the center to the outside edge as shown in the diagram below.

If necessary, use a cloth soaked in alcohol, or a commercially available CD/DVD cleaning kit to clean a disc more thoroughly. Never use benzine, thinner or other cleaning agents, including products designed for cleaning vinyl records.

Storing discs
Although CDs and DVD discs are more durable than vinyl records, you should still take care to handle and store discs correctly. When you're not using a disc, return it to its case and store upright. Avoid leaving discs in excessively cold, humid, or hot environments (including under direct sunlight).

Don't glue paper or put stickers onto the disc, or use a pencil, ball-point pen or other sharp-tipped writing instrument. These could all damage the disc.

For more detailed care information see the instructions that come with discs.

Do not load more than one disc into the recorder.

Damaged discs
Discs spin at high speed inside the recorder. If you can see that a disc is cracked, chipped, warped, or otherwise damaged, don't risk using it; you could end up damaging the recorder.

This recorder is designed for use with conventional, fully circular discs only. Use of shaped discs is not recommended for this product. Pioneer disclaims all liability arising in connection with the use of shaped discs.

Cleaning the pickup lens
The DVD recorder's lens should not become dirty in normal use, but if for some reason it should malfunction due to dust or dirt, consult your nearest Pioneer-authorized service center. Although lens cleaners are commercially available, we do not recommend using them since some may damage the lens.

Condensation
Condensation may form inside the recorder if it is brought into a warm room from outside, or if the temperature of the room rises quickly. Although the condensation won't damage the recorder, it may temporarily impair its performance. For this reason you should leave it to adjust to the warmer temperature for about an hour before switching on and using.

<table>
<thead>
<tr>
<th>Message</th>
<th>Explanation/Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>• HDD optimization is recommended. This can be done using Disc Setup.</td>
<td>The HDD should be optimized (basically, HDD housekeeping) to maintain playback and recording performance.</td>
</tr>
<tr>
<td>• Please perform HDD optimization. This can be done using Disc Setup.</td>
<td>The HDD is in more urgent need of optimization in order to maintain performance.</td>
</tr>
<tr>
<td>• The HDD has not been sufficiently optimized. Please optimize again.</td>
<td>If this message appears repeatedly after optimizing the HDD it is likely that there is not enough free space on the HDD for optimization to complete properly. Please erase some titles from the HDD and optimize again.</td>
</tr>
</tbody>
</table>
Hints on installation

We want you to enjoy using this unit for years to come, so please bear in mind the following points when choosing a suitable location for it:

**Do...**
✓ Use in a well-ventilated room.
✓ Place on a solid, flat, level surface, such as a table, shelf or stereo rack.

**Don’t...**
× Use in a place exposed to high temperatures or humidity, including near radiators and other heat-generating appliances.
× Place on a window sill or other place where the recorder will be exposed to direct sunlight.
× Use in a dusty or damp environment or in a room where it will be exposed to excessive cigarette smoke.
× Place directly on top of an amplifier, or other component in your stereo system that becomes hot in use.
× Use near a television or monitor as you may experience interference—especially if the television uses an indoor antenna.
× Use in a kitchen or other room where the recorder may be exposed to smoke or steam.
× Use on a thick rug or carpet, or cover with cloth—this may prevent proper cooling of the unit.
× Place on an unstable surface, or one that is not large enough to support all four of the unit’s feet.

Moving the recorder

If you need to move the recorder, first remove the disc, if there’s one loaded, and close the disc tray. Next, press 🍅 STANDBY/ON to switch the power to standby, checking that the POWER OFF indication in the display goes off. Wait at least two minutes. Lastly, disconnect the power cord. Never lift or move the unit during playback or recording—discs rotate at a high speed and may be damaged.

Glossary

**Analog audio**
An electrical signal that directly represents sound. Compare this to digital audio which can be an electrical signal, but is an indirect representation of sound. See also Digital audio.

**Aspect ratio**
The width of a TV screen relative to its height. Conventional TVs are 4:3 (in other words, the screen is almost square); widescreen models are 16:9 (the screen is almost twice as wide as it is high).

**Chapter**
Just as a book is split up into several chapters, a title on the HDD/a DVD disc is usually divided into chapters. See also Title.

**Digital audio**
An indirect representation of sound by numbers. During recording, the sound is measured at discrete intervals (44,100 times a second for CD audio) by an analog-to-digital converter, generating a stream of numbers. On playback, a digital-to-analog converter generates an analog signal based on these numbers. See also Sampling frequency and Analog audio.

**Dolby Digital**

Dolby® Digital Stereo Creator enables consumers to create stereo DVD-Videos with stunning Dolby Digital sound tracks at home. The technology, when utilized instead of PCM recording, also saves recordable disc space, allowing for higher video resolution or extended recording time on each DVD. DVDs mastered using Dolby Digital Stereo Creator will play back on all DVD-Video players.

Manufactured under license from Dolby Laboratories. "Dolby" and the double-D symbol are trademarks of Dolby Laboratories.
**DRM (Digital Rights Management)**

DRM (Digital Rights Management) copy protection is a technology designed to prevent unauthorized copying by restricting playback, etc., of material on devices other than the PC (or other WMA recording equipment) used to record it. For detailed information, please see the instruction manuals or help files that came with your PC (or other WMA recording equipment) and/or software.

**DTS**

DTS stands for Digital Theater System. DTS is a surround system different from Dolby Digital that has become a popular surround sound format for movies.

“DTS” and “DTS Digital Out” are registered trademarks of Digital Theater Systems, Inc.

**Dynamic range**

The difference between the quietest and loudest sounds possible in an audio signal (without distorting or getting lost in noise). Dolby Digital and DTS soundtracks are capable of a wide dynamic range, delivering dramatic cinema-like effects.

**EXIF (Exchangeable Image File)**

A file format developed by Fuji Photo Film for digital still cameras. Digital cameras from various manufacturers use this compressed file format which carries date, time and thumbnail information, as well as the picture data.

**File extension**

A tag added to the end of a filename to indicate the type of file. For example, “.mp3” indicates an MP3 file.

**ISO 9660 format**

International standard for the volume and file structure of CD-ROM discs.

**JPEG**

A file format used for still images, such as photographs and illustrations. JPEG files are identified by the file extension “.jpg” or “.JPG”. Most digital cameras use this format.

**MP3**

MP3 (MPEG1 audio layer 3) is a compressed audio file format. Files are recognized by their file extension “.mp3” or “.MP3”.

**MPEG audio**

**MPEG 2 Multichannel**

An audio format used on Video CDs and some DVD discs. This unit can convert MPEG audio to PCM format for wider compatibility with digital recorders and AV amp/receivers. See also PCM.

**MPEG video**

The video format used for Video CDs and DVDs. Video CD uses the older MPEG-1 standard, while DVD uses the newer and much better quality MPEG-2 standard.

**Optical digital output**

A jack that outputs digital audio in the form of light pulses. Connect components with optical digital jacks using a special optical cord, available from specialist audio dealers.

**PCM (Pulse Code Modulation)**

The most common system of encoding digital audio, found on CDs and DAT. Excellent quality, but requires a lot of data compared to formats such as Dolby Digital and MPEG audio. For compatibility with digital audio recorders (CD, MD and DAT) and AV amp/receivers with digital inputs, this unit can convert Dolby Digital and MPEG audio to PCM. See also Digital audio.

**PBC (Playback Control) (Video CD only)**

A system of navigating a Video CD through on-screen menus recorded onto the disc. Especially good for discs that you would normally not watch from beginning to end all at once—karaoke discs, for example.

**Progressive scan video**

Also called non-interlaced video, this method of displaying a picture updates all the lines in one pass, resulting in a more stable, flicker-free image than interlaced video (for a given scanning rate).

**PureCinema**

Video on a DVD disc may be either video material (originally shot on video) or film material (originally shot on film). Video material has a frame rate of 30 frames/second, compared to 24 frames/second for film. This recorder converts film material to 60 frames/second (in progressive scan mode). PureCinema adjusts the picture so that it matches more closely the picture quality of a cinema screen.

You can see whether video on a DVD disc is film or video material by displaying the transfer rate. If a ‘#’ appears above the transfer rate display, it is film material.
Additional information

Regions (DVD-Video only)
Regions associate discs and players with particular areas of the world. This unit will only play discs that have compatible region codes. You can find the region code of your unit by looking on the rear panel. Some discs are compatible with more than one region (or all regions).

Sampling frequency
The rate at which sound is measured to be turned into digital audio data. The higher the rate, the better the sound quality, but the more digital information is generated. Standard CD audio has a sampling frequency of 44.1kHz, which means 44,100 samples (measurements) per second. See also Digital audio.

Title
A collection of chapters on a the HDD/DVD disc. See also Chapter.

Track
Audio CDs and Video CDs use tracks to divide up the content of a disc. The DVD equivalent is called a chapter. See also Chapter.

WMA
WMA is short for Windows Media Audio and refers to an audio compression technology developed by Microsoft Corporation. WMA data can be encoded by using Windows Media Player version 9 or 10, or Windows Media Player for Windows XP. Files are recognized by their file extension ".wma" or ".WMA". Microsoft, Windows Media, and the Windows logo are trademarks, or registered trademarks of Microsoft Corporation in the United States and/or other countries.

Specifications

General
- System: HDD, DVD-Video, DVD-R/RW, CD-R/RW (WMA, MP3, JPEG, CD-DA)
- Power consumption:
  - DVR-531H-S: 43 W
  - DVR-532H-S: 43 W
  - DVR-533H-S: 43 W
  - DVR-633H-S: 46 W
- Power consumption in standby mode: 0.42 W (Front panel display: off)
- Weight: 4.1 kg (9 lb 1 oz)
- Dimensions: 420 (W) x 59 (H) x 273 (D) mm (16 9/16 (W) x 2 3/8 (H) x 10 3/4 (D) in.)
- Operating temperature: +5°C to +35°C (+41°F to +95°F)
- Operating humidity: 5% to 85% (no condensation)
- TV format: NTSC

Recording
- Recording format: DVD Video Recording
- Recordable discs:
  - DVD-RW (DVDR Re-recordable disc)
  - DVD-R (DVDR Recordable disc)
- Video recording format
  - Sampling frequency: 13.5MHz
  - Compression format: MPEG
- Audio recording format
  - Sampling frequency: 48kHz
  - Compression format: Dolby Digital or Linear PCM (uncompressed)

Recording time
- HDD (160GB)
  - XP+: Approx. 23 hours
  - Fine (XP): Approx. 34 hours
  - Standard Play (SP): Approx. 68 hours
  - Long Play (LP): Approx. 136 hours
  - Extended Play (EP): Approx. 204 hours
  - Super Long Play (SLP): Approx. 272 hours
  - Super Extended Play (SEP): Approx. 340 hours
  - Manual Mode (MN): Approx. 23–455 hours
- HDD (80GB)
  - XP+: Approx. 11 hours
  - Fine (XP): Approx. 17 hours
  - Standard Play (SP): Approx. 34 hours
  - Long Play (LP): Approx. 68 hours
  - Extended Play (EP): Approx. 102 hours
  - Super Long Play (SLP): Approx. 136 hours
  - Super Extended Play (SEP): Approx. 170 hours
  - Manual Mode (MN): Approx. 17–227 hours
### DVD-R/DVD-RW
- Fine (XP): Approx. 1 hour
- Standard Play (SP): Approx. 2 hours
- Long Play (LP): Approx. 4 hours
- Extended Play (EP): Approx. 6 hours
- Super Long Play (SLP): Approx. 8 hours
- Super Extended Play (SEP): Approx. 10 hours
- Manual Mode (MN): Approx. 1–13 hours

### Tuner
#### Receivable channels
- VHF: 2–13 ch
- UHF: 14–69 ch
- CATV: C1–C125 ch

### Timer
- Programs: 1 month/32 programs
- Clock: Quartz lock (12-hour digital display)
- Power off memory: Approx. 5 years (after manufacture)

### Input/Output
- **VHF/UHF antenna input/output terminal**: VHF/UHF set 75 Ω (F-shape connector)
- **Video input**: Input 1, 3 (rear), 2 (front) 1 Vp-p (75 Ω) RCA jack
- **Video output**: Output 1, 2 1 Vp-p (75 Ω) RCA jack
- **S-Video input**: Input 1, 3 (rear), 2 (front) Y (luminance): 1 Vp-p (75 Ω) C (color): 286 mVp-p (75 Ω) 4 pin mini DIN
- **S-Video output**: Output 1, 2 Y (luminance): 1 Vp-p (75 Ω) C (color): 286 mVp-p (75 Ω) 4 pin mini DIN
- **Component video output**: Y: 1.0 Vp-p (75 Ω) Pγ, Pγ: 0.7 Vp-p (75 Ω) RCA jacks
- **Audio input**: Input 1, 3 (rear), 2 (front) L/R 2V rms (Input impedance: more than 22 kΩ) RCA jacks
- **Audio output**: Output 1, 2 L/R 2V rms (Output impedance: less than 1.5 kΩ) RCA jacks
- **Control input**: Mini jack
- **DV input (DVR-633/533H-S only)**: 4 pin (front) (i.LINK/IEEE 1394 standard)

### Supplied accessories
- Remote control: 1
- Dry cell batteries (AA/R6P): 2
- Audio / Video cable (red/white/yellow): 1
- G-LINK™ cable: 1
- RF antenna cable: 1
- Power cable: 1
- Blank DVD-RW disc: 1
- Quick Start Guide
- Operating Instructions
- Warranty card: 1

**Note:** The specifications and design of this product are subject to change without notice, due to improvement.
Index

A
Audio
digital output settings 93
DV audio settings 54
dynamic range control 91
external audio settings 93
input settings 93
setting preferences for audio language 94
setting which channel to record 52
switching on playback 64, 65
switching TV audio 29

DVD
activity display 32
aspect ratios 95, 99
backing up 74
compatibility 10, 49, 100
DVD-R vs DVD-RW 11, 12, 49, 100
finalizing 12, 55, 88
initializing 49, 88
playback controls for 30, 57–65
selecting for playback/recording 27
Video mode vs VR mode 11, 12, 49, 77, 88, 95

C
CD Audio
compatibility 10
playback controls for 31, 59–65
Chapter
automatic chapter marking 95
definition 110
editing 72, 81
maximum number per title/disc 49
Copying
from DVD to HDD 67, 70
from HDD to DVD 67–69, 100
high-speed 66, 73, 100
One Touch Copy 66
real-time 66, 73
restrictions and copyright 66
Video mode compatible and frame accurate 71, 72, 73

E
Editing 76–84
Video mode compatibility and frame accuracy 77, 95
Video mode vs VR mode 77

G
G-LINK™ 14, 17, 18

H
HDD
activity display 32
backing up content to DVD 74
disk space and recording quality 105
playback controls for 30
precautions 13
selecting for playback/recording 27
Video mode compatibility 49, 77, 95
Home menu 32

J
JPEG
file compatibility 12
viewing in the PhotoViewer 85

L
Language
audio 64, 94
code list 107
DVD menu 94
setting for menus and displays (OSD) 25, 94
settings for DVD playback 94
subtitle 94

Dolby Digital
dual mono sources and 65
explained 110
output setting 93
DTS
CD audio encoded with 31
explained 111
output setting 93
DV camcorder
connecting 14, 20
error messages 104
recording from 53
setting the audio track to record 93
MP3 audio files 11, 111

Picture quality
- recording time vs 50, 105
- setting for playback 90
- setting for recording 89
- video connections and 16

Play List
- compared to Original 13
- creating on a VR mode disc 78
- switching to Play List view 76

Playback 29–31, 57–65
- on-screen displays 33
- parental lock for DVD-Video 96
- picture quality settings for 90
- settings 95

Recording 27, 49–56
- audio format 50
- automatic chapter marking 95
- copyright and 50
- from a camcorder 53
- from an external input 53
- on-screen displays 34
- optimized 95
- settings 95
- simultaneous playback and 52
- time and picture quality 50, 105
- timer programs 37
- TV channels with SAP audio channels 52
- TV programs 27, 37, 51
- Video mode vs VR mode 49

Remote control
- buttons explained 22–23
- changing the batteries 10
- operating range 10
- setting the remote ID 96
- setting up for TV control 98

Subtitles
- setting preferences for 94
- switching during playback 64

Title
- defined 112
- maximum number recordable 49
- maximum recordable length 49
- thumbnails 79, 95

TV channels
- automatic tuning 92
- automatic tuning in the Setup Navigator 25
- changing 28
- manual setting 92
- numbering 28
- Recording - see Recording TV programs
- SAP audio channels and 29

TV Guide On Screen™
- recording programs using 37
- searching for a program 40
- setting a reminder to watch a program 39
- setting up 27, 45
- using 35–47

Video CD
- compatibility 10
- playback control (PBC) 31, 57
- playback controls for 31, 59–65

WMA audio files 11, 12, 112
Should this product require service in the U.S.A. and you wish to locate the nearest Pioneer Authorized Independent Service Company, or if you wish to purchase replacement parts, operating instructions, service manuals, or accessories, please call the number shown below.

800-421-1404

Please do not ship your product to Pioneer without first calling the Customer Support Division at the above listed number for assistance.

Pioneer Electronics Service, Inc.,
Customer Support Division
P.O. BOX 1760, Long Beach,
CA 90801-1760, U.S.A.

For warranty information please see the Limited Warranty sheet included with your product.

Should this product require service in Canada, please contact a Pioneer Canadian Authorized Dealer to locate the nearest Pioneer Authorized Service Company in Canada.

Alternatively, please contact the Customer Satisfaction Department at the following address:

Pioneer Electronics of Canada, Inc.
Customer Satisfaction Department
320 Allstate Parkway, Markham, Ontario L3R OP2
(905)479-4411
1(877)283-5901

For warranty information please see the Limited Warranty sheet included with your product.

Si este producto requiere servicio en Canadá, puede usted acudir a un Distribuidor Autorizado Pioneer del Canadá para obtener el nombre del Centro de Servicio Autorizado Pioneer más cercano a usted. También puede contactar al Servicio a la Clientela de Pioneer:

Pioneer Electroniques du Canada, Inc.
Service à la clientèle
320, Allstate Parkway, Markham, Ontario L3R OP2
(905)479-4411
1(877)283-5901

Pour obtenir des renseignements sur la garantie, veuillez vous reporter au feuillet sur la garantie qui accompagne le produit.